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Conventions used in this guide

TIP: Tips provide helpful hints or shortcuts.

NOTE: Notes provide important information to explain a concept or to complete a task.

CAUTION: Cautions indicate procedures that you should follow to avoid losing data or damaging
the product.

WARNING! Warnings alert you to specific procedures that you should follow to avoid personal
injury, catastrophic loss of data, or extensive damage to the product.
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Product comparison

CM4540 MFP

CC419A

● Prints up to 42 pages per minute (ppm) on
Letter-size paper and up to 40 ppm on A4-
size paper

● Scans in grayscale up to 36.5 images per
minute (ipm) for Letter-size pages and up to
35 ipm for A4-size pages

● Scans in color up to 21 images per minute
(ipm) for Letter-size pages and up to 20 ipm
for A4-size pages

● Digital sending features, including sending
to e-mail, network folders, and a USB flash
drive.

● 100-sheet multipurpose input tray (Tray 1)

● 500-sheet input tray (Tray 2)

● 50-sheet document feeder for copying and
scanning

● Flatbed scanner that holds pages up to
Legal size

● Automatic two-sided printing

● 500-sheet, face-down output bin

● Hi-speed USB 2.0 port

● HP Jetdirect embedded print server for
connecting to a 10/100/1000Base-TX
network

● USB port on the control panel for walk-up
printing and scanning

● Color touchscreen display

● Hinged control panel to adjust the viewing
angle

● 1280 megabytes (MB) of random access
memory (RAM)

● HP Encrypted High Performance Hard Disk

● Hardware integration pocket on the control
panel for adding solutions

● Color access control

CM4540f MFP

CC420A

This model has the same features as the CM4540 MFP model, with the following differences:

● HP 500-sheet Paper Feeder (Tray 3) and cabinet (increases the total input capacity to 1100
pages)

● Analog faxing with the built-in HP Analog Fax Accessory 500

CM4540fskm MFP

CC421A

This model has the same features as the CM4540 MFP model, with the following differences:

● HP 3 x 500-sheet Paper Feeder (Trays 3, 4, and 5) and stand (increases the total input capacity
to 2100 pages)

● HP 900-sheet 3-bin Stapling Mailbox (replaces the 500-sheet output bin)

● Analog faxing with the built-in HP Analog Fax Accessory 500
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Environmental features

Duplex Save paper by using duplex printing as your default print setting.

Print multiple pages per sheet Save paper by printing two or more pages of a document side-by-side on one sheet of paper.
Access this feature through the printer driver.

Recycling Reduce waste by using recycled paper.

Recycle print cartridges by using the HP return process.

Energy savings Save energy by initiating sleep mode for the product.

HP Smart Web printing Use HP Smart Web printing to select, store, and organize text and graphics from multiple
Web pages and then edit and print exactly what you see onscreen. It gives you the control
you need for printing meaningful information while minimizing waste.

Download HP Smart Web printing from this Web site: www.hp.com/go/smartweb.

Job storage Use the job storage features to manage print jobs. By using job storage, you activate printing
while you are at the shared product, eliminating lost print jobs that are then reprinted.

ENWW Environmental features 3
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Accessibility features
The product includes several features that aid you with accessibility issues.

● Online user guide that is compatible with text screen-readers.

● Print cartridges can be installed and removed by using one hand.

● All doors and covers can be opened by using one hand.

● Paper can be loaded in Tray 1 by using one hand.

● The control-panel display rotates up to adjust the viewing angle.
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Product views

Front view

CM4540 MFP

1

10

11

2 3
4

9

7

8

6

5

1 Standard output bin

2 Document feeder cover (access for clearing jams)

3 Document feeder input tray

4 Document feeder output bin

5 Control panel with color touchscreen display

6 Top-cover-release lever (access for clearing jams)

7 Handle for the right door (access for clearing jams)

8 On-off button

9 Handle for Tray 1

10 Tray 2

11 Handle for the front cover (access to the print cartridges and the toner collection unit)
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CM4540f MFP

1

14

13

2 3
4

9

10

11

7

8

6

5

12

1 Standard output bin

2 Document feeder cover (access for clearing jams)

3 Document feeder input tray

4 Document feeder output bin

5 Control panel with color touchscreen display

6 Top-cover-release lever (access for clearing jams)

7 Handle for the right door (access for clearing jams)

8 On-off button

9 Handle for Tray 1

10 Tray 2

11 Tray 3

12 Handle for lower-right door (access for clearing jams)

13 Storage cabinet

14 Handle for the front cover (access to the print cartridges and the toner collection unit)
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CM4540fskm MFP

1 2

16

17

15

14

3
4

5

10

11

12

13

8

9

7

6

1 Mailbox output bins

2 HP Stapling Mailbox accessory

3 Document feeder cover (access for clearing jams)

4 Document feeder input tray

5 Document feeder output bin

6 Control panel with color touchscreen display

7 Top-cover-release lever (access for clearing jams)

8 Handle for the right door (access for clearing jams)

9 On-off button

10 Handle for Tray 1

11 Tray 2

12 Tray 3

13 Handle for lower-right door (access for clearing jams)

14 Tray 4

15 Tray 5

16 Handle for the front cover (access to the print cartridges and the toner collection unit)

17 Stapler release lever (access to the staple cartridge)
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Back view

2

1

1 Interface ports

2 Power connection
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Interface ports

1

2

4

5

6

7

3

1 Hi-speed USB 2.0 printing port

2 Foreign interface harness for connecting third-party devices

3 Local area network (LAN) Ethernet (RJ-45) network port

4 USB port for connecting external USB devices

5 Fax port (RJ-11)

6 EIO interface expansion slot

7 Slot for a cable-type security lock

Serial number and model number location

The model number and serial number are listed on an identification label located on the back of the
product. The serial number contains information about the country/region of origin, the product
version, production code, and the production number of the product.

Model name Model number

CM4540 MFP CC419A

CM4540f MFP CC420A

CM4540fskm MFP CC421A
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Control-panel layout

7

5

8

6

31 4

91014

2

1213 11

1 Hardware integration pocket Area for adding third-party security devices

2 Touchscreen graphical display Use the touchscreen to open and set up all product
functions.

3 Brightness-adjustment button Use this button to increase or decrease the brightness of
the touchscreen display.

4 Numeric keypad Use this area to specify the number of copies and other
numeric values.

5 Sleep button If the product is inactive for a long period of time, it
automatically enters a sleep mode. To place the product
into sleep mode or to reactivate the product, press the
Sleep button.

6 Reset button Resets the job settings to factory or user-defined default
values.

7 Stop button Stops the active job and opens the Job Status screen.

8 Start button Begins a copy job, starts digital sending, starts a fax job,
or continues a job that has been interrupted.

9 Pause button Use this button to indicate a required pause for a fax
number.

10 Attention light Indicates that the product has a condition that requires
intervention. Examples include an empty paper tray or an
error message.

11 Data light Indicates that the product is receiving data.

12 Ready light Indicates that the product is ready to begin processing any
job.

13 Backspace button Clears the active text or number field, and returns values
to the default settings.

14 USB port (on the bottom edge of the hinged control panel) Connect a USB flash drive for walk-up printing and
scanning.
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Control-panel help

The product has a built-in Help system that explains how to use each screen. To open the Help system,
touch the Help button  in the upper-right corner of the screen.

For some screens, the Help opens to a global menu where you can search for specific topics. You can
browse through the menu structure by touching the buttons in the menu.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options
for that screen.

If the product alerts you of an error or warning, touch the error  or warning  button to open a
message that describes the problem. The message also contains instructions to help solve the problem.
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Touchscreen navigation

The home screen provides access to the product features, and it indicates the current status of the
product.

NOTE: HP regularly updates features that are available in the product firmware. To take advantage
of the most current features, update the product firmware. To download the most recent firmware
upgrade, go to www.hp.com/go/cljcm4540mfp_firmware.

NOTE: Depending on how the product has been configured, the features that appear on the home
screen can vary.

HP LaserJet  

DDMMYYYY 00.00 AM

2 3 4 5

6

789

1

1 Features Depending on how the product is configured, the features that appear in this area can include
any of the following items:

● Copy

● Fax

● E-mail

● Save to Network Folder

● Save to USB

● Save to Device Memory

● Open from USB

● Open from Device Memory

● Quick Sets

● Job Status

● Supplies

● Trays

● Administration

● Device Maintenance

2 Product status The status line provides information about the overall product status.

3 Copy type Shows whether copies are color.
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4 Copy count The copy count box indicates the number of copies that the product is set to make.

5 Help button Touch the Help button to open the embedded help system.

6 Scroll bar Touch the up or down arrows on the scroll bar to see the complete list of available features.

7 Sign In or Sign Out Touch the Sign In button to access secured features.

Touch the Sign Out button to sign out of the product if you have signed in for access to
secured features. After you sign out, the product restores all options to the default settings.

8 Network Address Touch the Network Address button to find information about the network connection.

NOTE: Depending on the product configuration, this button might not appear.

9 Date and time The current date and time appear here. You can select the format that the product uses to
show the date and time, for example 12-hour format or 24-hour format.
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Buttons on the touchscreen

The status line on the touchscreen provides information about the product status. Various buttons can
appear in this area. The following table describes each button.

Home button. Touch the home button to go to the Home screen from any other screen.

Start button. Touch the Start button to begin the action for the feature that you are using. 

NOTE: The name of this button changes for each feature. For example, in the Copy feature, the button
is named Start Copy.

Stop button. If the product is processing a print or fax job, the Stop button appears instead of the Start
button. Touch the Stop button to halt the current job. The product prompts you to cancel the job or to
resume it.

Warning button. The warning button appears when the product has a problem but can continue
functioning. Touch the warning button to see a message that describes the problem. The message also
has instructions for solving the problem.

Help button. Touch the help button to open the built-in online Help system.
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2 Control panel menus

● Control panel menus

● Administration menu

● Device Maintenance menu
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Control panel menus
The product has many menus on the control panel Home screen to help you perform tasks and
configure settings.

NOTE: To learn about each menu option, touch the Help button  in the upper-right corner of the
screen for that option.

NOTE: HP regularly updates features that are available in the product firmware. To take advantage
of the most current features, update the product firmware. To download the most recent firmware
upgrade, go to www.hp.com/go/cljcm4540mfp_firmware.

Table 2-1  Menus on the Home screen

Menu Description

Initial Setup This menu appears when you first turn the product on. Use it to set the language, to set the
date and time, to configure essential fax and e-mail settings, and to enable the Open from
USB feature.

After you have completed the initial setup, you have the option to hide this menu.

Copy Use this menu to make copies of documents.

Several options are available for customizing jobs. These settings are temporary. After you
have finished the job, the product returns to the default settings.

Fax Use this menu to send a fax from the product. This menu is available only for products that
have a fax accessory. For this menu to appear on the control panel, this feature must be set up
by using the Initial Setup menu or by using the HP Embedded Web Server.

Several options are available for customizing jobs. These settings are temporary. After you
have finished the job, the product returns to the default settings.

E-mail Use this menu to scan documents and send them as an e-mail attachment. For this menu to
appear on the control panel, this feature must be set up by using the Initial Setup menu, by
using the HP Scan to Email Setup Wizard during software installation, or by using the HP
Embedded Web Server.

Several options are available for customizing jobs. These settings are temporary. After you
have finished the job, the product returns to the default settings.

Save to USB Use this menu to scan documents and save them on a USB flash drive. For this menu to appear
on the control panel, this feature must be set up by using the HP Embedded Web Server.

Several options are available for customizing jobs. These settings are temporary. After you
have finished the job, the product returns to the default settings.

Save to Network Folder Use this menu to scan documents and save them to a shared folder on the network. For this
menu to appear on the control panel, this feature must be set up by using the HP Embedded
Web Server or by using the HP Save to Folder Setup Wizard during software installation.

Several options are available for customizing jobs. These settings are temporary. After you
have finished the job, the product returns to the default settings.

Open from USB Use this menu to open and print a document stored on a USB flash drive. For this menu to
appear on the control panel, this feature must be set up by using the Initial Setup menu.
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Table 2-1  Menus on the Home screen (continued)

Menu Description

Save to Device Memory Use this menu to scan documents and save them to the hard disk in the product.

Several options are available for customizing jobs. These settings are temporary. After you
have finished the job, the product returns to the default settings.

Open from Device Memory Use this menu to open and print a document stored on the product hard drive.

Quick Sets Use this menu to access preset job options for jobs that you scan and send by fax or e-mail, or
jobs that you scan and save to a USB flash drive, the product hard disk, or to a folder on the
network.

Set up Quick Sets by using the HP Embedded Web Server or HP Web Jetadmin.

Job Status Use this menu to see the status of all active jobs.

Trays Use this menu to see the current status of each tray. You can also use this menu to configure
the paper size and type settings for each tray.

Supplies Use this menu to see the current status of product supplies, such as print cartridges. Information
about ordering new supplies is also available.

Administration Use this menu to print reports and configure default settings for the product. The Administration
menu has several sub-menus. See the sections that follow for details about these menus.

Device Maintenance Use this menu to calibrate and clean the product and to backup and restore data. See the
sections that follow for details about these menus.
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Administration menu
You can perform basic product setup by using the Administration menu. Use the HP Embedded Web
Server for more advanced product setup. To open the HP Embedded Web Server, enter the product IP
address or host name in the address bar of a Web browser.

Reports menu

To display: At the product control panel, select the Administration menu, and then select the Reports
menu.

Table 2-2  Reports menu

First level Second level Values

Configuration/Status Pages Administration Menu Map Print

View

 Current Settings Page Print

View

 Configuration Page Print

View

 Supplies Status Page Print

View

 Usage Page Print

View

 File Directory Page Print

View

 Color Usage Job Log Print

Fax Reports Fax Activity Log Print

View

 Billing Codes Report Print

View

 Blocked Fax List Print

View

 Speed Dial List Print

View

 Fax Call Report Print

View
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Table 2-2  Reports menu (continued)

First level Second level Values

Other Pages Demonstration Page Print

 Color Samples for RGB Print

 CMYK Values Print

 PCL Font List Print

 PS Font List Print

General Settings menu

To display: At the product control panel, select the Administration menu, and then select the General
Settings menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-3  General Settings menu

First level Second level Third level Fourth level Values

Date/Time Settings Date/Time Format Date Format  DD/MMM/YYYY

MMM/DD/YYYY

YYYY/MMM/DD

  Time Format  12 hour (AM/PM)

24 hours

 Date/Time Date  Select the date from a
pop-up calendar.

  Time  Select the time from a
pop-up keypad.

  Time Zone  Select the time zone from
a list.

  Adjust for Daylight
Savings

 Checkbox

Energy Settings Sleep Schedule A list of scheduled events
displays.

  

  + (Add)

Edit

Edit

Delete

 

   Event Type Wake Up

Sleep

   Event Time  
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Table 2-3  General Settings menu (continued)

First level Second level Third level Fourth level Values

   Event Days Select days of the week
from a list.

 Sleep Delay   Enter a value between 1
and 120 minutes.

The default value is 45
minutes.

 Optimum Speed/Energy
Usage

  Faster First Page*

Save Energy

Save More Energy

Save Most Energy

Print Quality Adjust Color Highlights Cyan Density

Magenta Density

Yellow Density

Black Density

-5 to 5

  Midtones Cyan Density

Magenta Density

Yellow Density

Black Density

-5 to 5

  Shadows Cyan Density

Magenta Density

Yellow Density

Black Density

-5 to 5

 Image Registration Adjust Tray <X> Print Test Page  

   X1 Shift

Y1 Shift

X2 Shift

Y2 Shift

-5.00 mm to 5.00 mm

 Auto Sense Behavior Tray 1 Sensing  Full sensing

Expanded sensing*

Transparency Only

  Tray X Sensing  Expanded sensing

Transparency Only
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Table 2-3  General Settings menu (continued)

First level Second level Third level Fourth level Values

 Adjust Paper Types Select from a list of paper
types that the product
supports. The available
options are the same for
each paper type.

Print Mode Select from a list of print
modes.

   Resistance Mode Normal mode

Up

Down

   Humidity Mode Normal

High

   Pre-Rotation Mode Off

On

   Fuser Temp Mode Normal

Up

Down

   Paper Curl Mode Normal

Reduced

 Optimize Normal Paper  Standard*

Smooth

  Heavy Paper  Standard*

Smooth

  Envelope Control  Normal*

Reduced Temperature
multipurpose mode

  Environment  Normal*

Low Temp

  Line Voltage  Normal*

Low Voltage

  Tray 1  Normal*

Alternate
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Table 2-3  General Settings menu (continued)

First level Second level Third level Fourth level Values

  Background  Normal*

Alternate 1

Alternate 2

Alternate 3

  Uniformity Control  Normal*

Alternate 1

Alternate 2

Alternate 3

  Tracking Control  On*

Off

  Registration  Normal*

Alternate

  Transfer Control  Normal*

Alternate 1

Alternate 2

Alternate 3

  Fuser Temp  Normal*

Alternate

 Edge Control   Off

Light

Normal*

Maximum

Jam Recovery    Auto*

Off

On

Manage Stored Jobs Quick Copy Job Storage
Limit

  1-300

Default = 32
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Table 2-3  General Settings menu (continued)

First level Second level Third level Fourth level Values

 Quick Copy Job Held
Timeout

  Off*

1 Hour

4 Hours

1 Day

1 Week

 Default Folder Name for
Stored Jobs

   

 Sort Stored Jobs By   Job Name*

Date

Hold Off Print Job    Enabled*

Disabled

Restore Factory Settings    Address Book

Calibration

Copy

Digital Send

E-mail

Fax

General

Print

Security

Restrict Color    Enable color

Disable color

Color if allowed

Copy Settings menu

To display: At the product control panel, select the Administration menu, and then select the Copy
Settings menu.

In the following table, asterisks (*) indicate the factory default setting.
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Table 2-4  Copy Settings menu

First level Second level Values

Image Preview

NOTE: You might need to upgrade the
firmware to view this menu.

 Make optional*

Require preview

Disable preview

Sides  1-sided original, 1-sided output*

1-sided original, 2-sided output

2-sided original, 1-sided output

2-sided original, 2-sided output

 Orientation Portrait*

Landscape

Color/Black Color Mode Auto detect*

Color

Black

Staple/Collate

NOTE: For models that include an HP
Stapling Mailbox

Staple None

Top left

Top right

 Collate Off

On*

Collate

NOTE: For models that do not include an
HP Stapling Mailbox

 Collate on (Sets in page order)*

Collate off (Pages grouped)

Reduce/Enlarge Scaling Automatic

Range X-Y (25-400%)

100%

75%

50%

125%

150%

200%

 Auto Include Margins  
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Table 2-4  Copy Settings menu (continued)

First level Second level Values

Paper Selection  Automatic

Tray 1: [Size], [Type]

Tray <X>: [Size], [Type]

Image Adjustment Darkness  

 Contrast  

 Background Cleanup  

 Sharpness  

Content Orientation Orientation Portrait*

Landscape

 2-Sided Format Book-style

Flip-style

Book-style original; Flip-style copy

Flip-style original; Book-style copy

Output Bin  Select from a list of output bins.

Optimize Text/Picture Optimize For* Manually adjust*

Text

Printed picture

Photograph

Pages per Sheet  One (1)

Two (2)

Four (4)

 Page Order Right, then down

Down, then right

 Add Page Borders  

Original Size  Auto detect*

Select from a list of sizes that the product
supports.

 Borders on Each Page  

 Original Sides 1-sided*

2-sided
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Table 2-4  Copy Settings menu (continued)

First level Second level Values

Edge-To-Edge  Normal (recommended)*

Edge-To-Edge output

Job Build  Job Build off*

Job Build on
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Scan/Digital Send Settings menu

To display: At the product control panel, select the Administration menu, and then select the Scan/
Digital Send Settings menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-5  Scan/Digital Send Settings menu

First level Second level Third level Fourth level Values

E-mail Settings

Default Save to Network
Folder Options

Default Save to USB
Options

NOTE: The same
options are available for
each of these features,
except where noted.

E-mail Setup

NOTE: E-mail Settings
only

E-mail Setup Wizard   

 Default Job Options Image Preview

NOTE: You might need
to upgrade the firmware
to view this menu.

 Make optional*

Require preview

Disable preview

  Default File Name   

  Document File Type  Select from a list of file
types.

  Optimize Text/Picture Optimize For: Manually adjust*

Text

Printed picture

Photograph

  Output Quality  High (large file)

Medium*

Low (small file)

  Original Sides  1-sided

2-sided

   Orientation Portrait*

Landscape

Book-style

Flip-style
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Table 2-5  Scan/Digital Send Settings menu (continued)

First level Second level Third level Fourth level Values

  Resolution  600 dpi

400 dpi

300 dpi

200 dpi

150 dpi*

75 dpi

  Content Orientation Orientation Portrait*

Landscape

   2-Sided Format Book-style*

Flip-style

  Color/Black  Auto detect

Color

Black/Gray

Black

  Original Size  

  Notification  Do not notify*

Notify when job
completes

Notify only if job fails

Print

E-mail*

  Image Adjustment Darkness  

   Contrast  

   Background Cleanup  

   Sharpness  

  Job Build  Job Build off*

Job Build on*

  Blank Page Suppression  Enabled

Disabled*
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Table 2-5  Scan/Digital Send Settings menu (continued)

First level Second level Third level Fourth level Values

Digital Send Service
Setup

Allow Usage of Digital
Sending Software (DSS)
Server

   

 Allow Transfer to New
Digital Sending Software
(DSS) Server

   

Fax Settings menu

To display: At the product control panel, select the Administration menu, and then select the Fax
Settings menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-6  Fax Settings menu

First level Second level Third level Fourth level Values

Fax Send Settings Fax Send Setup Fax Setup Wizard   

  Fax Dialing Settings Fax Dial Volume Off

Low*

High

   Dialing Mode Tone*

Pulse

   Redial On Busy Range: 0 – 9

Default = 3

   Redial On No Answer Range: 0 - 2

Default = 0

   Redial Interval 1-5 Minutes

Default = 5 minutes

   Detect Dial Tone  

   Fax Send Speed Fast

Medium

Slow

   Dialing Prefix  

  General Fax Send
Settings

PC Fax Send Enabled*

Disabled
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Table 2-6  Fax Settings menu (continued)

First level Second level Third level Fourth level Values

   Fax Header Prepend*

Overlay

   Error Correction Mode Enabled*

Disabled

   Fax Number Confirmation Enabled

Disabled*

   JBIG Compression Enabled*

Disabled

  Billing Codes Enable Billing Codes Off*

On

   Minimum Length Range: 1 – 16

Default = 1

   Default Billing Code  

   Allow users to edit billing
codes

 

 Default Job Options Image Preview

NOTE: You might need
to upgrade the firmware
to view this menu.

 Make optional*

Require preview

Disable preview

  Resolution  Standard (100 x
200dpi)*

Fine (200 x 200dpi)

Superfine (300 x 300dpi)

  Original Sides  1-sided*

2-sided

   Orientation Portrait*

Landscape

Book-style*

Flip-style
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Table 2-6  Fax Settings menu (continued)

First level Second level Third level Fourth level Values

  Notification  Do not notify*

Notify when job
completes

Notify only if job fails

Print

E-mail

   Notification E-mail
address

 

   Include Thumbnail  

  Content Orientation Orientation Portrait*

Landscape

   2-Sided Format Book-style*

Flip-style

  Original Size  Select from a list of sizes
that the product supports.

  Image Adjustment Darkness  

   Contrast  

   Background Cleanup  

   Sharpness  

  Optimize Text/Picture Optimize For: Manually adjust*

Text

Printed picture

Photograph

  Job Build  Job Build off*

Job Build on

  Blank Page Suppression  Disabled*

Enabled

Fax Receive Settings Fax Receive Setup Rings To Answer   

  Ring Frequency   

  Ring Interval   

  Ringer Volume  Off

Low*

High
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Table 2-6  Fax Settings menu (continued)

First level Second level Third level Fourth level Values

  Fax Receive Speed  Fast

Medium

Slow

 Fax Printing Schedule Incoming Fax Options  Always store faxes

Always print faxes*

Use Fax Printing Schedule

  Schedule

Touch this to set up a fax
printing schedule if you
selected the Use Fax
Printing Schedule option.

Add (plus sign)

Edit

Print incoming faxes

Store incoming faxes

Event Time

Event Days

 Blocked Fax Numbers Fax Number to Block   

 Default Job Options Notification  Do not notify

Notify when job
completes

Notify only if job fails

Include Thumbnail

  Stamp Received Faxes  Enabled

Disabled*

  Fit to Page  Enabled*

Disabled

  Paper Selection  Automatic

Select from a list of the
trays.

  Output Bin  Select from a list of the
bins.

  Sides  1-sided

2-sided

Fax Archive and
Forwarding

Enable Fax Archiving    

  Type of Fax Job to
Archive

 Send and receive*

Send only

Receive only
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Table 2-6  Fax Settings menu (continued)

First level Second level Third level Fourth level Values

  Fax Archiving E-mail
Address

  

 Enable Fax Forwarding    

  Type of Fax Job to
Forward

 Send and receive

Send only

Receive only

  Fax Forwarding Number   

Print Settings menu

To display: At the product control panel, select the Administration menu, and then select the Print
Settings menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-7  Print Settings menu

First level Second level Values

Manual Feed  Enabled

Disabled*

Courier Font  Regular*

Dark

Wide A4  Enabled

Disabled*

Print PS Errors  Enabled

Disabled*

Print PDF Errors  Enabled

Disabled*

Personality  Auto*

PCL

POSTSCRIPT

PDF

PCL Form Length Range: 5 – 128

Default = 60
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Table 2-7  Print Settings menu (continued)

First level Second level Values

 Orientation Portrait*

Landscape

 Font Source Internal*

Card slot 1

Card slot <X>

EIO <X> disk

USB

 Font Number Range: 0 – 999

Default = 0

 Font Pitch Range: 0.44 – 99.99

Default = 10

 Font Point Size Range: 4.00 – 999.75

Default = 12.00

 Symbol Set Select from a list of symbol sets.

 Append CR to LF No*

Yes

 Suppress Blank Pages No*

Yes

 Media Source Mapping Standard*

Classic

Print Options menu

To display: At the product control panel, select the Administration menu, and then select the Print
Options menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-8  Print Options menu

First level Second level Values

Number of Copies   

Default Paper Size  Select from a list of sizes that the product
supports.

Default Custom Paper Size X Dimension  
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Table 2-8  Print Options menu (continued)

First level Second level Values

 Y Dimension  

 Use Inches

Use Millimeters

 

Output Bin   

Sides  1-sided*

2-sided

2-Sided Format  Book-style*

Flip-style

Enable Edge-To-Edge Override  Enabled

Disabled*

Display Settings menu

To display: At the product control panel, select the Administration menu, and then select the Display
Settings menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-9  Display Settings menu

First level Second level Values

Key Press Sound  On*

Off

Language Settings Language Select from a list of languages that the
product supports.

 Keyboard Layout Each language has a default keyboard
layout. To change it, select from a list of
layouts.

Network Address Button  Display

Hide

Sleep Mode  Disabled

Use sleep delay*

Use sleep schedule

Balance power savings/Wait time

Inactivity Timeout  Range: 10 – 300 seconds

Default = 60 seconds
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Table 2-9  Display Settings menu (continued)

First level Second level Values

Clearable Warnings  On

Job*

Continuable Events  Auto continue (10 seconds)*

Press OK to continue
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Manage Supplies menu

To display: At the product control panel, select the Administration menu, and then select the Manage
Supplies menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-10  Manage Supplies menu

First level Second level Third level Fourth level Values

Supplies Status    Print

View

Supply Settings Black Cartridge Very Low Settings  Stop

Prompt to continue*

Continue

  Low Threshold Settings  1-100%

Default = 10%

 Color Cartridges Very Low Settings  Stop

Prompt to continue*

Continue

  Low Threshold Settings Cyan Cartridge

Magenta Cartridge

Yellow Cartridge

1-100%

Default = 10%

 Fuser Kit Very Low Settings  Stop

Prompt to continue*

Continue

  Low Threshold Settings  1-100%

Default = 10%

 Transfer Kit Very Low Settings  Stop

Prompt to continue*

Continue

  Low Threshold Settings  1-100%

Default = 10%

 Document Feeder Kit Very Low Settings  Stop

Prompt to continue*

Continue
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Table 2-10  Manage Supplies menu (continued)

First level Second level Third level Fourth level Values

  Low Threshold Settings  1-100%

Default = 10%

 Toner Collection Unit Very Low Settings  Stop*

Prompt to continue

Continue

 Color/Black Mix   Auto*

Mostly Color Pages

Mostly Black Pages

Supply Messages Low Message   On*

Off

Reset Supplies New Document Feeder Kit   No

Yes

Manage Trays menu

To display: At the product control panel, select the Administration menu, and then select the Manage
Trays menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-11  Manage Trays menu

First level Values

Use Requested Tray Exclusively*

First

Manually Feed Prompt Always*

Unless loaded

Size/Type Prompt Display*

Do not display

Use Another Tray Enabled*

Disabled

Alternative Letterhead Mode Disabled*

Enabled

Blank Pages Auto *

Yes
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Table 2-11  Manage Trays menu (continued)

First level Values

Image Rotation Standard

Alternate

Override A4/Letter Yes*

No

Stapler/Stacker Settings menu

To display: At the product control panel, select the Administration menu, and then select the Stapler/
Stacker Settings menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-12  Stapler/Stacker Settings menu

First level Values

Operation Mode Mailbox

Stacker

Function Separator

Stapling None

Top left or right

Top left

Top right

Staples Very Low Continue

Stop

Network Settings menu

To display: At the product control panel, select the Administration menu, and then select the Network
Settings menu.

In the following table, asterisks (*) indicate the factory default setting.
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Table 2-13  Network Settings menu

First level Values

I/O Timeout Range: 5 – 300 sec

Default = 15

Embedded Jetdirect Menu

EIO <X> Jetdirect Menu

See the table that follows for details. These menus have the same
structure. If an additional HP Jetdirect network card is installed in the
EIO slot, then both menus are available.

Table 2-14  Embedded Jetdirect Menu/EIO <X> Jetdirect Menu

First level Second level Third level Fourth level Values

Information Print Sec Page   Yes

No*

TCP/IP Enable   On*

Off

 Host Name    

 IPV4 Settings Config Method  Bootp

DHCP*

Auto IP

Manual

  Manual Settings

NOTE: This menu is
available only if you
select the Manual option
under the Config Method
menu.

IP Address Enter the address.

   Subnet Mask Enter the address.

   Default Gateway Enter the address.

  Default IP  Auto IP*

Legacy

  DHCP Release  No*

Yes

  DHCP Renew  No*

Yes

  Primary DNS   

  Secondary DNS   
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Table 2-14  Embedded Jetdirect Menu/EIO <X> Jetdirect Menu (continued)

First level Second level Third level Fourth level Values

 IPV6 Settings Enable  Off

On*

  Address Manual Settings Enable

Address

  DHCPV6 Policy  Router Specified

Router Unavailable*

Always

  Primary DNS   

  Secondary DNS   

Security Secure Web   HTTPS Required*

HTTPS Optional

 IPSEC   Keep

Disable*

 802.1X   Reset

Keep*

 Reset Security   Yes

No*

Diagnostics Embedded Tests LAN HW Test  Yes

No*

  HTTP Test  Yes

No*

  SNMP Test  Yes

No*

  Data Path Test  Yes

No*

  Select All Tests  Yes

No*

  Execution Time [M]  Range: 1 – 60 hours

Default = 1 hour
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Table 2-14  Embedded Jetdirect Menu/EIO <X> Jetdirect Menu (continued)

First level Second level Third level Fourth level Values

  Execute  No*

Yes

Link Speed    Auto*

10T Half

10T Full

100TX Half

100TX Full

Troubleshooting menu

To display: At the product control panel, select the Administration menu, and then select the
Troubleshooting menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-15  Troubleshooting menu

First level Second level Third level Fourth level Values

Event Log    View*

Print

Paper Path Page    View*

Print

Fax Fax T.30 Trace Print T.30 Report When to Print Report Print

Never automatically
print*

Print after every fax

Print only after fax send
jobs

Print after any fax error

Print only after fax send
errors

Print only after fax receive
errors

Save

 Fax V.34   Normal*

Off

42 Chapter 2   Control panel menus ENWW



Table 2-15  Troubleshooting menu (continued)

First level Second level Third level Fourth level Values

 Fax Speaker Mode   Normal*

Diagnostic

Print Quality Pages PQ Troubleshooting
Pages

  Print

 Diagnostic Page   Print

 Color Band Test Print Test Page  Print

  Copies  Range: 1 – 30

Diagnostic Tests Disable Cartridge Check    

 Paper Path Sensors Select from a list of the
product sensors.

  

 Paper Path Test Test Page  Print

  Source  Select from a list of the
available trays.

  Destination  Select from a list of the
available bins.

  Duplex  Off*

On

  Copies  1*

10

50

100

500

  Stacking  Off

On

 Manual Sensor Test   Select from a list of
available components.

 Tray/Bin Manual Sensor
Test

  Select from a list of
available components.

 Component Test   Select from a list of
available components.

 Print/Stop Test   Range: 0 – 60,000

 Scanner Tests   Select from a list of
available components.
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Table 2-15  Troubleshooting menu (continued)

First level Second level Third level Fourth level Values

 Control Panel   LEDs

Display

Buttons

Touchscreen

Retrieve Diagnostic Data    Create device data file

Create zipped debug
information file

Include crash dump files

Clean up debug
information

Send to E-mail

Export to USB
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Device Maintenance menu

Backup/Restore menu

To display: At the product control panel, select the Device Maintenance menu, and then select the
Backup/Restore menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-16  Backup/Restore menu

First level Second level Third level Values

Backup Data Enable Scheduled Backups Backup Time Enter a time

  Days Between Backups Enter the number of days

 Backup Now   

 Export Last Backup   

Restore Data   Insert a USB drive that contains
the backup file.

Calibration/Cleaning menu

To display: At the product control panel, select the Device Maintenance menu, and then select the
Calibration/Cleaning menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-17  Calibration/Cleaning menu

First level Second level Values

Cleaning Settings Auto Cleaning Off*

On

 Cleaning Interval  

 Cleaning Size  

Cleaning Page  Print

Quick Calibration   

Full Calibration   

Delay Calibration at Wake/Power On  Yes*

No

Calibrate Scanner   
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USB Firmware Upgrade menu

To display: At the product control panel, select the Device Maintenance menu, and then select the
USB Firmware Upgrade menu.

Insert a USB storage device with a firmware upgrade bundle into the USB port, and follow the on-
screen instructions.

Service menu

To display: At the product control panel, select the Device Maintenance menu, and then select the
Service menu.

The Service menu is locked and requires a PIN for access. This menu is intended for use by authorized
service personnel.
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3 Software for Windows

● Supported operating systems for Windows

● Supported printer drivers for Windows

● Select the correct printer driver for Windows

● Priority for print settings

● Change printer-driver settings for Windows

● Remove software for Windows

● Supported utilities for Windows

● Software for other operating systems
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Supported operating systems for Windows
The product supports the following Windows operating systems:

● Windows XP (32-bit and 64-bit)

● Windows Server 2003 (32-bit and 64-bit)

● Windows Server 2008 (32-bit and 64-bit)

● Windows Vista (32-bit and 64-bit)

● Windows 7 (32-bit and 64-bit)
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Supported printer drivers for Windows
● HP PCL 6 (this is the default printer driver)

● HP postscript emulation Universal Print Driver (HP UPD PS)

● HP PCL 5 Universal Print Driver (HP UPD PCL 5)

● HP PCL 6 Universal Print Driver (HP UPD PCL 6)

The printer drivers include online Help that has instructions for common printing tasks and also
describes the buttons, checkboxes, and drop-down lists that are in the printer driver.

NOTE: For more information about the UPD, see www.hp.com/go/upd.
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Select the correct printer driver for Windows
Printer drivers provide access to the product features and allow the computer to communicate with the
product (using a printer language). The following printer drivers are available at www.hp.com/go/
cljcm4540mfp_software.

HP PCL 6 driver ● Provided as the default driver. This driver is automatically installed unless you
select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other
highly graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript
flash font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single
driver for use with multiple printer models

● Preferred when printing to multiple printer models from a mobile Windows
computer

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for
most users

● Developed to align with Windows Graphic Device Interface (GDI) for best
speed in Windows environments

● May not be fully compatible with third-party and custom solutions based on
PCL5
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HP Universal Print Driver (UPD)

The HP Universal Print Driver (UPD) for Windows is a single driver that gives you instant access to
virtually any HP LaserJet product, from any location, without downloading separate drivers. It is built on
proven HP print driver technology and has been tested thoroughly and used with many software
programs. It is a powerful solution that performs consistently over time.

The HP UPD communicates directly with each HP product, gathers configuration information, and then
customizes the user interface to show the product’s unique, available features. It automatically enables
features that are available for the product, such as two-sided printing and stapling, so you do not need
to enable them manually.

For more information, go to www.hp.com/go/upd.

UPD installation modes

Traditional mode ● Use this mode if you are installing the driver from a CD for a single computer.

● When installed from the CD that comes with the product, UPD operates like
traditional printer drivers. It operates with a specific product.

● If you use this mode, you must install UPD separately for each computer and
for each product.

Dynamic mode ● To use this mode, download UPD from the Internet. See www.hp.com/go/
upd.

● Dynamic mode allows you to use a single driver installation, so you can
discover and print to HP products in any location.

● Use this mode if you are installing UPD for a workgroup.
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Priority for print settings
Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here override settings
changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and usually do not override changes made in the Page Setup dialog box.

● Printer Properties dialog box (printer driver): Click Properties in the Print dialog box
to open the printer driver. Settings changed in the Printer Properties dialog box usually do not
override settings anywhere else in the printing software. You can change most of the print settings
here.

● Default printer driver settings: The default printer driver settings determine the settings used
in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties
dialog boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower
priority than changes made anywhere else.
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Change printer-driver settings for Windows

Change the settings for all print jobs until the software program is
closed

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

The steps can vary; this procedure is most common.

Change the default settings for all print jobs

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the
default Start menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the
Classic Start menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware
and Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Printing Preferences.

Change the product configuration settings

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the
default Start menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the
Classic Start menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware
and Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Properties or Printer properties.

3. Click the Device Settings tab.
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Remove software for Windows

Windows XP

1. Click Start, Control Panel, and then Add or Remove Programs.

2. Find and select the product from the list.

3. Click the Change/Remove button to remove the software.

Windows Vista

1. Click Start, Control Panel, and then Programs and Features.

2. Find and select the product from the list.

3. Select the Uninstall/Change option.

Windows 7

1. Click Start, Control Panel, and then under the Programs heading, click Uninstall a
program.

2. Find and select the product from the list.

3. Select the Uninstall option.
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Supported utilities for Windows

HP Web Jetadmin

HP Web Jetadmin is a simple print and imaging peripheral management software tool that helps
optimize product use, control color costs, secure products, and streamline supplies management by
enabling remote configuration, proactive monitoring, security troubleshooting, and reporting of printing
and imaging products.

To download a current version of HP Web Jetadmin and for the latest list of supported host systems,
visit www.hp.com/go/webjetadmin.

When installed on a host server, a Windows client can gain access to HP Web Jetadmin by using a
supported Web browser (such as Microsoft® Internet Explorer) by navigating to the HP Web Jetadmin
host.

HP Embedded Web Server

The product is equipped with the HP Embedded Web Server, which provides access to information
about product and network activities. This information appears in a Web browser, such as Microsoft
Internet Explorer, Netscape Navigator, Apple Safari, or Mozilla Firefox.

The HP Embedded Web Server resides on the product. It is not loaded on a network server.

The HP Embedded Web Server provides an interface to the product that anyone who has a network-
connected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
HP Embedded Web Server, type the IP address for the product in the address line of the browser. (To
find the IP address, print a configuration page. For more information about printing a configuration
page, see Print information pages on page 264).

For a complete explanation of the features and functionality of the HP Embedded Web Server, see Use
the HP Embedded Web Server on page 266.

ENWW Supported utilities for Windows 55

http://www.hp.com/go/webjetadmin


Software for other operating systems

OS Software

UNIX For HP-UX and Solaris networks, go to www.hp.com/go/jetdirectunix_software to install
model scripts using the HP Jetdirect printer installer (HPPI) for UNIX.

For the latest model scripts, go to www.hp.com/go/unixmodelscripts.

Linux For information, go to www.hplip.net.

SAP devices For drivers, go to www.hp.com/go/sap/drivers

For information, go to www.hp.com/go/sap/print
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4 Use the product with Mac

● Software for Mac

● Print with Mac

● Solve problems with a Mac
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Software for Mac

Supported operating systems for Mac

The product supports the following Mac operating systems:

● Mac OS X 10.4, 10.5, 10.6, and later

NOTE: For Mac OS X 10.4 and later, PPC and Intel® Core™ Processor Macs are supported.

Supported printer drivers for Mac

The HP LaserJet software installer provides PostScript® Printer Description (PPD) files, Printer Dialog
Extensions (PDEs), and the HP Utility for use with Mac OS X computers. The HP printer PPD and PDE
files, in combination with the built-in Apple PostScript printer drivers, provide full printing functionality
and access to specific HP printer features.

Install software for Mac operating systems

Install software for Mac computers connected directly to the product

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a
cable that is no longer than 2 m (6.5 ft).

1. Install the software from the CD.

2. Click the product icon, and follow the onscreen instructions.

3. Click the Close button.

4. When the software prompts you, connect the USB cable to the product and the computer.

5. To configure the product software to recognize the installed accessories, complete these steps:
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Mac OS X 10.4 1. From the Apple menu , click the System Preferences menu and then
click the Print & Fax icon.

2. Click the Printer Setup button.

3. Click the Installable Options menu.

4. Configure the installed options.

Mac OS X 10.5 and 10.6 1. From the Apple menu , click the System Preferences menu and then
click the Print & Fax icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Driver tab.

5. Configure the installed options.

NOTE: For Mac OS X 10.5 and 10.6, the installation procedure should
automatically configure the installed options.

6. Print a page from any program to make sure that the software is correctly installed.

NOTE: If the installation failed, reinstall the software.

Install software for Mac computers on a wired network

Configure the IP address

1. Make sure the product is turned on and that the Ready message appears on the control-panel
display.

2. Connect the network cable to the product and to the network.

3. Wait for 60 seconds before continuing. During this time, the network recognizes the product and
assigns an IP address or host name for the product.

4. At the product control panel, touch the Network Address button to identify the product IP address
or host name.
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If the Network Address button is not visible, you can find the IP address or host name by printing a
configuration page.

a. At the product control panel, scroll to and touch the Administration button.

b. Open the following menus:

● Reports

● Configuration/Status Pages

● Configuration Page

c. Touch the View button to view the information on the control panel, or touch the Print button
to print the pages.

d. Find the IP address on the Jetdirect page.

5. IPv4: If the IP address is 0.0.0.0, or 192.0.0.192, or 169.254.x.x, you must manually configure
the IP address. Otherwise, the network configuration was successful.

IPv6: If the IP address begins with "fe80:", the product should be able to print. If not, you must
manually configure the IP address.

Install the software

1. Quit all programs on the computer.

2. Install the software from the CD.

3. Click the product icon, and follow the onscreen instructions.

4. Click the Close button when the installation is complete.

5. At the computer, open the Apple menu , click the System Preferences menu, and then click
the Print & Fax icon.

6. Click the plus symbol (+).
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By default, Mac OS X uses the Bonjour method to find the driver and add the product to the
printer pop-up menu. This method is best in most situations. If Mac OS X cannot find the HP printer
driver, an error message displays. Reinstall the software.

If you are connecting the product to a large network, you might need to use IP printing to connect
rather than Bonjour. Follow these steps:

a. Click the IP Printer button.

b. From the Protocol drop-down list, select the HP Jetdirect-Socket option. Enter the IP
address or host name for the product. From the Print Using drop-down list, select the
product model if one is not already selected.

7. To configure the product to recognize the installed accessories, complete these steps:

Mac OS X 10.4 1. From the Apple menu , click the System Preferences menu and then
click the Print & Fax icon.

2. Click the Printer Setup button.

3. Click the Installable Options menu.

4. Configure the installed options.

Mac OS X 10.5 and 10.6 1. From the Apple menu , click the System Preferences menu and then
click the Print & Fax icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Driver tab.

5. Configure the installed options.

NOTE: For Mac OS X 10.5 and 10.6, the installation procedure should
automatically configure the installed options.

8. Print a page from any program to make sure that the software is correctly installed.

Remove software from Mac operating systems

You must have administrator rights to remove the software.

1. Open System Preferences.

2. Select Print & Fax.

3. Highlight the product.

4. Click the minus (-) symbol.
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5. Delete the print queue, if necessary.

6. Delete the .GZ file from the following hard-drive folder:

● Mac OS X 10.4: Library/Printers/PPDs/Contents/Resources/
<lang>.lproj, where <lang> is the two-letter language code for the language that you are
using.

● Mac OS X 10.5 and 10.6: Library/Printers/PPDs/Contents/Resources
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Priority for print settings for Mac

Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here might override
settings changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and do not override changes made in the Page Setup dialog box.

● Default printer driver settings: The default printer driver settings determine the settings used
in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties
dialog boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower
priority than changes made anywhere else.

Change printer-driver settings for Mac

Change the settings for all print
jobs until the software program
is closed

Change the default settings for
all print jobs

Change the product configuration
settings

1. On the File menu, click the Print
button.

2. Change the settings that you want
on the various menus.

1. On the File menu, click the Print
button.

2. Change the settings that you want
on the various menus.

3. On the Presets menu, click the
Save As... option and type a
name for the preset.

These settings are saved in the Presets
menu. To use the new settings, you must
select the saved preset option every time
you open a program and print.

Mac OS X 10.4

1. From the Apple menu , click the
System Preferences menu and
then click the Print & Fax icon.

2. Click the Printer Setup button.

3. Click the Installable Options
menu.

4. Configure the installed options.

Mac OS X 10.5 and 10.6

1. From the Apple menu , click the
System Preferences menu and
then click the Print & Fax icon.

2. Select the product in the left side of
the window.

3. Click the Options & Supplies
button.

4. Click the Driver tab.

5. Configure the installed options.
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Software for Mac computers

HP Utility for Mac

Use the HP Utility to set up product features that are not available in the printer driver.

You can use the HP Utility when the product uses a universal serial bus (USB) cable or is connected to a
TCP/IP-based network.

Open the HP Printer Utility

Mac OS X 10.4 1. Open the Finder, click Applications, click Utilities, and then double-click
Printer Setup Utility.

2. Select the product that you want to configure, and then click Utility.

Mac OS X 10.5 and 10.6 1. From the Printer Browser menu, click Printer Utility.

-or-

From the Print Queue, click the Utility icon.

HP Utility features

The HP Utility consists of pages that you open by clicking in the Configuration Settings list. The
following table describes the tasks that you can perform from these pages. At the top of any page, click
the HP Support link to access technical assistance, online supplies ordering, online registration, and
recycling and return information.

Menu Item Description

Information And
Support

Supplies Status Shows the product supplies status and provides links for online
supplies-ordering.

 Device Information Shows information about the currently selected product.

 Color Usage Shows the total pages printed, the number of pages printed in color,
and the number of pages printed in black only.

 File Upload Transfers files from the computer to the product.

 Upload Fonts Transfers font files from the computer to the product.

 Update Firmware Transfers a firmware update file to the product.

 Commands Sends special characters or print commands to the product after the
print job.

Printer Settings Trays Configuration Changes the default tray settings.

 Duplex Mode Turns on the automatic two-sided printing mode.

 Stored Jobs Manages print jobs that are stored on the product hard disk.

 E-mail Alerts Configures the product to send e-mail notices for certain events.

 Network Settings Configures the network settings, such as the IPv4 and IPv6 settings.
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Menu Item Description

 Supplies
Management

Configures how the product should behave when supplies are
nearing the end of their estimated life.

 Restrict Color Configures color-printing restrictions for specific users and software
programs.

NOTE: This option is available only after you open the View menu
and select the Show Advanced option.

 Protect Direct Ports Disables printing over USB or parallel ports.

 Additional Settings Provides access to the HP Embedded Web Server.

Supported utilities for Mac

HP Embedded Web Server

The product is equipped with the HP Embedded Web server, which provides access to information
about product and network activities. Access the HP Embedded Web Server from the HP Utility. Open
the Printer Settings menu, and then select the Additional Settings option.
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Print with Mac

Cancel a print job with Mac

1. If the print job is currently printing, cancel it by following this procedure:

a. Press the Stop  button on the product control panel.

b. From the list on the touchscreen, touch the print job you want to delete, and touch the Cancel
Job button.

c. The product prompts you to confirm the deletion. Touch the Yes button.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen,
allowing you to cancel the print job.

● Mac print queue: Open the print queue by double-clicking the product icon in the Dock.
Highlight the print job, and then click Delete.

Change the paper size and type with Mac

1. On the File menu in the software program, click the Print option.

2. In the Copies & Pages menu, click the Page Setup button.

3. Select a size from the Paper Size drop-down list, and then click the OK button.

4. Open the Finishing menu. (Mac OS X 10.5 and 10.6)

5. Select a type from the Media-type drop-down list.

6. Click the Print button.

Create and use printing presets with Mac

Use printing presets to save the current printer driver settings for reuse.

Create a printing preset

1. On the File menu, click the Print option.

2. Select the driver.

3. Select the print settings that you want to save for reuse.

4. In the Presets menu, click the Save As... option, and type a name for the preset.

5. Click the OK button.
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Use printing presets

1. On the File menu, click the Print option.

2. Select the driver.

3. In the Presets menu, select the printing preset.

NOTE: To use printer-driver default settings, select the standard option.

Resize documents or print on a custom paper size with Mac

Mac OS X 10.4, 10.5, and 10.6 1. On the File menu, click the Page Setup option.

2. Select the product, and then select the correct settings for the Paper Size and
Orientation options.

Mac OS X 10.5 and 10.6

Use one of these methods.

1. On the File menu, click the Print option.

2. Click the Page Setup button.

3. Select the product, and then select the correct settings for the Paper Size and
Orientation options.

1. On the File menu, click the Print option.

2. Open the Paper Handling menu.

3. In the Destination Paper Size area, click the Scale to fit paper size
box, and then select the size from the drop-down list.

Print a cover page with Mac

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Cover Page menu, and then select where to print the cover page. Click either the
Before Document button or the After Document button.

4. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select the standard option from the Cover Page Type
menu.

Use watermarks with Mac

1. On the File menu, click the Print option.

2. Open the Watermarks menu.

3. From the Mode menu, select the type of watermark to use. Select the Watermark option to print
a semi-transparent message. Select the Overlay option to print a message that is not transparent.
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4. From the Pages menu, select whether to print the watermark on all pages or on the first page
only.

5. From the Text menu, select one of the standard messages, or select the Custom option and type
a new message in the box.

6. Select options for the remaining settings.

Print multiple pages on one sheet of paper with Mac

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Layout menu.

4. From the Pages per Sheet menu, select the number of pages that you want to print on each
sheet (1, 2, 4, 6, 9, or 16).

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

Print on both sides (duplex) with Mac

1. Insert enough paper into one of the trays to accommodate the print job.

2. On the File menu, click the Print option.

3. Open the Layout menu.

4. From the Two-Sided menu, select a binding option.
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Store jobs with Mac

You can store jobs on the product so you can print them at any time. You can share stored jobs with
other users, or you can make them private.

1. On the File menu, click the Print option.

2. Open the Job Storage menu.

3. In the Job Storage Mode drop-down list, select the type of stored job.

● Proof and Hold: This feature provides a quick way to print and proof one copy of a job
and then print more copies.

● Personal Job: When you send a job to the product, the job does not print until you request
it at the product control panel. If you assign a personal identification number (PIN) to the job,
you must provide the required PIN at the control panel.

● Quick Copy: If the optional hard disk is installed on the product, you can print the
requested number of copies of a job and then store a copy of the job on the optional hard
disk. Storing the job allows you to print additional copies of the job later.

● Stored Job: If the optional hard disk is installed on the product, you can store a job such as
a personnel form, time sheet, or calendar on the product and allow other users to print the
job at any time. Stored jobs also can be protected by a PIN.

4. To use a custom user name or job name, click the Custom button, and then enter the user name
or the job name.

Select which option to use if another stored job already has that name.

Use Job Name + (1 - 99) Append a unique number to the end of the job name.

Replace Existing File Overwrite the existing stored job with the new one.

5. If you selected the Stored Job or Personal Job option in step 3, you can protect the job with a
PIN. Type a 4-digit number in the Use PIN to Print field. When other people attempt to print
this job, the product prompts them to enter this PIN number.

Set the color options with Mac

Use the Color Options menu or the Color/Quality Options menu to control how colors are
interpreted and printed from software programs.

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Color Options menu or the Color/Quality Options menu.

4. Select the appropriate tab and adjust the settings.
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Solve problems with a Mac
See Solve product software problems with Mac on page 319.
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5 Connect the product

● Printer sharing disclaimer

● Connect with USB

● Connect to a network
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Printer sharing disclaimer
HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems
and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.
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Connect with USB
This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a
cable that is no longer than 2 m (6.5 ft).

CAUTION: Do not connect the USB cable until the installation software prompts you to connect it.

CD installation

1. Quit all open programs on the computer.

2. Install the software from the CD, and follow the onscreen instructions.

3. When prompted, select the Directly connect to this computer using USB cable option,
and then click the Next button.

4. When the software prompts you, connect the USB cable to the product and the computer.

5. At the end of the installation, click the Finish button, or click the More Options button to install
more software.

6. On the More Options screen, you can install more software, or click the Exit button.

7. Print a page from any program to make sure that the software is correctly installed.

NOTE: If the installation failed, reinstall the software.

Connect to a network
You can configure network parameters from the control panel, the HP Embedded Web Server, or for
most networks, from the HP Web Jetadmin software.

NOTE: HP Web Jetadmin software is not supported on Mac OS X operating systems.
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For a complete list of supported networks and for instructions on configuring network parameters from
software, see the HP Jetdirect Embedded Print Server Administrator’s Guide. The guide comes with
products in which an HP Jetdirect embedded print server is installed.

Supported network protocols

Table 5-1  Supported network protocols

Network type Supported protocols

TCP/IP IPv4 and IPv6 networks ● Apple Bonjour

● Simple Network Management Protocol (SNMP) v1, v2, and v3

● Hyper Text Transfer Protocol (HTTP)

● Secure HTTP (HTTPS)

● File Transfer Protocol (FTP)

● Port 9100

● Line printer daemon (LPD)

● Intenet Printing Protocol (IPP)

● Secure IPP

● Web Services Dynamic Discovery (WS Discovery)

● IPsec/Firewall

TCP/IP IPv4 networks only ● Auto IP

● Service Location Protocol (SLP)

● Trivial File Transfer Protocol (TFTP)

● Telnet

● Internet Group Management Protocol (IGMP) v2

● Bootstrap Protocol (BOOTP)/DHCP

● Windows Internet Name Service (WINS)

● IP Direct Mode

● WS Print
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Table 5-1  Supported network protocols (continued)

Network type Supported protocols

TCP/IP IPv6 networks only ● Dynamic Host Configuration Protocol (DHCP) v6

● Multicast Listener Discovery Protocol (MLD) v1

● Internet Control Message Protocol (ICMP) v6

Other supported network protocols ● Internetwork Packet Exchange/Sequenced Packet Exchange (IPX/SPX)

● AppleTalk

● NetWare Directory Services (NDS)

● Bindery

● Novell Distributed Print Services (NDPS)

● iPrint

Table 5-2  Advanced Security features for network management

Service name Description

IPsec/Firewall Provides network-layer security on IPv4 and IPv6 networks. A firewall provides
simple control of IP traffic. IPsec provides additional protection through
authentication and encryption protocols.

Kerberos Allows you to exchange private information across an open network by assigning a
unique key, called a ticket, to each user who logs on to the network. The ticket is
then embedded in messages to identify the sender.

SNMP v3 Employs a user-based security model for SNMP v3, which provides user
authentication and data privacy through encryption.

SSL/TLS Allows you to transmit private documents via the Internet and guarantee privacy
and data integrity between the client and server applications.

IPsec batch configuration Provides network-layer security through the simple control of IP traffic to and from
the product. This protocol provides the benefits of encryption and authentication
and allows for multiple configurations.

Install the product on a wired network

Configure the IP address

1. Make sure the product is turned on and that the Ready message appears on the control-panel
display.
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2. Connect the network cable to the product and to the network.

3. Wait for 60 seconds before continuing. During this time, the network recognizes the product and
assigns an IP address or host name for the product.

4. At the product control panel, touch the Network Address button to identify the product IP address
or host name.

If the Network Address button is not visible, you can find the IP address or host name by printing a
configuration page.

a. At the product control panel, scroll to and touch the Administration button.

b. Open the following menus:

● Reports

● Configuration/Status Pages

● Configuration Page

c. Touch the View button to view the information on the control panel, or touch the Print button
to print the pages.
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d. Find the IP address on the Jetdirect page.

5. IPv4: If the IP address is 0.0.0.0, or 192.0.0.192, or 169.254.x.x, you must manually configure
the IP address. Otherwise, the network configuration was successful.

IPv6: If the IP address begins with "fe80:", the product should be able to print. If not, you must
manually configure the IP address.

Install the software

1. Quit all programs on the computer.

2. Install the software from the CD.

3. Follow the onscreen instructions.

4. When prompted, select the Connect through a wired network option.

5. From the list of available printers, select the printer that has the correct IP address.

6. At the end of the installation, click the Finish button, or click the More Options button to install
more software or configure basic digital sending features for the product.

● Install the HP PC Send Fax driver to enable sending faxes from your computer. (Fax models
only)

● Use the HP Scan to Email Setup Wizard to configure basic E-mail settings.

● Use the HP Save to Folder Setup Wizard to set up a shared folder on the network where you
can store scanned documents.

7. Print a page from any program to make sure that the software is correctly installed.
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Configure network settings

View or change network settings

Use the embedded Web server to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.

● If you are using IPv4, the IP address contains only digits. It has this format:

xxx.xxx.xxx.xxx

● If you are using IPv6, the IP address is a hexadecimal combination of characters and digits. It
has a format similar to this:

xxxx::xxxx:xxxx:xxxx:xxxx

2. To open the embedded Web server, type the IP address into the address line of a Web browser.

3. Click the Networking tab to obtain network information. You can change settings as needed.

Set or change the network password

Use the embedded Web server to set a network password or change an existing password.

1. Open the embedded Web server, click the Networking tab, and click the Security link.

NOTE: If a password has previously been set, you are prompted to type the password. Type the
password, and then click the Apply button.

2. Type the new password in the New Password box and in the Verify password box.

3. At the bottom of the window, click the Apply button to save the password.
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Manually configure IPv4 TCP/IP parameters from the control panel

Use the control-panel Administration menus to manually set an IPv4 address, subnet mask, and default
gateway.

1. From the Home screen, scroll to and touch the Administration button.

2. Open each of the following menus:

a. Network Settings

b. Embedded Jetdirect Menu

c. TCP/IP

d. IPV4 Settings

e. Config Method

f. Manual

g. Manual Settings

h. IP Address, Subnet Mask, or Default Gateway

3. Use the keypad to specify the IP address, subnet mask, or default gateway.
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Manually configure IPv6 TCP/IP parameters from the control panel

Use the control-panel Administration menus to manually set an IPv6 address.

1. From the Home screen, scroll to and touch the Administration button.

2. To enable manual configuration, open each of the following menus:

a. Network Settings

b. Embedded Jetdirect Menu

c. TCP/IP

d. IPV6 Settings

e. Address

f. Manual Settings

g. Enable

Select the On option, and then touch the Save button.

3. To configure the address, open each of the following menus:

● Network Settings

● Embedded Jetdirect Menu

● TCP/IP

● IPV6 Settings

● Address

Use the keypad to enter the address.

NOTE: If you are using the arrow buttons, you must press the OK button after entering each
digit.
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6 Paper and print media

● Understand paper use

● Change the printer driver to match the paper type and size in Windows

● Supported paper sizes

● Supported paper types

● Load paper trays

● Configure trays

● Select an output bin (fskm models only)
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Understand paper use
This product supports a variety of paper and other print media in accordance with the guidelines in this
user guide. Paper or print media that does not meet these guidelines might cause poor print quality,
increased jams, and premature wear on the product.

For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Do
not use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend
the use of other brands of media because HP cannot control their quality.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity levels,
or other variables over which Hewlett-Packard has no control.

CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.

Special paper guidelines

This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in the printer driver
to obtain the best results.

CAUTION: HP LaserJet products use fusers to bond dry toner particles to the paper in very precise
dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper could damage the
product.

Media type Do Do not

Envelopes ● Store envelopes flat.

● Use envelopes where the seam
extends all the way to the corner of
the envelope.

● Use peel-off adhesive strips that are
approved for use in laser printers.

● Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.

● Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

● Do not use self-stick adhesives or
other synthetic materials.

Labels ● Use only labels that have no
exposed backing between them.

● Use labels that lie flat.

● Use only full sheets of labels.

● Do not use labels that have
wrinkles or bubbles, or are
damaged.

● Do not print partial sheets of labels.

Transparencies ● Use only transparencies that are
approved for use in color laser
printers.

● Place transparencies on a flat
surface after removing them from
the product.

● Do not use transparent print media
not approved for laser printers.
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Media type Do Do not

Letterhead or preprinted forms ● Use only letterhead or forms
approved for use in laser printers.

● Do not use raised or metallic
letterhead.

Heavy paper ● Use only heavy paper that is
approved for use in laser printers
and meets the weight specifications
for this product.

● Do not use paper that is heavier
than the recommended media
specification for this product unless
it is HP paper that has been
approved for use in this product.

Glossy or coated paper ● Use only glossy or coated paper
that is approved for use in laser
printers.

● Do not use glossy or coated paper
designed for use in inkjet products.

ENWW Understand paper use 83



Change the printer driver to match the paper type
and size in Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

5. Select a paper type from the Paper type drop-down list.

6. Click the OK button.
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Supported paper sizes
NOTE: To obtain best results, select the correct paper size and type in the printer driver before
printing.

Table 6-1  Supported paper and print media sizes

Size and dimensions Tray 1 Tray 2 Optional Trays
3, 4, and 5

Automatic
duplex printing

Letter

216 x 279 mm (8.5 x 11 in)

Legal

216 x 356 mm (8.5 x 14 in)

Executive

184 x 267 mm (7.24 x 10.51 in)

Statement

140 x 216 mm (5.5 x 8.5 in)

   

8.5 x 13

216 x 330 mm (8.5 x 13 in)

4 x 6

101.6 x 152.4 mm (4 x 6 in)

   

10 x 15 cm

101.6 x 152.4 mm (4 x 6 in)

   

5 x 7

127 x 188 mm (5 x 7 in)

   

5 x 8

127 x 203 mm (5 x 8 in)

   

A4

210 x 297 mm (8.27 x 11.69 in)

RA4

215 x 305 mm (8.46 x 12.01 in)

A5

148 x 210 mm (5.83 x 8.27 in)

A6

105 x 148 mm (4.13 x 5.82 in)

   

ENWW Supported paper sizes 85



Table 6-1  Supported paper and print media sizes (continued)

Size and dimensions Tray 1 Tray 2 Optional Trays
3, 4, and 5

Automatic
duplex printing

B5 (JIS)

182 x 257 mm (7.17 x 10.12 in)

B6 (JIS)

128 x 182 mm (5.03 x 7.16 in)

   

16K

195 x 270 mm (7.67 x 10.62 in)

184 x 260 mm (7.24 x 10.23 in)

197 x 273 mm (7.75 x 10.74 in)

Postcard (JIS)

100 x 148 mm (3.93 x 5.82 in)

   

DPostcard (JIS)

148 x 200 mm (5.82 x 7.87 in)

   

Custom

89 x 127 mm to 216 x 356 mm (3.5 x 5 in to
8.5 x 14 in)

1    

Custom

148 x 210 mm to 216 x 356 mm (5.83 x 8.27 in
to 8.5 x 14 in)

  

Envelope #9

98 x 225 mm (3.85 x 8.85 in)

   

Envelope #10

105 x 241 mm (4.13 x 9.48 in)

   

Envelope Monarch

98 x 191 mm (3.9 x 7.5 in)

   

Envelope B5

176 x 250 mm (6.92 x 9.84 in)

   

Envelope C5

162 x 229 mm (6.37 x 9.01 in)

   

Envelope C6

162 x 114 mm (6.37 x 4.48 in)
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Table 6-1  Supported paper and print media sizes (continued)

Size and dimensions Tray 1 Tray 2 Optional Trays
3, 4, and 5

Automatic
duplex printing

Envelope DL ISO

110 x 220 mm (4.33 x 8.66 in)

   

1 The product can print on 89 x 127 mm (3.5 x 5 in) size paper from Tray 1 for Extra Heavy (131-175 g/m2) and Cardstock
(176-220 g/m2) paper types.
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Supported paper types

Paper type Tray 1 Tray 2 Optional Trays 3,
4, and 5

Automatic duplex
printing

Plain Paper

HP Matte (105 g/m2)

HP Matte (120 g/m2)

HP Matte (160 g/m2) 1 1 2

HP Matte (200 g/m2) 1 1  

HP Soft Gloss (120 g/m2)

HP Glossy (130 g/m2)

HP Glossy (160 g/m2)

HP Glossy (220 g/m2)

Light (60–74 g/m2)

Midweight (96–110 g/m2)

Heavy (111–130 g/m2)

Extra Heavy (131–175 g/m2) 1 1 2

Cardstock (176–220 gm2) 1 1  

Mid-weight glossy (96–110 g/m2)

Heavy glossy (111–130 g/m2)

Extra-heavy glossy (131–175 g/m2)

Card glossy (176–220 g/m2)

Color Transparency  

Labels 1 1  

Letterhead

Envelope    

Preprinted

Prepunched

Colored

Bond

Recycled

Rough

HP Tough Paper
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Paper type Tray 1 Tray 2 Optional Trays 3,
4, and 5

Automatic duplex
printing

Opaque film

1 Trays 2, 3, 4, and 5 can print on this paper in some circumstances, but HP does not guarantee results.
2 The product can automatically print on both sides for this paper type in some circumstances, but HP does not guarantee

results.
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Load paper trays

Load Tray 1

CAUTION: To avoid jams, never add or remove paper from Tray 1 during printing.

1. Open Tray 1.  

2. Fold out the tray extension to support the
paper and set the side guides to the correct
width.
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3. Load paper in the tray.  

4. Make sure the stack fits under the tabs on the
guides and does not exceed the load-level
indicators.

 

5. Adjust the side guides so that they lightly touch
the paper stack but do not bend it.
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Load Tray 2 and optional Trays 3, 4, and 5 with standard-size
paper 

1. Open the tray.

NOTE: Do not open the tray while it is in
use.

 

2. Adjust the paper-length and paper-width
guides by squeezing the adjustment latches
and sliding the guides to the size of the paper
being used.

 

3. Load paper into the tray. Check the paper to
verify the guides lightly touch the stack, but do
not bend it.

NOTE: To prevent jams, do not overfill the
tray. Be sure the top of the stack is below the
tray full indicator.

NOTE: If the tray is not adjusted correctly,
an error message might appear during
printing or the paper might jam.
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4. Close the tray.  

5. The control panel shows the tray’s paper type
and size. If the configuration is not correct,
follow the instructions on the control panel to
change the size or type.

 

Load Tray 2 and optional Trays 3, 4, and 5 with custom-size paper 

1. Open the tray.  
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2. Adjust the paper-length and paper-width
guides by squeezing the adjustment latches
and sliding the guides to the size of the paper
being used.

 

3. Load paper into the tray. Check the paper to
verify the guides lightly touch the stack, but do
not bend it.
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4. Close the tray.  

5. The control panel prompts you to set the paper
size and type. Select the Custom setting, and
then configure the X and Y dimensions of the
custom paper size.

NOTE: See the label in the paper tray, or
the following illustration, to determine the X
and Y dimensions.

 

Y
X
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Tray and bin capacity

Tray or bin Paper type Specifications Quantity

Tray 1 Paper Range:

60 g/m2 (16 lb) bond to 216 g/
m2 (58 lb) bond

Maximum stack height: 10 mm
(0.39 in)

Equivalent to 100 sheets of
75 g/m2 (20 lb) bond

Envelopes Less than 60 g/m2 (16 lb) bond
to 90 g/m2 (24 lb) bond

Up to 10 envelopes

Labels Maximum 0.102 mm (0.004 in)
thick

Maximum stack height: 10 mm
(0.39 in)

Transparencies Minimum 0.102 mm (0.004 in)
thick

Maximum stack height: 10 mm
(0.39 in)

Up to 50 sheets

Glossy paper Range:

105 g/m2 (28 lb) bond to 220
g/m2 (58 lb) bond

Maximum stack height: 10 mm
(0.39 in)

Up to 50 sheets

Tray 2 Paper Range:

60 g/m2 (16 lb) bond to 220 g/
m2 (59 lb) bond

Maximum stack height: 56 mm
(2.2 in)

Equivalent to 500 sheets of
75 g/m2 (20 lb) bond

Transparencies Minimum 0.102 mm (0.004 in)
thick

Maximum stack height: 56 mm
(2.2 in)

Glossy paper Range:

105 g/m2 (28 lb) bond to
220 g/m2 (58 lb) bond

Maximum stack height: 56 mm
(2.2 in)

Optional Trays 3, 4, and 5 Paper Range:

60 g/m2 (16 lb) bond to 220 g/
m2 (59 lb) bond

Maximum stack height: 56 mm
(2.2 in)

Equivalent to 500 sheets of
75 g/m2 (20 lb) bond

Transparencies Minimum 0.102 mm (0.004 in)
thick

Maximum stack height: 56 mm
(2.2 in)

Glossy paper Range:

105 g/m2 (28 lb) bond to
220 g/m2 (58 lb) bond

Maximum stack height: 56 mm
(2.2 in)

Output bin Paper  Up to 500 sheets of 75 g/m2

(20 lb) bond

Document feeder Paper Range:

60 g/m2 (16 lb) bond to 220 g/
m2 (59 lb) bond

Up to 50 sheets of 75 g/m2

(20 lb) bond
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NOTE: Trays 2, 3, 4, and 5 can print on bond paper heavier than 220 g/m2 (59 lb) in some
circumstances, but HP does not guarantee results.
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Paper orientation for loading trays

If you are using paper that requires a specific orientation, load it according to the information in the
following tables.

NOTE: The Alternative Letterhead Mode and Image Rotation settings affect the way you load
letterhead or preprinted paper. The following information depicts the default setting.

Paper orientation for loading Tray 1

Paper type Image orientation Duplex mode How to load paper

Preprinted or letterhead Portrait 1-sided printing Face down

Bottom edge leading into the product

Automatic 2-sided printing Face up

Bottom edge leading into the product

Landscape 1-sided printing Face down

Top edge toward the back of the product

Automatic 2-sided printing Face up

Top edge toward the back of the product

98 Chapter 6   Paper and print media ENWW



Paper type Image orientation Duplex mode How to load paper

Prepunched Portrait or landscape 1- or 2-sided printing Holes toward the back of the product

Envelopes Landscape

Short edge of the envelope
feeding into the product

1-sided printing Face down

Top edge toward the front of the product

Portrait

Long edge of the envelope
feeding into the product

1-sided printing Face down

Top edge leading into the product
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Paper orientation for loading Tray 2 or Trays 3, 4, and 5

Paper type Image orientation Duplex mode How to load paper

Preprinted or letterhead Portrait 1-sided printing Face up

Top edge at the left side of the tray

Automatic 2-sided printing Face down

Top edge at the left side of the tray

Landscape 1-sided printing Face up

Top edge toward the back of the product

Automatic 2-sided printing Face down

Top edge toward the back of the product

Prepunched Portrait or landscape 1- or 2-sided printing Holes toward the back of the product
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Configure trays
The product automatically prompts you to configure a tray for type and size in the following situations:

● When you load paper into the tray

● When you specify a particular tray or paper type for a print job through the printer driver or a
software program and the tray is not configured to match the print-job’s settings

NOTE: The prompt does not appear if you are printing from Tray 1, and it is configured for the Any
Size paper size and the Any Type paper type settings. In this situation, if the print job does not specify
a tray, the product prints from Tray 1, even if the paper size and type settings in the print job do not
match the paper loaded in Tray 1.

Configure a tray when loading paper

1. Load paper in the tray. Close the tray if you are using Tray 2, 3, 4, or 5.

2. The tray configuration message appears.

3. Touch the OK button to accept the detected size and type, or touch the Modify button to choose a
different paper size or type.

4. Select the correct size and type and then touch the OK button.

Configure a tray to match print job settings

1. In the software program, specify the source tray, the paper size, and the paper type.

2. Send the job to the product.

If the tray needs to be configured, the tray configuration message appears.

3. Load the tray with the specified type and size of paper, and then close the tray.

4. Touch the OK button to accept the detected size and type, or touch the Modify button to choose a
different paper size or type.

5. Select the correct size and type and then touch the OK button.

Configure a tray by using the control panel

You can also configure the trays for type and size without a prompt from the product.

1. From the Home screen, touch the Trays button.

2. Touch the line for the tray that you want to configure, and then touch the Modify button.

3. Select the paper size and paper type from the lists of options.

4. Touch the OK button to save your selection.
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Automatic paper sensing (auto-sense mode)

The automatic paper type sensor functions when a tray is configured to the Any Type or plain type
setting.

After it has picked up paper from the tray, the product can detect overhead transparencies, paper
weight, and gloss level.

For more control, select a specific paper type in the job or configure the tray for a specific paper type.

Auto-sense settings

Full sensing (Tray 1 only) For each sheet of paper that it picks up from the tray, the product detects light
paper, plain paper, heavy paper, glossy paper, tough paper, and transparencies.

Expanded sensing

NOTE: This is the default setting for all
trays.

For the first few sheets of paper that it picks up from the tray, the product detects
light paper, plain paper, heavy paper, glossy paper, tough paper, and
transparencies. The product assumes the rest of the pages are of the same type.

Transparency only The product distinguishes between transparencies and non-transparencies. This
setting provides the fastest printing, but for some paper types it might reduce print
quality.
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Select an output bin (fskm models only)
You can configure the product to use different output bins for printing, copying, and faxing. You can
also configure the product to sort jobs according to the username associated with each job, or to stack
all jobs from the lower bin to the upper bin.

NOTE: You can also select output bins from the printer driver. Selections that you make in the printer
driver override control-panel settings.

2
1

3

1 Upper-Left Bin

2 Middle-Left Bin

3 Lower-Left Bin

1. From the Home screen, scroll to and touch the Administration menu.

2. Open each of the following menus:

● Stapler/Stacker Settings

● Operation Mode

3. To configure the product to sort jobs into different bins according to product function, select the
Function Separator option. Touch the OK button.

NOTE: You can also select the Mailbox option to sort jobs according to the username
associated with the job.

Select the Stacker option to stack all jobs into the lower output bin first. When the lower bin is full,
jobs stack into the middle bin, and then into the upper bin.
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4. To configure the bin for copy jobs, open these menus, and then select a bin from the list of
options.

● Administration

● Copy Settings

● Output Bin

5. To configure the bin for printing incoming faxes, open these menus:

● Administration

● Fax Settings

● Fax Receive Settings

● Default Job Options

● Output Bin

Select a bin from the list of options.

NOTE: All stapled jobs always go to the lower bin.

NOTE: For print jobs, select the output bin in the printer driver.
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Print cartridge information

Feature Description

Part numbers ● Standard-capacity black print cartridge: CE260A

● High-capacity black print cartridge: CE264X

● Cyan print cartridge: CF031A

● Yellow print cartridge: CF032A

● Magenta print cartridge: CF033A

Accessibility ● The print cartridges can be installed and removed by using one hand.

Environmental
features

● Recycle print cartridges by using the HP Planet Partners return and recycling program.

For more information about supplies, go to www.hp.com/go/learnaboutsupplies.
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Supplies views

Print cartridge views

3

1
2

1 Plastic shield

2 Imaging drum

3 Print cartridge memory tag
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Manage print cartridges
Correctly using, storing, and monitoring the print cartridge can help ensure high-quality print output.

Settings for print cartridges

Print when a print cartridge is at estimated end of life

● A <Color> <Supply> Low message—where <Color> is the color of the supply, and <Supply>
is the type of supply—appears when a supply is nearing the estimated end of its useful life.

● A <Color> <Supply> Very Low message appears when a supply is at its estimated end of
useful life.

Print-quality problems can occur when using a supply that is at its estimated end of life.

Enable or disable the Very Low Settings options from the control panel

You can enable or disable the default settings at any time, and you do not have to re-enable them
when you install a new cartridge.

1. From the Home screen on the control panel, touch the Administration button.

2. Open the following menus:

● Manage Supplies

● Supply Settings

● Black Cartridge or Color Cartridges

● Very Low Settings

3. Select one of the following options:

● Select the Continue option to set the product to alert you that the cartridge is very low, but to
continue printing.

NOTE: Using the Continue setting allows printing beyond Very Low without customer
interaction and can result in unsatisfactory print quality.

● Select the Stop option to set the product to stop printing (including printing faxes) until you
replace the cartridge.

● Select the Prompt to continue option to set the product to stop printing (including printing
faxes) and prompt you to replace the cartridge. You can acknowledge the prompt and
continue printing.

If you select the Stop or Prompt to continue option, the product stops printing when it reaches the Very
Low threshold. When you replace the cartridge, the product automatically resumes printing.

When the product is set to the Stop or Prompt to continue option, there is some risk that faxes will not
print when the product resumes printing. This can occur if the product has received more faxes than the
memory can hold while the product is waiting.
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The product can print faxes without interruption when it passes the Very Low threshold if you select the
Continue option for color and black cartridges, but print quality might degrade.

Once an HP supply has reached Very Low, HP’s premium Protection Warranty on that supply has
ended.

Recycle supplies

To recycle a genuine HP print cartridge, place the used cartridge in the box in which the new cartridge
arrived. Use the enclosed return label to send the used supply to HP for recycling. For complete
information, see the recycling guide that is included with each new HP supply item.

Print-cartridge storage

Do not remove the print cartridge from its package until you are ready to use it.

CAUTION: To prevent damage to the print cartridge, do not expose it to light for more than a few
minutes.

HP policy on non-HP print cartridges

Hewlett-Packard Company cannot recommend the use of non-HP print cartridges, either new or
remanufactured.

NOTE: Any damage caused by a non-HP print cartridge is not covered under the HP warranty and
service agreements.

HP fraud hotline and Web site

Call the HP fraud hotline (1-877-219-3183, toll-free in North America) or go to www.hp.com/go/
anticounterfeit when you install an HP print cartridge and the control-panel message says the cartridge
is non-HP. HP will help determine if the cartridge is genuine and take steps to resolve the problem.

Your print cartridge might not be a genuine HP print cartridge if you notice the following:

● The supplies status page indicates that a non-HP supply is installed.

● You are experiencing a high number of problems with the print cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from
HP packaging).
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Replacement instructions

Replace print cartridges

The product uses four colors and has a different print cartridge for each color: black (K), magenta (M),
cyan (C), and yellow (Y).

CAUTION: If toner gets on clothing, wipe it off with a dry cloth and wash the clothes in cold water.
Hot water sets toner into fabric.

NOTE: Information about recycling used print cartridges is on the print-cartridge box.

1. Open the front door. Make sure that the door
is completely open.

 

2. Grasp the handle of the used print cartridge
and pull out to remove.

 

3. Store the used print cartridge in a protective
bag. Information about recycling used print
cartridges is on the print-cartridge box.
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4. Remove the new print cartridge from its
protective bag.

NOTE: Be careful not to damage the
memory tag on the print cartridge.

 

5. Grasp both sides of the print cartridge and
distribute the toner by gently rocking the print
cartridge.

 

6. Remove the orange protective cover from the
print cartridge.

CAUTION: Avoid prolonged exposure to
light.

CAUTION: Do not touch the green roller.
Doing so can damage the cartridge.
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7. Align the print cartridge with its slot and insert
the print cartridge until it clicks into place.

NOTE: The print cartridges go in at a slight
angle.

 

8. Close the front door.  

Replace the toner collection unit

Replace the toner collection unit when the control panel prompts you.

NOTE: The toner collection unit is designed for a single use. Do not attempt to empty the toner
collection unit and reuse it. Doing so could lead to toner being spilled inside the product, which could
result in reduced print quality. After use, return the toner collection unit to HP’s Planet Partners program
for recycling.
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1. Open the front door. Make sure that the door
is completely open.

 

2. Grasp the top of the toner collection unit and
remove it from the product.

 

3. Place the attached cap over the opening at the
top of the unit.
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4. Remove the new toner collection unit from its
packaging.

 

5. Insert the bottom of the new unit into the
product first and then push the top of the unit
until it clicks into place.

 

6. Close the front door.

NOTE: If the toner collection unit is not
installed correctly, the front door does not
close completely.

To recycle the used toner collection unit, follow
the instructions included with the new toner
collection unit.
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Replace the staple cartridge

1. Lift the gray latch on the front of the stapler,
and open the stapler cover.

 

2. Lift the green tab on the staple cartridge up,
and then pull the staple cartridge straight out.

 

3. Insert the new staple cartridge into the stapler
and push down on the green handle until it
snaps into place.

 

4. Close the stapler cover.  
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Solve problems with supplies

Check the print cartridges

Check the print cartridge, and replace it if necessary, if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Printed pages have small unprinted areas.

● Printed pages have streaks or bands.

NOTE: If you are using a draft or EconoMode print setting, the printing might appear light.

If you determine that you need to replace a print cartridge, print the supplies status page to find the
part number for the correct genuine HP print cartridge.

Type of print cartridge Steps to resolve the problem

Refilled or remanufactured print
cartridge

Hewlett-Packard Company cannot recommend the use of non-HP supplies, either
new or remanufactured. Because they are not HP products, HP cannot influence
their design or control their quality. If you are using a refilled or remanufactured
print cartridge and are not satisfied with the print quality, replace the cartridge with
a genuine HP cartridge that has the words “HP” or “Hewlett-Packard” on it, or has
the HP logo on it.

Genuine HP print cartridge 1. The product control panel or the supplies status page indicates Very Low
status when the cartridge has reached the end of its designated life. Replace
the print cartridge if print quality is no longer acceptable.

2. Visually inspect the print cartridge for damage. See the instructions that follow.
Replace the print cartridge if necessary.

3. If printed pages have marks that repeat several times at the same distance
apart, print a cleaning page. If this does not solve the problem, use the
repeating defects information in this document to identify the cause of the
problem.
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Inspect the print cartridge for damage

1. Remove the print cartridge from the product, and verify that the sealing tape has been removed.

2. Check the memory chip for damage.

3. Examine the surface of the green imaging drum on the bottom of the print cartridge.

CAUTION: Do not touch the green roller (imaging drum) on the bottom of the cartridge.
Fingerprints on the imaging drum can cause print-quality problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the print
cartridge.

5. If the imaging drum does not appear to be damaged, rock the print cartridge gently several times
and reinstall it. Print a few pages to see if the problem has resolved.
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Repeating defects

If defects repeat at regular intervals on the page, use this ruler to identify the cause of the defect. Place
the top of the ruler at the first defect. The marking that is beside the next occurrence of the defect
indicates which component needs to be replaced.

Figure 7-1  Repetitive defects ruler
0 mm

27 mm

32 mm

44 mm

55 mm

48 mm
51 mm

63 mm

76 mm

80 mm

96 mm

101 mm

Distance between defects Product components that cause the defect

27 mm Print cartridge

32 mm Print cartridge

44 mm Transfer unit

48 mm Print cartridge

51 mm Transfer roller

55 mm Print engine

63 mm Transfer unit

76 mm Print cartridge

76 mm Fuser

80 mm Fuser

96 mm Print engine

101 mm Print engine
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Print the Supplies Status page

The Supplies Status page indicates the estimated life remaining in print cartridges. It also lists the part
number for the correct genuine HP print cartridge for your product so you can order a replacement
print cartridge, as well as other useful information.

1. Open the following menus:

● Administration

● Reports

● Configuration/Status Pages

2. Select the Supplies Status option, and then touch the Print button to print the report.
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Interpret control panel messages for supplies

The following table contains important information about supplies status messages.

Table 7-1  Supplies status messages

Control panel message Description Recommended action

10.XX.YY Supply memory error The product cannot read or write to at least
one print cartridge memory chip or a
memory chip is missing from a print
cartridge.

XX values

● 00 = Memory chip memory error

● 10 = Memory chip missing

YY values

● 00 = Black

● 01 = Cyan

● 02 = Magenta

● 03 = Yellow

Reinstall the print cartridge, or install a new
print cartridge.

Black cartridge low The product indicates when a supply level is
low. Actual print cartridge life might vary.
You do not need to replace the print
cartridge at this time unless print quality is no
longer acceptable.

If print quality is no longer acceptable,
replace the print cartridge. Consider
purchasing a replacement cartridge so it is
available when the installed cartridge has
reached the end of its estimated life.

Black cartridge very low The product indicates when a supply level is
very low. Actual print cartridge life might
vary. You do not need to replace the print
cartridge at this time unless print quality is no
longer acceptable. After an HP supply has
reached the very low threshold, the HP
premium protection warranty for that supply
has ended.

If print quality is no longer acceptable,
replace the print cartridge. Consider
purchasing a replacement cartridge so it is
available when the installed cartridge has
reached the end of its estimated life.

Cyan cartridge low The product indicates when a supply level is
low. Actual print cartridge life might vary.
You do not need to replace the print
cartridge at this time unless print quality is no
longer acceptable.

If print quality is no longer acceptable,
replace the print cartridge. Consider
purchasing a replacement cartridge so it is
available when the installed cartridge has
reached the end of its estimated life.
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Table 7-1  Supplies status messages (continued)

Control panel message Description Recommended action

Cyan cartridge very low The product indicates when a supply level is
very low. Actual print cartridge life might
vary. Consider having a replacement print
cartridge available to install when print
quality is no longer acceptable. You do not
need to replace the print cartridge at this
time unless print quality is no longer
acceptable. After an HP supply has reached
the very low threshold, the HP premium
protection warranty for that supply has
ended.

If print quality is no longer acceptable,
replace the print cartridge.

Fuser kit low The fuser kit is low. The actual supply life
remaining might vary. Consider having a
replacement fuser kit available to install
when print quality is no longer acceptable.
You do not need to replace the fuser kit at
this time unless print quality is no longer
acceptable.

If print quality is no longer acceptable,
replace the fuser kit. Instructions are included
with the fuser kit.

Fuser kit very low The fuser kit is very low. The actual supply
life remaining might vary. You do not need
to replace the fuser kit at this time unless
print quality is no longer acceptable. After
an HP supply has reached the very low
threshold, the HP premium protection
warranty for that supply has ended.

If print quality is no longer acceptable,
replace the fuser kit. Instructions are included
with the fuser kit.

Incompatible <color> cartridge The indicated color print cartridge is not
compatible with this product.

Replace the print cartridge with one that is
designed for this product.

Incompatible fuser The fuser is not compatible with this product. CAUTION: The fuser can be hot while the
product is in use. Wait for the fuser to cool
before handling it.

1. Open the right door.

2. Remove the incompatible fuser.

3. Install the correct fuser.

4. Close the right door.

Incompatible supplies Print cartridges or other supply items are
installed that were not designed for this
product. The product cannot print with these
supplies installed.

Touch the Supplies button to identify the
incompatible supplies. Install supplies that
are designed for this product.

Incompatible transfer unit The transfer unit is incompatible with this
product.

1. Open right door.

2. Remove the incompatible transfer unit.

3. Install the correct transfer unit.

4. Close the right door.
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Table 7-1  Supplies status messages (continued)

Control panel message Description Recommended action

Magenta cartridge low The product indicates when a supply level is
low. Actual print cartridge life might vary.
You do not need to replace the print
cartridge at this time unless print quality is no
longer acceptable.

If print quality is no longer acceptable,
replace the print cartridge. Consider
purchasing a replacement cartridge so it is
available when the installed cartridge has
reached the end of its estimated life.

Magenta cartridge very low The product indicates when a supply level is
very low. Actual print cartridge life might
vary. Consider having a replacement print
cartridge available to install when print
quality is no longer acceptable. You do not
need to replace the print cartridge at this
time unless print quality is no longer
acceptable. After an HP supply has reached
the very low threshold, the HP premium
protection warranty for that supply has
ended.

If print quality is no longer acceptable,
replace the print cartridge.

Replace <color> cartridge The product indicates when a supply level is
at its estimated end of life. The actual life
remaining might be different than the
estimation. Have a replacement supply
available to install when print quality is no
longer acceptable. The supply does not need
to be replaced now unless the print quality is
no longer acceptable. After an HP supply
has reached its approximated end of life,
HP’s premium Protection Warranty on that
supply ends.

Replace the specified color cartridge.

Or, configure the product to continue
printing by using the Manage Supplies
menu.

Replace fuser kit The product indicates when the fuser kit is at
its estimated end of life. The actual life
remaining might be different than the
estimation. Have a replacement fuser kit
available to install when print quality is no
longer acceptable. The fuser kit does not
need to be replaced now unless the print
quality is no longer acceptable. After the
fuser kit reaches its approximated end of life,
HP’s premium Protection Warranty on that
fuser kit ends.

CAUTION: The fuser can be hot while the
product is in use. Wait for the fuser to cool
before handling it.

1. Open the right door.

2. Grasp the blue handles on both sides of
the fuser and pull straight out to remove
it.

3. Install the new fuser.

4. Close the right door.

Replace supplies Two or more supplies are at the estimated
end of life. The actual life remaining might
be different than the estimation. Consider
having replacement supplies available to
install when print quality is no longer
acceptable. The supply does not need to be
replaced now unless the print quality is no
longer acceptable. After an HP supply has
reached its approximated end of life, HP’s
premium Protection Warranty on that supply
ends.

Touch the Supplies button to see which
supplies need to be replaced.

Or, configure the product to continue
printing by using the Manage Supplies
menu.
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Table 7-1  Supplies status messages (continued)

Control panel message Description Recommended action

Replace toner collection unit The product indicates when a toner
collection unit is at its estimated end of life.
The actual life remaining might be different
than the estimation. Have a replacement
toner collection unit available to install when
print quality is no longer acceptable. The
toner collection unit does not need to be
replaced now unless the print quality is no
longer acceptable. After a toner collection
unit has reached its approximated end of
life, HP’s premium Protection Warranty on
that toner collection unit ends.

Replace the toner collection unit.

If you wish to have the toner collection unit
operate past its estimated capacity,
configure the product to continue printing by
using the Manage Supplies menu. This is not
a recommended option because of the risk of
overfilling the toner collection unit, which
could result in the need to service the
product.

Replace transfer kit The product indicates when a transfer kit is
at its estimated end of life. The actual life
remaining might be different than the
estimation. Have a replacement transfer kit
available to install when print quality is no
longer acceptable. The transfer kit does not
need to be replaced now unless the print
quality is no longer acceptable. After a
transfer kit has reached its approximated
end of life, HP’s premium Protection
Warranty on that transfer kit ends.

Replace the transfer kit. Instructions are
included with the transfer kit.

Supplies in wrong position Two or more print-cartridge slots contain the
wrong color print cartridge.

From left to right, the print cartridges should
be installed in this order:

● Yellow

● Magenta

● Cyan

● Black

Install the correct color cartridge in each slot.

Supplies low This message appears when at least two
supplies have reached the low threshold. The
actual supply life remaining might vary.
Touch the Supplies button to see which
supplies are low. You do not need to replace
the supplies at this time unless print quality is
no longer acceptable. After an HP supply
has reached the very low threshold, the HP
premium protection warranty for that supply
has ended.

To continue printing in color, either replace
the supply or reconfigure the product by
using the Manage Supplies menu on the
control panel.
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Table 7-1  Supplies status messages (continued)

Control panel message Description Recommended action

Supplies very low This message appears when at least two
supplies have reached the very low
threshold. Touch the Supplies button to see
which supplies are low. The actual supply
life remaining might vary. You do not need
to replace the supplies at this time unless
print quality is no longer acceptable. After
an HP supply has reached the very low
threshold, the HP premium protection
warranty for that supply has ended.

To continue printing in color, either replace
the supply or reconfigure the product by
using the Manage Supplies menu on the
control panel.

Toner collection unit low The toner collection unit is almost full. The
actual supply life remaining might vary. You
do not need to replace the toner collection
unit at this time unless print quality is no
longer acceptable.

To continue printing, either touch the OK
button or replace the toner collection unit.

Toner collection unit very low The toner collection unit is almost full, and
the product is configured to stop at this point.
The actual supply life remaining might vary.
After an HP supply has reached the very low
threshold, the HP premium protection
warranty for that supply has ended.

Reconfigure the product to continue printing,
or replace the toner collection unit.

CAUTION: Continuing to print when the
toner collection unit is full could damage the
product.

Transfer kit low This message appears when the transfer kit
reaches the low threshold. The actual supply
life remaining might vary. You do not need
to replace the transfer kit at this time unless
print quality is no longer acceptable.

No action is necessary to continue. If the
print quality is no longer acceptable, replace
the transfer kit. Instructions are included with
the new transfer kit.

Transfer kit very low This message appears when the transfer kit
has reached the very low threshold. The
actual supply life remaining might vary. You
do not need to replace the supplies at this
time unless print quality is no longer
acceptable. After an HP supply has reached
the very low threshold, the HP premium
protection warranty for that supply has
ended.

To continue printing, either replace the
transfer kit or reconfigure the product to
continue printing by using the Manage
Supplies menu on the control panel.

Unsupported supply installed One of the print cartridges is for a different
HP product.

If print quality is no longer acceptable,
replace the print cartridge.

Used supply in use One of the print cartridges has been
previously used.

If you believe you purchased a genuine HP
supply, go to www.hp.com/go/
anticounterfeit.
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Table 7-1  Supplies status messages (continued)

Control panel message Description Recommended action

Wrong cartridge in <color> slot The indicated slot for a print cartridge
contains a cartridge that is not the correct
color. From left to right, the print cartridges
should be installed in this order:

● Yellow

● Magenta

● Cyan

● Black

Remove the print cartridge from that slot, and
install a cartridge that is the correct color.

Yellow cartridge low The product indicates when a supply level is
low. Actual print cartridge life might vary.
You do not need to replace the print
cartridge at this time unless print quality is no
longer acceptable.

If print quality is no longer acceptable,
replace the print cartridge. Consider
purchasing a replacement cartridge so it is
available when the installed cartridge has
reached the end of its estimated life.

Yellow cartridge very low The product indicates when a supply level is
very low. Actual print cartridge life might
vary. Consider having a replacement print
cartridge available to install when print
quality is no longer acceptable. You do not
need to replace the print cartridge at this
time unless print quality is no longer
acceptable. After an HP supply has reached
the very low threshold, the HP premium
protection warranty for that supply has
ended.

If print quality is no longer acceptable,
replace the print cartridge.
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8 Print tasks

● Cancel a print job with Windows

● Basic print tasks with Windows

● Additional print tasks with Windows

● Walk-up USB printing
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Cancel a print job with Windows
NOTE: If the print job is too far into the printing process, you might not have the option to cancel it.

1. If the print job is currently printing, cancel it by following this procedure:

a. Press the Stop  button on the control panel.

b. From the list on the touchscreen, touch the print job you want to delete, and touch the Cancel
Job button.

c. The product prompts you to confirm the deletion. Touch the Yes button.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen,
allowing you to cancel the print job.

● Windows print queue: If a print job is waiting in a print queue (computer memory) or
print spooler, delete the job there.

◦ Windows XP, Server 2003, or Server 2008: Click Start, click Settings, and
then click Printers and Faxes. Double-click the product icon to open the window,
right-click the print job that you want to cancel, and then click Cancel.

◦ Windows Vista: Click Start, click Control Panel, and then, under Hardware
and Sound, click Printer. Double-click the product icon to open the window, right-
click the print job that you want to cancel, and then click Cancel.

◦ Windows 7: Click Start, and then click Devices and Printers. Double-click the
product icon to open the window, right-click the print job that you want to cancel, and
then click Cancel.
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Basic print tasks with Windows
The methods to open the print dialog from software programs can vary. The procedures that follow
include a typical method. Some software programs do not have a File menu. See the documentation
for your software program to learn how to open the print dialog.

Open the printer driver with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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Get help for any printing option with Windows

1. Click the Help button to open the online Help.  

Change the number of print copies with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then select the number of copies.
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Save custom print settings for reuse with Windows

Use a printing shortcut with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Printing Shortcuts tab.  

4. Select one of the shortcuts, and then click the
OK button.

NOTE: When you select a shortcut, the
corresponding settings change on the other
tabs in the printer driver.

 

Create printing shortcuts

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Printing Shortcuts tab.  

4. Select an existing shortcut as a base.

NOTE: Always select a shortcut before
adjusting any of the settings on the right side
of the screen. If you adjust the settings and
then select a shortcut, all your adjustments are
lost.
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5. Select the print options for the new shortcut.  

6. Click the Save As button.  

7. Type a name for the shortcut, and click the OK
button.
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Improve print quality with Windows

Select the page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

Select a custom page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Custom button.

5. Type a name for the custom size, specify the dimensions, and click the OK button.

Select the paper type with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand the category of paper types that best describes your paper, and then click the paper type
that you are using.

Select the paper tray with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a tray from the Paper source drop-down list.

Select the gloss level with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.
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3. Click the Paper/Quality tab.

4. In the Print Quality area, select the gloss level from the first drop-down list.

Print on both sides (duplex) with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Finishing tab.  

4. Select the Print on both sides check box.
Click the OK button to print the job.

 

Print multiple pages per sheet with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the number of pages per sheet from the
Pages per sheet drop-down list.

 

5. Select the correct Print page borders,
Page order, and Orientation options.

 

Select page orientation with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

4. In the Orientation area, select the Portrait
or Landscape option.

To print the page image upside down, select
the Rotate by 180 degrees option.
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Set color options with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Color tab.  
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4. Click the HP EasyColor check box to clear it.  

5. In the Color Options area, click the
Manual option, and then click the Settings
button.

 

6. Adjust the general settings for Edge Control,
and settings for text, graphics, and
photographs.
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Additional print tasks with Windows

Print colored text as black (grayscale) with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Advanced tab.

4. Expand the Document Options section.

5. Expand the Printer Features section.

6. In the Print All Text as Black drop-down list, select the Enabled option.

Print on preprinted letterhead or forms with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Paper/Quality tab.  

4. From the Paper type drop-down list, click the
More... option.

 

5. Expand the list of Type is: options.  
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6. Expand the list of Other options.  

7. Select the option for the type of paper you are
using, and click the OK button.

 

Print on special paper, labels, or transparencies

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  

4. From the Paper type drop-down list, click the
More... option.
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5. Expand the list of Type is: options.  

6. Expand the category of paper types that best
describes your paper.

NOTE: Labels and transparencies are in the
list of Other options.

 

7. Select the option for the type of paper you are
using, and click the OK button.
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Print the first or last page on different paper with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  
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4. In the Special pages area, click the Print
pages on different paper option, and
then click the Settings button.

 

5. In the Pages in document area, select
either the First or Last option.

 

6. Select the correct options from the Paper
source and Paper type drop-down lists.
Click the Add button.
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7. If you are printing both the first and last pages
on different paper, repeat steps 5 and 6,
selecting the options for the other page.

 

8. Click the OK button.  

Scale a document to fit page size with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Effects tab.  

4. Select the Print document on option, and
then select a size from the drop-down list.
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Add a watermark to a document with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select a watermark from the Watermarks drop-down list.

Or, to add a new watermark to the list, click the Edit button. Specify the settings for the
watermark, and then click the OK button.

5. To print the watermark on the first page only, select the First page only check box. Otherwise,
the watermark is printed on each page.

Create a booklet with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Finishing tab.  

4. Select the Print on both sides check box.  

5. In the Booklet layout drop-down list, click
the Left binding or Right binding option.
The Pages per sheet option automatically
changes to 2 pages per sheet.
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Select output options with Windows (fskm models only)

Select an output bin with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Output tab.  

4. In the Output Bin Options area, select a
bin from the Bin drop-down list.

 

Select staple options with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Output tab.  

4. In the Output Options area, select an
option from the Staple drop-down list.
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Use job storage features with Windows

The following job-storage modes are available for print jobs:

● Proof and Hold: This feature provides a quick way to print and proof one copy of a job and
then print more copies.

● Personal Job: When you send a job to the product, the job does not print until you request it at
the product control panel. If you assign a personal identification number (PIN) to the job, you must
provide the required PIN at the control panel.

● Quick Copy: If the optional hard disk is installed on the product, you can print the requested
number of copies of a job and then store a copy of the job on the optional hard disk. Storing the
job allows you to print additional copies of the job later.

● Stored Job: If the optional hard disk is installed on the product, you can store a job such as a
personnel form, time sheet, or calendar on the product and allow other users to print the job at
any time. Stored jobs also can be protected by a PIN.

CAUTION: If you turn off the product, all Quick Copy, Proof and Hold, and Personal Job
types of stored jobs are deleted. To permanently store the job and prevent the product from deleting it
when space is needed for something else, select the Stored Job option in the driver.

Create a stored job with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Job Storage tab.  

4. Select a Job Storage Mode option.  

Print a stored job

Use the following procedure to print a job that is stored in the product memory.

1. From the Home screen, touch the Open from
Device Memory button.

 

158 Chapter 8   Print tasks ENWW



2. Select the name of the folder where the job is
stored.

 

3. Select the name of the job, adjust the number
of copies, and then touch the Start  button to
print the job.

 

4. If the job is locked, type the PIN in the PIN
field, adjust the number of copies, and then
touch the Start  button to print the job.

 

Delete a stored job

When you send a stored job to the product memory, the product overwrites any previous jobs with the
same user and job name. If a job is not already stored under the same user and job name, and the
product needs additional space, the product might delete other stored jobs starting with the oldest. You
can change the number of jobs that can be stored from the General Settings menu on the product
control panel.

Use this procedure to delete a job that is stored in the product memory.

1. From the Home screen, touch the Open from Device Memory button.

2. Select the name of the folder where the job is stored.

3. Select the name of the job, and then touch the Delete button.

4. If the job is locked, type the PIN in the PIN field, and then touch the Delete button.

Set job storage options with Windows

Print one copy for proof before printing all the copies

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.
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3. Click the Job Storage tab.

4. In the Job Storage Mode area, click the Proof and Hold option.

Temporarily store a personal job on the product and print it later

NOTE: The product deletes the job after you print it.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. In the Job Storage Mode area, click the Personal Job option.

5. Optional: In the Make Job Private area, click the PIN to print option, and enter a 4-digit
personal identification number (PIN).

6. Print the job at any time from the product control panel.

Temporarily store a job on the product

NOTE: This option is available if the optional hard disk is installed in the product.

NOTE: The product stores the job until you turn the product off.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. In the Job Storage Mode area, click the Quick Copy option.

The requested number of copies are printed immediately, and you can print more copies from the
product control panel.

Permanently store a job on the product

NOTE: This option is available if the optional hard disk is installed in the product.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. In the Job Storage Mode area, click the Stored Job option.
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Make a permanently stored job private so that anyone who tries to print it must provide a
PIN

NOTE: This option is available if the optional hard disk is installed in the product.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. In the Job Storage Mode area, click the Stored Job option or the Personal Job option.

5. In the Make Job Private area, click the PIN to print option, and enter a 4-digit personal
identification number (PIN).

NOTE: To print the job or to delete it, you must provide the PIN at the product control panel.

Receive notification when someone prints a stored job

NOTE: Only the person who created the stored job receives notification. You do not receive
notification when someone prints a stored job that another person has created.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. Select the job storage mode that you want.

5. In the Job Notifications Options area, click the Display Job ID when printing option.

Set the user name for a stored job

Follow this procedure to change the user name for a stored job.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. Select the job storage mode that you want.

5. In the User Name area, click the User name option to use the Windows default user name. To
provide a different user name, click the Custom option and type the name.

Specify a name for the stored job

Follow this procedure to change the default name for a stored job.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.
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3. Click the Job Storage tab.

4. Select the job storage mode that you want.

5. To automatically generate the job name associated with the stored document, in the Job Name
area, click the Automatic option. The driver uses the document file name, if it is available. If the
document has no file name, the driver uses the software program name or a time stamp for the job
name.

To specify a job name, click the Custom option and type the name.

6. Select an option from the If job name exists drop-down list.

● Select the Use Job Name + (1-99) option to add a number to the end of the existing
name.

● Select the Replace Existing File option to overwrite a job that already has that name.

Print special jobs with Windows

Print business graphics or marketing material

You can use this product to print marketing and sales material or other color documents on glossy
paper. To maximize the quality of this output you must do the following:

1. Choose the appropriate paper. See the following table.

2. At the product control panel, configure the paper tray for the correct paper type.

3. Select the corresponding settings in the printer driver.

Supported glossy paper

HP glossy paper product Product code Product size Control panel and print
driver settings

HP Laser Presentation Paper,
Soft Gloss

Q6541A Letter HP soft gloss 120g

HP Laser Presentation Paper,
Glossy

Q2546A Letter HP glossy 130g

HP Laser Presentation Paper,
Glossy

Q2552A A4 HP glossy 130g

HP Laser Professional Paper,
Soft Gloss

Q6542A A4 HP soft gloss 120g

HP Laser Brochure Paper,
Glossy

Q6611A, Q6610A Letter HP glossy 160g

HP Laser Superior Paper,
Glossy

Q6616A A4 HP glossy 160g

HP Laser Photo Paper, Glossy Q6607A, Q6608A Letter HP glossy 220g

HP Laser Photo Paper, Glossy Q6614A A4 HP glossy 220g

162 Chapter 8   Print tasks ENWW



HP glossy paper product Product code Product size Control panel and print
driver settings

HP Laser Photo Paper, Glossy
4x6

Q8842A 101.6 x 152.4 mm (4 x 6 in) HP glossy 220g

HP Laser Photo Paper, Glossy
10 cm x 15 cm

Q8843A 101.6 x 152.4 mm (4 x 6 in) HP glossy 220g

NOTE: In the United States, see www.hp.com/go/paper for a complete list of HP brand paper.

Print weatherproof maps and outdoor signs

The product can print durable, waterproof maps, signs, or menus by using HP Tough Paper. HP Tough
Paper is a waterproof, tear-proof, satin finish paper that retains rich, vibrant print color and clarity even
when exposed to heavy usage or weather. This avoids expensive and time-consuming lamination. To
maximize the quality of this output you must do the following:

● Choose the appropriate paper. See the following table.

● At the product control panel, configure the paper tray for the correct paper type.

● Select the corresponding settings in the printer driver.

Supported tough paper

HP paper name Product code Product size Control panel and print
driver settings

HP LaserJet Tough Paper Q1298A Letter HP Tough Paper

HP LaserJet Tough Paper Q1298B A4 HP Tough Paper

Set the duplex alignment

For documents that are printed on both sides, such as brochures, set the registration for the tray before
printing to ensure that the front and back of the page are aligned.

1. From the Home screen, touch the Administration button.

2. Open the following menus:

a. General Settings

b. Print Quality

c. Image Registration

d. Adjust Tray <X>

3. Touch the Print Test Page setting, and then touch the OK button.

4. Follow the instructions on the test page to complete the adjustment.
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Walk-up USB printing
This product features walk-up USB printing, so you can quickly print files without sending them from a
computer. The product accepts standard USB storage accessories in the USB port on the front of the
product. You can print the following types of files:

● .pdf

● .prn

● .pcl

● .ps

● .cht

1. Insert the USB storage accessory into the USB
port on the front of the product.

NOTE: You might need to remove the cover
from the USB port

 

2. The Open from USB screen opens. Select a
folder from the list on the left side of the
screen.

 

3. Select the name of the document that you want
to print.
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4. If you need to adjust the number of copies,
touch the Copies field, and then use the
keypad to select the number of copies.

 

5. Touch the Start  button to print the document.  
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9 Color

● Adjust color

● Match colors
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Adjust color
Manage color by changing the settings on the Color tab in the printer driver.

Change the color theme for a print job

1. On the File menu in the software program,
click Print.

 

2. Click Properties or Preferences.  

3. Click the Color tab.  

4. Select a color theme from the Color Themes
drop-down list.

● Default (sRGB): This theme sets the
product to print RGB data in raw device
mode. When using this theme, manage
color in the software program or in the
operating system for correct rendering.

● Vivid: The product increases the color
saturation in the midtones. Use this theme
when printing business graphics.

● Photo: The product interprets RGB color
as if it were printed as a photograph using
a digital mini lab. The product renders
deeper, more saturated colors differently
than with the Default (sRBG) theme. Use
this theme when printing photos.

● Photo (Adobe RGB 1998): Use this
theme with printing digital photos that use
the AdobeRGB color space rather than
sRGB. Turn off color management in the
software program when using this theme.

● None: No color theme is used.
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Change the color options

Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independent from other
settings.

NOTE: Changing color settings manually can impact output. HP recommends that only
color graphics experts change these settings.

5. Click the Print in Grayscale option to print a color document in black and shades of gray. Use
this option to print color documents for photocopying or faxing. You can also use this option to
print draft copies or to save color toner.

6. Click the OK button.
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Manual color options

Use manual color options to adjust the Neutral Grays, Halftone, and Edge Control options for
text, graphics, and photographs.

Table 9-1  Manual color options

Setting description Setting options

Edge Control

The Edge Control setting determines the rendering
of edges. Edge control has two components:
adaptive halftoning and trapping. Adaptive
halftoning increases edge sharpness. Trapping
reduces the effect of color-plane misregistration by
overlapping the edges of adjacent objects slightly.

● Off turns off both trapping and adaptive halftoning.

● Light sets trapping at a minimal level. Adaptive halftoning is on.

● Normal sets trapping at a medium level. Adaptive halftoning is
on.

● Maximum is the most aggressive trapping setting. Adaptive
halftoning is on.

Halftone

Halftone options affect color output clarity and
resolution.

● Smooth provides better results for large, solid-filled print areas
and enhances photographs by smoothing color gradations. Select
this option when uniform and smooth area fills are important.

● Detail is useful for text and graphics that require sharp
distinctions among lines or colors, or images that contain a
pattern or a high level of detail. Select this option when sharp
edges and small details are important.

Neutral Grays

The Neutral Grays setting determines the method
for creating gray colors used in text, graphics, and
photographs.

● Black Only generates neutral colors (grays and black) by using
only black toner. This guarantees neutral colors without a color
cast. This setting is best for documents and grayscale viewgraphs.

● 4-Color generates neutral colors (grays and black) by combining
all four toner colors. This method produces smoother gradients
and transitions to other colors, and it produces the darkest black.
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Use the HP EasyColor option

If you are using the HP PCL 6 printer driver for Windows, the HP EasyColor technology automatically
improves mixed-content documents that are printed from Microsoft Office programs. This technology
scans documents and automatically adjusts photographic images in .JPEG or .PNG format.
HP EasyColor technology enhances the entire image at one time, rather than dividing it into several
pieces, which results in improved color consistency, sharper details, and faster printing.

If you are using the HP Postscript printer driver for Mac, HP EasyColor technology scans all
documents and automatically adjusts all photographic images with the same improved photographic
results.

In the following example, the images on the left were created without using the HP EasyColor option.
The images on the right show the enhancements that result from using the HP EasyColor option.

The HP EasyColor option is enabled by default in both the HP PCL 6 printer driver and the HP Mac
Postscript printer driver, so you do not need to make manual color adjustments. To disable the option so
you can manually adjust the color settings, open the Color tab in the Windows driver or the Color/
Quality Options tab in the Mac driver, and then click the HP EasyColor check box to clear it.
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Match colors
The process of matching product output color to your computer screen is quite complex because printers
and computer monitors use different methods of producing color. Monitors display colors by light pixels
using an RGB (red, green, blue) color process, but printers print colors using a CMYK (cyan, magenta,
yellow, and black) process.

Several factors can influence your ability to match printed colors to those on your monitor. These factors
include:

● Paper

● Printer colorants (inks or toners for example)

● Printing process (inkjet, press, or laser technology for example)

● Overhead lighting

● Personal differences in perception of color

● Software programs

● Printer drivers

● Computer operating system

● Monitors and monitor settings

● Video cards and drivers

● Operating environment (humidity for example)

Keep the above factors in mind when colors on your screen do not perfectly match your printed colors.

For most users, the best method for matching colors on your screen to your product is to print sRGB
colors.

Sample book color matching

The process for matching product output to preprinted sample books and standard color references is
complex. In general, you can obtain a reasonably good match to a sample book if the inks used to
create the sample book are cyan, magenta, yellow, and black. These are usually referred to as process
color sample books.

Some sample books are created from spot colors. Spot colors are specially created colorants. Many of
these spot colors are outside of the range of the product. Most spot color sample books have
companion process sample books that provide CMYK approximations to the spot color.

Most process sample books will state which process standards were used to print the sample book. In
most cases they will be SWOP, EURO, or DIC. To get optimal color matching to the process sample
book, select the corresponding ink emulation from the product menu. If you cannot identify the process
standard, use SWOP ink emulation.

172 Chapter 9   Color ENWW



Print color samples

To use the color samples, select the color sample that is the closest match to the desired color. Use the
sample’s color value in your software program to describe the object you wish to match. Colors may
vary depending on paper type and the software program used. For more details on how to use the
color samples, go to www.hp.com/support/cljcm4540mfp.

Use the following procedure to print color samples at the product using the control panel:

1. From the Home screen, open the following menus:

a. Administration

b. Reports

c. Other Pages

2. Select either the Color Samples for RGB or the CMYK Values option, and touch the OK button.

PANTONE® color matching

PANTONE has multiple color matching systems. PANTONE MATCHING SYSTEM® is very popular
and uses solid inks to generate a wide range of color hues and tints. See www.hp.com/go/
cljcm4540mfp_software for details on how to use PANTONE Colors with this product.

NOTE: PANTONE Colors generated might not match PANTONE-identified standards. Consult current
PANTONE Publications for accurate color.
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10 Copy

● Use copy functions

● Copy settings

● Copy a book

● Copy a photo

● Create a stored copy job

● Copy mixed-size originals

● Copy on both sides (duplex)

● Use Job Build mode
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Use copy functions

Copy

Use the scanner glass to make as many as 9999 copies of small, lightweight paper (less than 60 g/m2

or 16 lb) or heavy paper (more than 105 g/m2 or 28 lb). This includes paper such as receipts,
newspaper clippings, photographs, old documents, worn documents, and books.

Use the document feeder to make as many as 9999 copies of a document that has up to 50 pages
(depending on the thickness of the pages).

1. To copy from the scanner glass, place the original document face-down on the glass. Align the
corner of the original with the upper-left corner of the glass.

2. To copy from the document feeder, place the document into the document feeder with the pages
facing up.

3. To make copies by using the default copy options, use the keypad on the control panel to select
the number of copies, and touch the Start  button.

Cancel a copy job

1. Press the Stop  button on the control panel and then touch the name of the job.

2. Touch the Cancel Job button, and then touch the OK button.
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Reduce or enlarge a copy image

1. From the Home screen, touch the Copy button.  

2. Touch the Reduce/Enlarge button.  

3. Select one of the predefined percentages, or
touch the Scaling field and type a percentage
between 25 and 400. Touch the OK button.
You can also select these options:

● Auto: The product automatically scales the
image to fit the paper size in the tray.

● Auto Include Margins: The product
reduces the image slightly to fit the entire
scanned image within the printable area
on the page.

NOTE: To reduce the image, select a scaling
percentage that is less than 100. To enlarge
the image, select a scaling percentage that is
greater than 100.

 

4. Touch the Start  button.  
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Collate a copy job

1. From the Home screen, touch the Copy button.  

2. Touch the Collate button or the Staple/Collate
button.

 

3. Touch the Collate on (Sets in page order)
option.

 

4. Touch the Start  button.  

Make color copies or black and white copies

1. From the Home screen, touch the Copy button.

2. Touch the Color/Black button.

3. Select the color option that you want to use, and then touch the OK button.
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Copy settings

Change copy quality

Optimize the copy image for text or pictures

1. From the Home screen, touch the Copy button.  

2. Touch the More Options button, and then
touch the Optimize Text/Picture button.

 

3. Select one of the predefined options, or touch
the Manually adjust button and then adjust the
slider in the Optimize For area. Touch the OK
button.

 

4. Touch the Start  button.  

Check the scanner glass for dirt or smudges

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can
affect performance. Use the following procedure to clean the scanner glass and white plastic backing.
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1. Use the power switch to turn off the product,
and then unplug the power cord from the
electrical socket.

 

2. Open the scanner lid.  
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3. Clean the scanner glass and the white plastic
backing with a soft cloth or sponge that has
been moistened with nonabrasive glass
cleaner. Dry the glass and white plastic
backing with a chamois or a cellulose sponge
to prevent spotting.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

 

4. Plug in the product, and then use the power
switch to turn on the product.

 

Adjust the copy lightness/darkness

1. From the Home screen, touch the Copy button.  

2. Touch the Image Adjustment button.  
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3. Adjust the sliders to set the Darkness level, the
Contrast, the Sharpness level, and the
Background Cleanup level. Touch the OK
button.

 

4. Touch the Start  button.  
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Define custom copy settings

You can use the Administration menu to establish default settings that apply to all copy jobs. If
necessary, you can override most settings for an individual job. After that job is complete, the product
returns to the default settings.

1. From the Home screen, scroll to and touch the Administration menu.

2. Open the Copy Settings menu.

3. Several options are available. You can configure defaults for all options, or for only some options.

NOTE: To learn about each menu option, touch the Help button  in the upper-right corner of
the screen for that option.

Set the paper size and type for copying on special paper

1. From the Home screen, touch the Copy button.  

2. Touch the Paper Selection button.  

3. Select the tray that holds the paper that you
want to use, and then touch the OK button.
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Restore copy default settings

1. From the Home screen, open the following menus:

● Administration

● General Settings

● Restore Factory Settings

2. Select the Copy check box, and then touch the Reset button.
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Copy a book
1. Lift the lid and place the book on the scanner glass with the spine aligned with the mark on the

rear, center of the scanner glass.

2. Gently close the lid.

3. On the control panel, touch the Copy button.

4. Touch the Start  button.

5. Repeat these steps for each page that you want to copy.

NOTE: This product does not have the capability to distinguish left and right pages. Assemble the
copied pages carefully.
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Copy a photo
NOTE: Copy photos from the scanner glass.

1. Lift the lid and place the photo on the scanner glass with the picture-side down and the upper-left
corner of the photo in the upper-left corner of the glass.

2. Gently close the lid.

3. On the control panel, touch the Copy button.

4. Touch the Optimize Text/Picture button, and select the Photograph button.

5. Touch the Start  button.
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Create a stored copy job
Use this procedure to scan a document and save it on the product so you can print copies at any time.

1. Place the document face-down on the scanner glass or face-up in the document feeder.

2. From the Home screen, touch the Save to Device Memory button.

NOTE: If prompted, type your user name and password.

3. Select an existing folder, or touch the New Folder button to create a new folder.

4. Type the name for the file in the File Name text field, and select the file type from the File Type
drop-down list.

5. To configure settings for the document, touch the More Options button.

6. Touch the Start  button to save the file.
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Copy mixed-size originals
You can copy original documents that are printed on different sizes of paper as long as the sheets of
paper have one common dimension. For example, you could combine Letter and Legal sizes.

1. Arrange the sheets in the original document so they all have the same width.

2. Place the sheets face-up into the document feeder, and adjust both paper guides against the
document.

3. On the control panel, touch the Copy button.

4. Touch the Original Size button.

NOTE: If this option is not on the first screen, touch the More Options button until the option
displays.

5. Select the Mixed Letter/Legal button, and then touch the OK button.

6. Touch the Start  button.
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Copy on both sides (duplex)

1. Load the original documents into the document
feeder with the first page facing up, and with
the top of the page leading.

 

2. On the control panel, touch the Copy button.  

3. Touch the Sides button.  

4. To make a two-sided copy from a one-sided
original, touch the 1-sided original, 2-sided
output button.

To make a two-sided copy from a two-sided
original, touch the 2-sided original, 2-sided
output button.

To make a one-sided copy from a two-sided
original, touch the 2-sided original, 1-sided
output button.

Touch the OK button.

 

5. Touch the Start  button.  
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Use Job Build mode
Use the Job Build feature to combine several sets of original documents into one copy job. Also use this
feature to copy an original document that has more pages than the document feeder can accommodate
at one time.

1. Load the original document face-up in the document feeder or face-down on the scanner glass.

2. On the control panel, touch the Copy button.

3. Scroll to and touch the Job Build button.

4. Touch the Job Build on button.

5. Touch the OK button.

6. If necessary, select the desired copy options.

7. Touch the Start  button. After each page is scanned, the control panel prompts you for more
pages.

8. If the job contains more pages, load the next page, and then touch the Scan button.

The product temporarily saves all the scanned images. Touch the Finish button to finish printing the
copies.
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11 Scan and send documents

● Set up scan/send features

● Use scan/send functions

● Send a scanned document
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Set up scan/send features
The product offers the following scan and send features:

● Scan and save files to a folder on your network.

● Scan and save files to the product hard drive.

● Scan and save files to a USB flash drive.

● Scan and send documents to one or more e-mail addresses.

Some scan and send features are not available on the product control panel until you use the
HP Embedded Web Server to enable them.

NOTE: To find detailed information about using the HP Embedded Web Server, click the Help link in
the upper-right corner of each HP Embedded Web Server page.

1. Open a Web page, and type the product IP address in the address line.

2. When the HP Embedded Web Server opens, click the Scan/Digital Send tab.

3. If you did not previously use the HP Scan to Email Setup Wizard to set up the E-mail feature, you
can enable it by using the HP Embedded Web Server.

a. Click the E-mail Setup link.

b. Select the E-mail check box to enable the feature.

c. Select the outgoing mail server to use, or click the Add button to add a different server to the
list.

NOTE: If you don't know the name of the mail server, you can usually find it by opening
your e-mail program and looking at the outgoing mail configuration settings.

d. In the Address and Message Field Control area, configure the default setting for the
From address.

e. Configuring the other settings is optional.

f. When you are finished, click the Save Settings button.

4. Enable the Save to Network Folder feature.

a. Click the Save to Network Folder Setup link.

b. Select the Save to Network Folder check box to enable the feature.

c. In the Quick Sets area, click the Add button.

d. On the next screen, provide a name and a description for the Quick Set and specify the
location where you want the Quick Set to appear on the control panel. Click the Next
button.

e. On the next screen, select the type of Quick Set folder to use, and then click the Next
button.
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f. Continue through the screens and select the default options you want to apply to the Quick
Set.

g. On the Summary screen, review the settings and then click the Finish button.

5. Enable the Save to USB feature.

a. Click the Save to USB Setup link.

b. Select the Enable Save to USB check box.

c. Click the Apply button at the bottom of the page.
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Use scan/send functions

Sign in

Some features on the product control panel can be secured so that unauthorized people cannot use
them. When a feature is secured, the product prompts you to sign in before you can use it. You can
also sign in without waiting for a prompt by touching the Sign In button on the Home screen.

Typically, you use the same user name and password that you use to sign in to your computer on the
network. Consult the network administrator for this product if you have questions about which
credentials to use.

After you have signed in to the product a Sign Out button appears on the control panel. To maintain
security for the product, touch the Sign Out button when you have finished using the product.

Change default scan/send settings from the product control panel

1. From the Home screen, scroll to and touch the
Administration button.

 

2. Open the Scan/Digital Send Settings menu.  

3. Select the category of scan and send settings
that you want to configure.

 

4. Open the Default Job Options menu, and
configure the options. Touch the OK button to
save the settings.
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Send a scanned document

Send a scanned document to a network folder

The product can scan a file and save it in a folder on the network. The following operating systems
support this feature:

● Windows Server 2003, 64-bit

● Windows Server 2008, 64-bit

● Windows XP, 64-bit

● Windows Vista, 64-bit

● Windows 7, 64-bit

● Novell v5.1 and later (access to the Quick Sets folders only)

NOTE: You might be required to sign in to the product to use this feature.

The system administrator can use the HP Embedded Web Server to configure pre-defined Quick Sets
folders, or you can provide the path to another network folder.

1. Place the document face-down on the scanner
glass or face-up in the document feeder.

 

2. From the Home screen, touch the Save to
Network Folder button.

NOTE: If prompted, type your user name
and password.

 

3. To use one of the preset job settingss, select
one of the items in the Quick Sets list.
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4. To set up a new job, type the name for the file
in the File Name text field, and type the path
to the network folder in the Network Folder
Path field. Use this format for the path:

\\path\path

 

5. To configure settings for the document, touch
the More Options button.

 

6. Touch the Start  button to save the file.  

Send a scanned document to a folder in the product memory

Use this procedure to scan a document and save it on the product so you can print copies at any time.

1. Place the document face-down on the scanner
glass or face-up in the document feeder.

 

2. From the Home screen, touch the Save to
Device Memory button.

NOTE: If prompted, type your user name
and password.
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3. Select an existing folder, or touch the New
Folder button to create a new folder.

 

4. Type the name for the file in the File Name text
field.

 

5. To configure settings for the document, touch
the More Options button.

 

6. Touch the Start  button to save the file.  

Send a scanned document to a USB flash drive

The product can scan a file and save it in a folder on a USB flash drive.

NOTE: You might be required to sign in to the product to use this feature.

1. Place the document face-down on the scanner
glass or face-up in the document feeder.
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2. From the Home screen, touch the Save to USB
button.

NOTE: If prompted, type your user name
and password.

 

3. Select one of the folders in the list, or touch the
New Folder button to create a new folder on
the USB flash drive.

 

4. Type the name for the file in the File Name text
field, and select the file type from the File Type
drop-down list.

 

5. To configure settings for the document, touch
the More Options button.

 

6. Touch the Start  button to save the file.  

Send to e-mail

The product e-mail feature offers the following benefits:

● Sends documents to one or more e-mail addresses.

● Delivers files in black-and-white or in color.

● You can send files in different file formats that the recipient can manipulate.
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In order to use the e-mail feature, the product needs to be connected to a valid SMTP local area
network that includes Internet access.

Supported protocols

The product supports Simple Mail Transfer Protocol (SMTP) and Lightweight Directory Access Protocol
(LDAP).

SMTP

● SMTP is a set of rules that define the interaction between programs that send and receive e-mail.
In order for the product to send documents to e-mail, it must be connected to a LAN that has
access to an e-mail server that supports SMTP.

● If you are using a LAN connection, contact your system administrator to obtain the IP address or
host name for your SMTP server. If you are connecting through a DSL or cable connection, contact
the internet service provider to obtain the SMTP server IP address.

LDAP

● LDAP is used to gain access to a database of information. When the product uses LDAP, it
searches a global list of e-mail addresses. As you begin to type the e-mail address, LDAP uses an
auto-complete feature that supplies a list of e-mail addresses that match the characters you type.
As you type additional characters, the list of matching e-mail addresses becomes smaller.

● The product supports LDAP, but a connection to an LDAP server is not required in order for the
product to be able to send to e-mail.

NOTE: If you need to change the LDAP settings, you must change them by using the
HP Embedded Web Server.

Configure e-mail server settings

Before you can send a document to e-mail, you must configure the product.

NOTE: The instructions that follow are for configuring the product at the control panel. You can also
perform these procedures by using the HP Embedded Web Server. Using the E-mail Setup Wizard
menu is the simplest way to configure the e-mail settings.

NOTE: The e-mail icon is not shown on the control panel if e-mail is not configured.

1. From the Home screen, scroll to and touch the
Administration menu.
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2. Open the Scan/Digital Send Settings menu.  

3. Open the E-mail Settings menu.  

4. Open the E-mail Setup Wizard menu, and
follow the on-screen instructions.

 

Send a scanned document to one or more e-mail addresses

1. Place the document face-down on the scanner
glass or face-up in the document feeder.

 

2. From the Home screen, touch the E-mail button.

NOTE: If prompted, type your user name
and password.
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3. Touch the text box next a field to open a
keypad.

NOTE: If you are signed in to the product,
your user name or other default information
might appear in the From field. If so, you might
not be able to change it.

 

4. Type the appropriate information for the field.
To send to multiple addresses, separate the
addresses with a semicolon, or touch the Enter
button on the touchscreen keypad after you
type each address.

 

5. To change the settings for the document touch
the More Options button.

 

6. If you are sending a two-sided document,
select the Original Sides menu and select the
2-sided option.

 

7. Touch the Start  button to begin sending.  

ENWW Send a scanned document 201



Use the address book

You can send e-mail to a list of recipients by using the address book. Depending on how the product is
configured, you might have one or more of the following address book viewing options.

● All Contacts: Lists all the contacts that are available to you.

● Personal Contacts: Lists all the contacts that are associated with your user name. These contacts
are not visible to other people who use the product.

NOTE: You must be signed in to the product to see the Personal Contacts list.

● Local Contacts: Lists all the contacts that are stored in the product memory. These contacts are
visible to all people who use the product.

Add contacts to the address book from the product control panel

If you are signed in to the product, contacts that you add to the address book will not be visible to other
people who use the product.

If you are not signed in to the product, contacts that you add to the address book will be visible to all
people who use the product.

NOTE: You can also use the HP Embedded Web Server (EWS) to create and manage the address
book.

1. From the Home screen, touch the E-mail button.

NOTE: If prompted, type your user name
and password.

 

2. Touch the address book  button that is next
to the To field to open the Address Book
screen.

 

3. Touch the Add contact button  that is in the
lower left corner of the screen.
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4. In the Name text field, type the name of the
contact.

 

5. From the drop-down list, select the E-mail
Address option, and then type the contact's e-
mail address.

Touch the OK button to add the contact to the
list.

 

Send a document to e-mail by using the address book

1. Place the document face-down on the scanner
glass or face-up in the document feeder.

 

2. From the Home screen, touch the E-mail button.

NOTE: If prompted, type your user name
and password.

 

3. Touch the address book  button that is next
to the To field to open the Address Book
screen.
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4. From the drop-down list, select the address
book view that you want to use.

 

5. Select a name from the list of contacts, and
then touch the right arrow  button to add the
name to the recipients list.

Repeat this step for each recipient, and then
touch the OK button.

 

6. Touch the Start  button to begin sending.  
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12 Fax

● Setup

● Set fax settings

● Use Fax

● Solve fax problems
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Setup

Introduction

The HP LaserJet Analog Fax Accessory 500 enables the HP multifunction product (MFP) to function as a
standalone analog fax machine. For more information, see www.hp.com/go/
ljanalogfaxaccessory500_manuals.

NOTE: In addition to the analog fax feature, the product also supports LAN and internet faxing. Only
one fax method can be enabled at a time.

NOTE: If the product came with the fax accessory installed, remove the fax connection cover, connect
the phone cord, and then perform the initial fax configuration. The fax connection cover is located on
the phone connector on the formatter rear panel.

HP LaserJet Analog Fax Accessory 500 features

Send-fax features ● Speed dials

● Fax address book

● Resolution and image-adjustment options

● Billing codes
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Receive-fax features ● Stamp received faxes

● Block incoming faxes

● Fax polling

● Adjustable rings-to-answer

Advanced fax features ● Notification of fax status

● JBIG compression

● Error correction

● Fax archive

Remote fax configuration ● Embedded Web server

● HP Web Jetadmin

● HP MFP Digital Sending Software

Security features ● Fax-printing schedule

Verify fax operation

When the fax accessory is installed and operating correctly, the fax icon displays on the product
control panel. If the fax accessory has just been installed but has not been configured, the fax icon is
grayed-out. If this occurs, use the instructions that follow to configure the fax accessory.

Required fax settings

After the fax accessory is installed, you must configure certain settings before you can use the
accessory. If these settings are not configured, the fax icon is grayed-out. These settings include:

● Country/region

● Date/Time

● Company Name

● Fax Number

● Dialing Prefix (optional)

This information is used in the fax header, which is printed on all outgoing faxes.

NOTE: When first installed, the fax accessory might read some of these settings from the product;
therefore, a value may already be set. You should check the values to verify that they are set and
correct.

NOTE: In the U.S. and many other countries/regions, setting the date, time, country/region, phone
number, and company name is a legal requirement for fax.
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Fax Setup Wizard

The Fax Setup Wizard guides you through a step-by-step procedure to configure fax settings that are
required to use the fax feature. If the settings are not configured, the fax feature is disabled.

The first time the product is turned on with a fax accessory installed, access the Fax Setup Wizard by
following these steps:

1. From the Home screen, touch the Initial Setup button.

2. Touch the Fax Setup Wizard menu.

3. Follow the steps in the Fax Setup Wizard to configure the required settings.

4. When the Fax Setup Wizard finishes, the option to hide the Initial Setup button appears on the
Home screen.

Access the Fax Setup Wizard after initial setup through the control panel by following these steps:

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● Fax Setup Wizard

Follow these steps to configure the required fax settings using the Fax Setup Wizard:

1. Touch your country/region on the first screen of the Fax Setup Wizard and then touch the Next
button.

2. Touch the date and time boxes to enter the date/time, and then touch the Next button.

3. Touch the Company Name and Fax Number boxes to enter your company name and fax number,
and then touch the Next button.

4. Touch the Dialing Prefix box to enter your dialing prefix, if required, and then touch the Next
button.

5. Confirm your fax configuration settings on the final screen of the Fax Setup Wizard. Touch the
Finish button to complete the Fax Setup Wizard.

-or-

Touch the Back button to move back through the Fax Setup Wizard screens and make changes to
your configuration entries.

NOTE: The settings configured using the Fax Setup Wizard on the control panel override any settings
made in the embedded Web server.
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NOTE: If the Fax Setup menu settings does not appear in the menu listing, LAN or internet fax might
be enabled. When LAN or internet fax is enabled, the analog fax accessory is disabled and the fax
menu does not display. Only one fax feature, either LAN fax, analog fax or internet fax, can be
enabled at a time. The fax icon displays for either fax feature. If you wish to use analog fax when LAN
fax is enabled, use the HP MFP Digital Sending Software Configuration Utility or the product embedded
Web server to disable LAN fax.

Set or verify the date and time

The date and time setting for the fax accessory is the same value as the product date and time setting.
This information can be entered using the Fax Setup Wizard, or by following these steps:

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● General Settings

● Date/Time Settings

● Date/Time

3. Touch the correct Time Zone setting for your locale.

4. Touch the Month drop down menu and select a month.

5. Touch the boxes next to the Date drop down menu to enter the day and year from the keypad.

6. Touch the boxes below the Time heading to enter the hour and minutes from the keypad and then
touch the AM or PM button.

7. Touch the Adjust for Daylight Savings feature, if necessary.

8. Touch the Save button to save the settings.

Set or verify the date/time format

The date and time format setting for the fax accessory is in the same format as the product date and
time setting. This information can be entered using the Fax Setup Wizard, or by following these steps:

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● General Settings

● Date/Time Settings

● Date/Time Format

3. Touch a Date Format option.

4. Touch a Time Format option.

5. Touch the Save button to save the settings.
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Set fax settings

Remote fax configuration

In addition to using the product control panel, you can configure the fax accessory remotely by using
various software tools. Because the product contains an embedded Web server (EWS), you can
configure the fax accessory across the Web by using either a Web browser or HP Web Jetadmin
(WJA). In addition, you can configure the fax accessory across the network with a network-connected
computer by using the HP MFP Digital Sending Software Configuration Utility (DSS). These tools
provide access to most of the fax accessory configuration settings that available from the product fax
menu.

Web browser

The product contains an embedded Web server (EWS). The EWS allows you to use a Web browser to
access and set the analog-fax settings.

1. Type the IP address of the product in the browser URL address bar and press Enter to open the
EWS Configure product screen. To get the IP address of the product, print a product Configuration
page.

NOTE: If DSS is being used, a message appears on EWS indicating that DSS is in control. The
only way to change settings is through DSS.

2. Click the Fax tab. The Fax Send Setup screen displays.

3. On the Fax Send Setup screen, click Enable Fax Send to enable the fax. Make any changes to
the common job settings and to the specific settings for the type of fax being used, and then click
the Apply button to accept the settings.

HP Web Jetadmin

To access the product analog-fax settings by using HP Web Jetadmin, perform the following steps. For
detailed information about HP Web Jetadmin, see the HP Web Jetadmin Reference Manual.

1. Start HP Web Jetadmin.

2. In the At a Glance text box, type the IP address of the product in the Quick Device Find text
box, and then click the Go button to see the device status in the right pane. Select Digital
Sending and Fax from the status drop-down menu in that pane.

3. Configure the options in the Fax Settings section or the Advanced Fax Settings section. For
information about a specific setting, select the context help next to the setting.

4. After you have made changes to the settings, click the Apply button to accept the settings.

In addition to configuring a single product, you can also perform multiple device configuration. Multiple
device mode configures several products at once. For information about this feature, see the Web
Jetadmin User Guide available under the Self Help and Documentation tab at www.hp.com/
go/webjetadmin.
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HP MFP Digital Sending Software Configuration Utility

To access the analog MFP fax settings by using the DSS configuration utility, perform the following
steps.

1. Start the utility (on the computer or server) to open the main screen.

2. Select the product and click the Configure MFP button on the main screen, and then click the
Send to Fax tab to open the Fax Settings screen.

3. To enable the fax capabilities on the product, select the Enable Fax Send option. To access
Analog-fax settings, select Internal Modem in the Fax Send Method drop-down list. On the
Common Job Settings tab, make any changes to the settings and click the Apply button to
accept the settings. Select the Internal Modem tab to set additional fax settings.

In addition to configuring a single product, you can also configure multiple devices. For more
information about the HP MFP Digital Sending Software Configuration Utility, see the HP MFP Digital
Sending Software User Guide or the HP MFP Digital Sending Software Support Guide.

NOTE: Depending on the capabilities and settings of your fax method, some of these options might
not be available or configurable.

Send fax settings

Fax send setup

Use the Fax Send Setup menu to configure the following features:

● Fax Setup Wizard

● Fax Dialing Settings

● General Fax Send Settings

● Billing Codes

Fax Setup Wizard

The Fax Setup Wizard guides you through a step-by-step procedure to configure fax settings that are
required to use the fax feature. If the settings are not configured, the fax feature is disabled.

The first time the product is turned on with a fax accessory installed, access the fax setup wizard by
following these steps:

1. From the Home screen, touch the Initial Setup button.

2. Touch the Fax Setup Wizard menu.

3. Follow the steps in the Fax Setup Wizard to configure the required settings.

4. When the Fax Setup Wizard finishes, the option to hide the Initial Setup button appears on the
Home screen.
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Access the Fax Setup Wizard after initial setup through the control panel by following these steps:

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● Fax Setup Wizard

Follow these steps to configure the required fax settings using the Fax Setup Wizard:

1. Touch your country/region on the first screen of the Fax Setup Wizard and then touch the Next
button.

2. Touch the date and time boxes to enter the date/time, and then touch the Next button.

3. Touch the Company Name and Fax Number boxes to enter your company name and fax number,
and then touch the Next button.

4. Touch the Dialing Prefix box to enter your dialing prefix, if required, and then touch the Next
button.

5. Confirm your fax configuration settings on the final screen of the Fax Setup Wizard. Touch the
Finish button to complete the Fax Setup Wizard.

-or-

Touch the Back button to move back through the Fax Setup Wizard screens and make changes to
your configuration entries.

NOTE: The settings configured using the Fax Setup Wizard on the control panel override any settings
made in the embedded Web server.

NOTE: If the Fax Setup menu settings does not appear in the menu listing, LAN fax might be
enabled. When LAN fax is enabled, the analog fax accessory is disabled and the fax menu does not
display. Only one fax feature, either LAN fax, analog fax or internet fax, can be enabled at a time. The
fax icon displays for either fax feature. If you wish to use analog fax when LAN fax is enabled, use the
HP MFP Digital Sending Software Configuration Utility to disable LAN fax.
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Fax dialing settings

Set the fax dial volume

Use the Fax Dial Volume setting to control the product's dialing volume level when sending faxes.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● Fax Dialing Settings

3. Touch the Fax Dial Volume drop-down menu and select one of the following settings:

● Off

● Low (default)

● High

4. Touch the Save button to save the fax volume setting.

Set the dialing mode

The dialing mode setting sets the type of dialing that is used: either tone (touch-tone phones) or pulse
(rotary-dial phones).

To set the dialing mode, perform the following steps.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● Fax Dialing Settings

3. Touch the Dialing Mode drop down menu and select either the Tone option (default) or Pulse
option to set the fax dialing mode.

4. Touch the Save button.
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Set fax send speed

The Fax send speed setting sets the modem bit rate (measured in bits per second) of the Analog Fax
modem while sending a fax.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● Fax Dialing Settings

3. Touch the drop down menu under the Fax Send Speed heading and then touch one of the
following:

● Fast (default) — 33600 bps (bits per second)

● Medium — 14400 bps

● Slow — 9600 bps

4. Touch the Save button.

Set the redial interval

The redial interval setting selects the number of minutes between retries if the number dialed is busy or
not answering.

NOTE: You might observe a redial message on the control panel when both the Redial-on-Busy
and Redial-on-No-Answer settings are set to off. This occurs when the fax accessory dials a
number, establishes a connection, and then loses the connection. As a result of this error condition, the
fax accessory performs two automatic redial attempts regardless of the redial settings (the first one at
26,400 bps and, if that fails, a second one at 14,400 bps). During this redial operation, a message
appears on the control panel to indicate that a redial is in progress.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● Fax Dialing Settings

3. Touch the Redial Interval text box to display the keypad.

4. Enter the value (1–5, default is 5) and touch the OK button.

5. Touch the Save button.
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Set redial on error

The Redial on error feature sets the number of times a fax number will be redialed when an error occurs
during a fax transmission.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● Fax Dialing Settings

3. Touch the Redial on error box to open the keypad.

4. Enter a value (0–9, default is 2) and then touch the OK button.

5. Touch the Save button.

Set redial-on-busy

The redial-on-busy setting selects the number of times (0 through 9) the fax accessory redials a number
when the number is busy. The interval between retries is set by the Redial Interval setting.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● Fax Dialing Settings

3. Touch the Redial On Busy text box to display the keypad.

4. Enter a value (0–9, default is 3) and then touch the OK button.

5. Touch the Save button.
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Set redial-on-no-answer

The redial-on-no-answer setting selects the number of times the fax accessory redials if the number
dialed does not answer. The number of retries is either 0 to 1 (used in the U.S.) or 0 to 2, depending
on the country/region setting. The interval between retries is set by the redial interval setting.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● Fax Dialing Settings

3. Touch the Redial On No Answer text box to display the keypad.

4. Enter a value (0–2, default is 0) and then touch the OK button.

5. Touch the Save button.

Set the dial tone detection

The detect dial tone setting determines whether the fax checks for a dial tone before sending a fax.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● Fax Dialing Settings

3. Touch the Detect Dial Tone setting; a checkmark appears next to the Detect Dial Tone setting when
selected. The default setting is unchecked (disabled).

4. Touch the Save button to enable dial tone detection.

Set a dialing prefix (if required)

The dialing prefix setting allows you to enter a prefix number (such as a "9" to access an outside line)
when dialing. This prefix number is automatically added to all phone numbers when dialed.
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NOTE: You might need a pause between the prefix and the phone number. To insert a 2–second
pause, enter a comma (,), pound sign (#), or a “P”. To add an extension number, use “X”.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● Fax Dialing Settings

3. Touch the Dialing Prefix text box to display the keypad.

4. Type your dialing prefix number on the keypad and then touch the OK button.

5. Touch the Save button.

General fax send settings

Use the General Fax Send Settings menu to configure the following features:

● Fax Number Confirmation

● PC Fax Send

● Fax Header

● JBIG Compression

● Error Correction Mode

Activate Fax Number Confirmation

When fax number confirmation is enabled, the fax number must be entered twice to ensure that it was
entered correctly. The default setting for this feature is Disabled.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● General Fax Send Settings

3. Touch the Fax Number Confirmation box to enable fax number confirmation.

4. Touch the Save button.
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Enable PC fax send

Use the PC fax send feature to send faxes from a PC. This feature is enabled by default. If this feature is
disabled, use the following steps to enable:

NOTE: The PC fax send driver must be installed on the computer from where the faxes will be sent.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● General Fax Send Settings

3. Touch the PC Fax Send box.

4. Touch the Save button.

Fax header

Use the fax header feature to control whether the header is appended to the top, and content is shifted
down, or if the header is overlayed on top of the fax image.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● General Fax Send Settings

3. Touch the Prepend (default) or Overlay option in the Fax Header section to orientate the fax
header.

4. Touch the Save button.

Set the JBIG compression mode

Enabling JBIG compression can reduce phone-call charges by reducing fax transmission time and is,
therefore, the preferred setting. However, JBIG might cause compatibility problems when
communicating with some older fax machines, in which case you might need to disable it.

NOTE: JBIG compression only works when both the sending and receiving machines have JBIG
compression.
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To enable or disable JBIG compression, perform the following steps.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● General Fax Send Settings

3. Touch the JBIG Compression feature (default) to enable JBIG compression.

4. Touch the Save button.

Set the error correction mode

Normally, the fax accessory monitors the signals on the telephone line while it is sending or receiving a
fax. If the fax accessory detects an error during the transmission and the error correction setting is on,
the fax accessory can request that the error portion of the fax be sent again.

Error correction mode is enabled by default. You should turn off error correction only if you are having
trouble sending or receiving a fax and if you are willing to accept the errors in the transmission and a
probable quality reduction in the image. Turning off the setting might be useful when you are trying to
send a fax overseas or receive one from overseas, or if you are using a satellite telephone connection.

NOTE: Some VOIP providers may suggest turning error correction mode off. However, this is not
usually necessary.

If error correction mode is disabled, follow these steps to enable:

1. From the Home screen, scroll to and touch the Administration button

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● General Fax Send Settings

3. Touch the Error Correction Mode check box to enable error correction mode if it is disabled
(unchecked).

4. Touch the Save button.

Set billing codes

The billing-code setting, when enabled, prompts the user to enter a number when sending a fax. This
number is placed in the billing-code report. To view the billing-code report, either print the report or
query it by using an application.
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Billing codes are disabled by default. Follow these steps to enable billing codes:

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Fax Send Setup

● Billing Codes

3. Touch the Enable Billing Codes feature to enable billing codes.

NOTE: To disable billing codes, deselect the Enable Billing Codes feature, touch the Save
button, and then skip the remaining steps.

To allow users to edit billing codes, touch the Allow users to edit billing codes feature.

4. Touch the Default Billing Code text box to open the keyboard.

5. Enter the billing code and then touch the OK button.

6. Touch the Minimum Length text box to open the keypad.

7. Type the minimum number of digits you want in the billing code, and then touch the OK button.

8. Touch the Save button.

Default job options

The following default job options are available for configuration:

● Image Preview

● Resolution

● Original Sides

● Notification

● Content Orientation

● Original Size

● Image Adjustment

● Optimize Text/Picture

● Job Build

● Blank Page Suppression

NOTE: Default job option settings are shared across all fax methods; analog, LAN, and internet fax.
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Image preview

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Default Job Options

● Image Preview

3. The following option is available:

● Disable preview

4. Touch the Save button.

Set the outgoing fax resolution

The outgoing fax resolution setting determines the maximum resolution supported by the receiving fax.
The fax accessory uses the highest possible resolution (as limited by this setting) and the maximum
resolution of the receiving fax.

NOTE: Faxes wider than 21.25 cm (8.5 inches) are automatically sent by using standard or fine
resolution, to reduce phone time.

NOTE: The default resolution setting is a lower dpi than previous product model default resolution
settings. For example, previous product models had a default resolution of FINE (200 x 200 dpi).

NOTE: The higher the resolution, the longer the transmission time required.

NOTE: LAN fax settings resolution settings vary by vendor and may differ from the settings listed
below.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Default Job Options

● Resolution

3. Touch one of the following resolution settings:

● Standard (100 x 200dpi) (default)

● Fine (200 x 200dpi)

● Superfine (300 x 300dpi)

4. Touch the Save button.
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Original sides

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Default Job Options

● Original Sides

3. Touch one of the following options:

● 1-sided (default)

● 2-sided

4. Touch the Orientation button to set the page orientation.

5. Touch the Save button.

Notification

Notification selects when and how you are notified of the status of an outgoing fax. This setting applies
to the current fax only. To change the setting permanently, change the default setting.

1. From the Home screen, touch the Fax menu.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Default Job Options

● Notification

3. Touch one of the following notification settings:

● Do not notify (default)

● Notify when job completes

● Notify only if job fails

4. Touch the Print option to receive a printed notification, or touch the E-mail option to receive an e-
mail notification.

5. If you selected the Print option, touch the Save button to complete the notification setup.

-or-
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If you selected the E-mail option, use the keyboard to type an e-mail address. Then touch the OK
button to complete the notification setup.

6. Touch the Include Thumbnail check box to include a thumbnail image with notifications.

Content orientation

Use the content orientation feature to set how the fax content is oriented on the page. For 1–sided
pages, choose Portrait (short-edge on top, default setting) or Landscape (long-edge on top). For 2–sided
pages, choose Book-style (short-edge on top) or Flip-style (long-edge on top).

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Default Job Options

● Content Orientation

3. Touch Portrait (default) or Landscape for 1-sided pages.

4. Touch Book-style or Flip-style for 2-sided pages.

5. Touch the Save button.

Original size

Use the Original size feature to match your fax content to the size of the original document.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Default Job Options

● Original Size

3. Touch one of the following options:

● Auto detect (default)

● Letter (8.5x11)

● Mixed Letter/Legal

● Legal (8.5 x 14)

● Executive (7.25 x 10.5)

● Statement (8.5 x 5.5)
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● Legal (8.5 x 13)

● A4 (210x297 mm)

● A5 (148x210 mm)

● B5 (257x182 mm)

● 16k (197x273 mm)

● DPostcard JIS (148x200 mm)

4. Touch the Save button.

Image adjustment

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Default Job Options

● Image Adjustment

3. Touch the Lighter or Darker buttons to adjust the Darkness setting.

4. Touch the Less or More buttons to adjust the Contrast, Background Cleanup, or Sharpness settings.

5. Touch the Save button.

NOTE: Touch the Default button to reset the sharpness setting to the factory setting.

Optimize text/picture

Use the Optimize text/picture feature to produce fax output that best matches the original. Sending
graphics and photos in text mode results in lower quality images.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Default Job Options

● Optimize Text/Picture

3. Touch one of the following options:

● Manually adjust (default)

● Text
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● Printed picture

● Photograph

4. Touch the Save button.

Job build

Use the Job build feature to combine multiple originals into a single fax job.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Default Job Options

● Job Build

3. Touch one of the following options:

● Job Build off (default)

● Job Build on

4. Touch the Save button.

Blank page suppression

Use the Blank page suppression feature to prevent blank pages in a fax from being printed.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Send Settings

● Default Job Options

● Blank Page Suppression

3. Touch one of the following options:

● Disabled (default)

● Enabled

4. Touch the Save button.
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Receive fax settings

Fax receive setup

Set the ringer volume

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Receive Settings

● Fax Receive Setup

3. Touch the Ringer Volume drop down menu and then select one of the following ringer volume
settings:

● Off

● Low (default)

● High

4. Touch the Save button to save the ringer volume setting.

Set rings-to-answer

The rings-to-answer setting determines the number of times the phone rings before the call is answered
by the fax accessory.

NOTE: The default setting range for rings-to-answer is country/region-specific. The range of possible
rings-to-answer is limited by country/region.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Receive Settings

● Fax Receive Setup

3. Touch the Rings To Answer drop-down menu and then touch the number of rings (1–5, the default
is 1).

4. Touch the Save button.
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Set fax receive speed

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Receive Settings

● Fax Receive Setup

3. Touch one of the following options from the Fax Receive Speed drop down menu:

● Fast (default) — v.34/max 33,600 bps

● Medium — v.17/max 14,600 bps

● Slow — v.29/max 9600 bps

4. Touch the Save button.

Set ring interval

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Receive Settings

● Fax Receive Setup

3. Touch the box beneath the Ring Interval heading to open the keypad.

4. Enter a value for the ring interval on the keypad, and then touch the OK button. The default setting
for ring interval is 600.

5. Touch the Save button.

Set ring frequency

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Receive Settings

● Fax Receive Setup

3. Touch the box beneath the Ring Frequency heading to open the keypad.
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4. Enter a value for the ring frequency on the keypad, and then touch the OK button. The default
setting for ring frequency is 68 hz.

5. Touch the Save button.

Enable or disable the fax printing schedule

NOTE: Before enabling a fax-printing schedule, a schedule must be created.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Receive Settings

● Fax Printing Schedule

3. Touch the Use Fax Printing Schedule option.

4. Touch the Schedule button.

5. Touch Fax Printing Mode.

6. Touch the green plus sign to open the Schedule a Weekly Fax Event screen.

7. Select an option under the Event Type heading:

● Print incoming faxes

● Store incoming faxes

8. Touch the Time fields to open the keypad and then enter the hour and minute values when
incoming faxes will be printed or stored.

9. Touch the Event Days buttons for the days to apply the fax printing schedule.

10. Touch the OK button.

11. Touch the Save button to save the fax printing schedule.

12. Touch the Save button to enable fax printing schedule.

NOTE: Only one fax printing schedule can be applied per day.

Block incoming faxes

Use the fax block list setting to create a list of blocked phone numbers. When a fax is received from a
blocked phone number, the fax is not printed and is immediately deleted from memory.
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Create a blocked-fax list

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Receive Settings

● Blocked Fax Numbers

3. Touch the Fax Number to Block text box to display the keyboard.

4. Type a number and then touch the OK button.

5. Touch the green arrow to move the number to the Blocked Fax Numbers list.

NOTE: To add additional blocked fax numbers, repeat steps 3 through 5.

6. Touch the Save button to save the blocked fax numbers list.

Delete numbers from the blocked-fax list

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Receive Settings

● Blocked Fax Numbers

3. Touch the number to be deleted from the Blocked Fax Numbers list, touch the Delete button, and
then touch the Save button.

4. Touch the OK button to confirm the deletion of the number.

5. Repeat steps 3 and 4 to delete more numbers from the Blocked Fax Numbers list, or touch the
Delete All button, and then touch the Save button, to delete all numbers from the Blocked Fax
Numbers list at once.

Initiate polling receive

Some fax machines can hold a fax until another fax machine requests that the fax be sent. When a
product polls another fax machine that is holding a fax and requests that the held fax be sent to the
product, this is known as polling receive.

1. On the control panel, touch the Fax icon to display the Fax screen.

2. Touch More Options to display the options screen.

3. Scroll to page 3.

4. Touch Fax Polling to display the Fax Polling screen.

ENWW Set fax settings 229



5. Touch the text box to display the keyboard.

6. Using the keypad, type a polling receive number, and then touch Start.

7. The number entered is dialed. If a stored fax is being held at the fax machine dialed, that fax is
transmitted to the product and printed. If no fax is held, a No Fax is Available message will be
displayed. If the fax machine does not support the polling feature, a Poll Invalid error message will
be shown.

Default job options

The following default job options are available for configuration:

● Notification

● Stamp Received Faxes

● Fit to Page

● Paper Selection

● Output Bin

● Sides

NOTE: Default job option settings are shared across all fax methods; analog, LAN, and internet fax.

Notification

This setting controls when the fax call report is printed for incoming faxes.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Receive Settings

● Default Job Options

● Notification

3. Touch one of the following notification settings:

● Do not notify (default)

● Notify when job completes

● Notify only if job fails

4. Touch the Print option to receive a printed notification, or touch the E-mail option to receive an e-
mail notification.

5. If you selected the Print option, touch the Save button to complete the notification setup.

-or-
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If you selected the E-mail option, use the keyboard to type an e-mail address. Then touch the Save
button to complete the notification setup.

6. Touch the Include Thumbnail check box to include a thumbnail image with notifications.

Stamp received faxes (incoming faxes)

The stamp received faxes setting enables or disables stamping incoming faxes. The stamp prints the
date, time, phone number, and page number on each incoming page.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Receive Settings

● Default Job Options

● Stamp Received Faxes

3. Touch the Disabled option (default) to disable the stamp, or touch the Enabled option to enable the
stamp.

4. Touch the Save button.

Set fit-to-page

When selecting a page size to print a fax, the product determines the closest page size that matches
the intended size from sizes available in the product. If the fit-to-page setting is enabled and the
received image is larger than that page size, the product attempts to scale the image to fit the page. If
this setting is disabled, an incoming image larger than the page splits across pages.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Receive Settings

● Default Job Options

● Fit to Page

3. Touch the Enabled option (default) to enable fit-to-page, or touch the Disabled option to disable fit-
to-page.

4. Touch the Save button.
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Set the paper selection

Use the paper selection feature to specify which tray the paper for the fax is loaded from.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Receive Settings

● Default Job Options

● Paper Selection

3. Touch one of the following options:

● Automatic (default)

● Tray 1

● Tray 2

● Tray 3

● Tray 4

● Tray 5

4. Touch the Save button.

Set the output bin

Use the Output bin feature to set which output bin to use for outputting the fax.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Receive Settings

● Default Job Options

● Output Bin

3. Touch the bin to use for your received faxes.

4. Touch the Save button.
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Set the sides

Use the Sides feature to specify 1–side or 2–sided ouput for faxes.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Receive Settings

● Default Job Options

● Sides

3. Touch one of the following options:

● 1-sided (default)

● 2-sided

4. Touch the Save button.

Set the paper tray

The paper tray setting selects the product paper tray to pull paper from for printing faxes.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Receive Settings

● Default Job Options

● Paper Selection

3. Touch the name of the tray to use for received faxes.

4. Touch the Save button to save the paper tray selection value.

Fax archive and forwarding

Use the fax archive feature to save archival copies of all incoming faxes, all outgoing faxes, or both, to
a specified email address.

Use the fax forwarding feature to forward all received faxes, all outgoing faxes, or both, to another fax
number. When fax forwarding is enabled, the receiving product prints the fax (if fax printing is
disabled, the fax prints when the printing is enabled), and also forwards the fax to the fax forward
number.
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NOTE: To use the Archive to Email Address feature, the SMTP server must be configured, and
responding, on the product. For information about configuring the SMTP server, see the product user
guide.

Enable fax archiving

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Archive and Forwarding

3. Touch the Enable Fax Archiving box.

4. Select one of the following choices from the Type of Fax Job to Archive drop down menu:

● Send and receive (default)

● Send only

● Receive only

5. Touch the Fax Archiving E-mail Address text box to open the keypad.

6. Type the email address where faxes will be forwarded, and then touch the OK button.

7. Touch the Save button.

Enable fax forwarding

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Fax Settings

● Fax Archive and Forwarding

3. Touch the Enable Fax Forwarding box.

4. Select one of the following choices from the Type of Fax Job to Forward drop down menu:

● Send and receive

● Send only

● Receive only (default)

5. Touch the Fax Forwarding Number text box to open the keypad.

6. Type the number where faxes will be forwarded, and then touch the OK button.

7. Touch the Save button.
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Use Fax

Fax feature screen

The Fax feature screen is used to send faxes. To access this screen, press the Fax icon displayed on the
control panel Home screen.

1

131415

2 8 95 6 7 3 4 

10
11

12
16
17

1 Home Key - return to main screen

2 Send Fax - press to send fax to recipients

3 Backspace/Delete Number

4 Enter Number into Recipient List

5 Status Message Bar

6 Access fax address book

7 Speed Dial Search by Number

8 Image Preview

9 Help - touch to display help selections

10 Speed Dial - Edit Key

11 Speed Dial - Search by Name

12 Speed Dial List (scroll to display other entries)

13 More Options – touch to view or set other fax sending options.

14 Press for Details of Selected Recipient

15 Press to Delete Selected Recipient from List

16 Fax Recipients

17 Fax Number - Touch for keyboard or enter from control panel keypad1
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1 When the Fax Number is touched, a pop up is displayed which includes the PIN button for adding
special character brackets ([ ]) to hide a PIN, and a Pause button to insert a comma for a two second
pause.

NOTE: The PIN is for calling card numbers, not for the security of faxed documents.

Status message bar

While sending and receiving faxes, status information will display in the status bar located at the top of
some touch screens. This status includes such information as: Ready, Receiving call, Page sent,
and others.

Send a fax

To send a fax, you can use one of three basic methods to enter numbers:

● Enter numbers manually.

● Enter numbers using speed dial.

● Enter numbers using the fax address book.

NOTE: For online information about sending a fax, touch ? on the screen to access the help menu,
and then touch the Fax menu under the list of help topics.

Allowable characters in fax numbers

● Digits (0–9)

● #

● *

● ,

● spaces

● []

● ()
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● –

● +

● X

● P

When entering a phone number from the numeric keypad, include any pauses or other numbers, such
as area codes, access codes for numbers outside a PBX system (usually a 9 or 0), or a long-distance
prefix. A two second pause may be included by typing a comma (,). If the fax prefix setting has been
set to automatically include the dialing prefix, you will not need to enter it.

NOTE: When a fax is sent, it is first scanned and stored into memory. After the entire document is
stored, it is sent and then deleted from memory. Faxes that fail to send, because the number was busy
or did not answer, are deleted from memory. If the Redial On Busy or Redial On No Answer features
are set, the fax will not be deleted until all retries fail or the fax is sent successfully.

Send a fax by entering numbers manually

1. Place the document in the automatic document
feeder (ADF) or on the scanner glass.

 

2. From the Home screen, touch the Fax button.
You may be prompted to type a user name
and password.

 

3. Touch the More Options button. Verify that the
settings match those of your original. When all
settings are completed, touch the up arrow to
scroll to the main Fax screen.
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4. Touch the Fax Number box to open the
keypad.

 

5. Using the keypad, enter a phone number and
then touch the OK button.

 

6. Touch the Start icon to send the fax. You can
either touch the Start icon on the touch screen
or press the green Start button on the control
panel.

 

Send a fax using speed dial

NOTE: Prior to sending a fax using speed dial, you must create a speed dial.

1. Place the document in the automatic document feeder (ADF) or on the scanner glass.

2. From the Home screen, touch the Fax button.

3. Touch a Speed Dial number for the speed dial name you wish to use and then touch the OK
button. The speed dial name will appear in the Fax Number section of the Fax screen.

4. Touch the Start button to send the fax. You can either touch the Start button on the touch screen or
press the green Start button on the control panel.

Search a speed-dial list by name

Use this feature to search an existing speed dial by name.

NOTE: If you do not know the unique name of the speed dial, type a letter to select any portion of the
list. For example, to view speed-dial names that begin with the letter N, type the letter N. If no matching
entries exist, a message appears before the search shows the entry that is closest to the letter N.
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1. From the Home screen, touch the Fax button.  

2. Touch the Speed Dial Search button. This
button looks like a magnifying glass and is
located to the right of the Speed Dial button.

 

3. Type the first letters of the speed dial name to
search for. As matches are found, the list at the
top of the search screen is populated. If
necessary, scroll to see all the entries, or type
more letters to narrow the search.

 

4. Select the appropriate name from the list and
touch the OK button. The speed-dial list on the
main fax screen shows the selected entry
within the list of numbers.

 

5. Touch a speed dial number to add it to the
recipients list.

 

6. Select or search for additional names as
needed.

 

Send a fax by using fax address book numbers

The fax address book feature allows you to store fax numbers on the product.

Your Microsoft® Exchange contact list may also be enabled on the product to appear in the fax
address book.

1. On the control panel, touch the Fax icon to display the Fax screen.

2. Touch the Address Book icon to display the Address Book screen.

3. Select a fax address book source from the drop down menu.

4. Touch the names to highlight and then touch the right arrow icon to move the highlighted names to
the Fax Recipients section.
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5. Touch the OK button to return to the Fax screen.

6. Touch the Start button to send the fax. You can either touch the Start button on the touch screen or
press the green Start button on the control panel.

Fax address book search

Use the fax address book search feature to complete a name search of the address book.

1. Touch the Fax icon on the Home screen.

2. Touch the fax address book icon (located to the right of the fax recipients box).

3. Select the All Contacts or Local Contacts choice in the drop down menu at the top of the fax
address book screen.

4. Touch the Search icon (magnifying glass) next to the drop down menu.

5. On the keyboard, type the first letter or letters of the name; matching recipients appear as letters
are typed. Type more letters to further refine the search. Select from the name(s) found at the top of
the screen, and then touch OK. The screen returns to the Fax fax address book.

6. Touch the right arrow to enter the selected name into the Fax Recipients list.

7. Touch the OK button to return to the Send Fax job screen.

NOTE: To import/export the local fax fax address book to the EWS, refer to the EWS
documentation.

Cancel a fax

Cancel the current fax transmission

▲ Touch the Cancel Job button on the fax Status screen.

-or-

On the control panel, touch the red Stop button.

Touch the OK button when the message Job has been aborted. displays.

Touch the OK button to finish canceling the fax job and return to the fax screen.

Cancel pending faxes

1. From the Home screen, scroll to and touch the Job Status button.

2. Touch the fax job to cancel on the Job Status screen.

3. Touch the Cancel Job button.

4. Touch the Yes button on the screen with the message Are you sure you want to cancel this
job? displays.
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NOTE: The cancel operation may require up to 30 seconds to complete.

Receive faxes

When the fax accessory receives incoming faxes, it stores them in memory before printing. After the
entire fax is stored, it is printed and then deleted from memory. Faxes print when received unless
Schedule Printing of Faxes is enabled. If Schedule Printing of Faxes is enabled, all incoming faxes are
stored in memory and not printed. When Schedule Printing of Faxes is disabled, all stored faxes print.

You can change the fax-receive default settings to modify the way a fax is received. These settings
include the following options:

● Selecting the number of rings-to-answer

● Printing date, time, and page number on faxes (stamp)

● Selecting input paper tray and destination bin

● Forwarding faxes to another number

● Blocking faxes from certain numbers

● Schedule the printing of faxes (memory lock)

● Notification settings

Create or delete speed dial lists

Speed dial allows you to assign a speed dial name to a single number or a group of numbers and then
send a fax to that number or numbers by selecting the speed dial name.

Create a speed dial list

1. From the Home screen, scroll to and touch the
Fax button.

 

2. Touch the Speed Dials button to display the
Speed Dial screen.
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3. Touch a Speed Dial Number.  

4. Touch the Speed Dial Name box to display the
keyboard.

 

5. Type a name for the speed dial.  

6. Touch the down arrow on the Speed Dial
Name box to open the drop down menu.

 

7. Touch the Fax Number option.  

8. Type a fax number for the Speed Dial Name.

NOTE: To enter additional fax numbers for a
speed dial name, touch the screen to the right
of the last digit of the previously entered fax
number. When the cursor appears, touch the
enter key  to move the cursor to the next line.
Repeat this step to enter all the numbers for the
speed dial name.
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9. Touch the OK button. The name and fax
number (or numbers) will appear next to the
Speed Dial Number.

 

10. When finished, press the OK button to return
to the Fax screen

 

Delete a speed dial list

1. From the Home screen, scroll to and touch the
Fax button.

 

2. Touch the Speed Dials button to display the
Speed Dial screen.

 

3. Touch a Speed Dials number of the list to be
deleted.
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4. Touch the Delete button.  

5. Touch the Yes button to confirm the deletion of
the speed dial list and to return to the Fax
screen.

 

Delete a single number from the speed dial list

1. From the Home screen, scroll to and touch the
Fax button.

 

2. Touch the Speed Dials button to display the
Speed Dial screen.

 

3. Touch the Speed Dial number of the list to
open the keyboard.

 

4. Touch the down arrow on the Speed Dial
Name box to open the drop down menu and
then touch the Fax Numbers option.
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5. Scroll through the list of fax numbers and touch
the screen to the right of last digit of the fax
number to be deleted. Use the backspace key
to delete the fax number.

 

6. Touch the OK button to return to the Speed
Dials screen.

 

7. Touch the OK button to return to the Fax
screen.

 

Add a number to an existing speed dial list

1. From the Home screen, scroll to and touch the
Fax button.

 

2. Touch the Speed Dials button to display the
Speed Dial screen.

 

3. Touch the Speed Dial number of the list to be
edited.
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4. Touch the down arrow on the Speed Dial
Name box to open the drop down menu.

 

5. Touch the Fax Numbers item.  

6. To add a fax number for a speed dial name,
touch the screen to the right of the last digit of
the last fax number in the list. When the cursor
appears, touch the enter key  to
move the cursor to the next line and then type
the fax number.

 

7. Touch the OK button to return to the Speed
Dials screen.

 

8. Touch the OK button to return to the Fax
screen.

 

Voice Calls and Retries

Fax Call Report

A Fax Call Report is printed when the Notification feature has been enabled in the Default Job Options
or More Options menu.

When all fax attempts have been exhausted, a Fax Call Report will be printed for a fax send. It shows
the fax job log ID. The result of the final attempt is printed on the Fax Call Report.
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A Fax Call Report does not print for voice calls.

NOTE: A Fax Call Report only generates Job numbers for final attempts. If one of these reports is
printed manually from the menu and the last call was neither the final attempt nor a Voice call the Job
number will be zero.

Fax Activity Log

Voice Calls are not included in the Fax Activity Log by default. Only the final attempt, after all redials
are used or the fax is a success, is listed in the Fax Activity Log.

T.30 Report

Voice Calls do not cause a T.30 report to print. All retry attempts cause a T.30 report to print.

Scheduling fax printing (memory lock)

Use the fax scheduling feature to specify when faxes print. The following fax printing modes can be
selected:

● Store all received faxes

● Print all received faxes

● Use Fax Printing Schedule

If the Store all received faxes feature is selected, then all incoming faxes will be stored in memory and
not printed. It is possible to access fax jobs stored in memory through the Open from Device Memory
menu. Using this menu, you can print or delete print jobs while they are stored in memory. For
additional information about this feature, see the Retrieve Job menu description in the product user
guide.

NOTE: Retrieved stored faxes can be accessed by entering the Fax Printing menu and changing to
the Print all received faxes mode.

If the Print all received faxes mode is selected, then all incoming faxes will be printed. Any faxes that
are currently stored in memory will also be printed.

If the Use Fax Printing Schedule mode is selected, then faxes will be only printed per the fax printing
schedule. The fax printing schedule can be set to lockout an entire day (24 hours) or lockout a time
period during the day. Only one lockout period can be set, but it can be applied to any number of
days. The lockout period is setup under the Fax Printing Schedule menu.

Adding only one type of event into the schedule would make the product behave as Store All
Received Faxes or Print All Received Faxes based on the type of single event added i.e. Single
Store Event would cause device to Store All Received Faxes and Single Print Event would cause
Print All Received Faxes.

NOTE: When the lockout time ends, any faxes that were received and stored during the lockout
period are printed automatically.
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Use Fax over VoIP networks

VoIP technology converts the analog phone signal into digital bits. These are then assembled into
packets which travel on the Internet. The packets are converted and transmitted back to analog signals
at or near the destination.

The transmission of the information on the Internet is done digitally instead of analog. Therefore, there
are different constraints on the fax transmission that may require different fax settings than the analog
Public Switched Telephone Network (PSTN). Fax is very dependent upon timing and signal quality, so a
fax transmission is more sensitive to a VoIP environment.

The following are suggested changes in settings for the HP LaserJet Analog Fax Accessory
500 when it is connected to a VoIP service:

● Start off with the fax set in V.34 (Fast) mode and with Error Correction Mode (ECM) turned on.
The V.34 protocol handles any changes in transmission speed needed to accommodate VoIP
networks.

● If numerous errors or retries occur with the unit set to V.34, set V.34 Off and set speed to Medium
(14,400 bps).

● If errors and retries persist, set a lower fax speed as some VoIP systems cannot handle the higher
signal rates associated with fax. Set the Maximum Baud Rate to 9,600 bps (Slow).

● In rare cases, if errors persist, turn off ECM on the product. The image quality might decrease.
Ensure that the image quality is acceptable with ECM off before using this setting.

● If the preceding setting changes have not improved the VoIP fax reliability, contact your VoIP
provider for help.
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Solve fax problems

Is your fax set up correctly?

Use the following checklist to help identify the cause of any fax related problems you are encountering:

● Are you using the phone cord supplied with the fax accessory? This fax accessory
has been tested with the supplied phone cord to meet RJ11 and functional specifications. Do not
substitute another phone cord; the analog-fax accessory requires an analog phone cord. It also
requires an analog phone connection.

● Is the fax/phone line connector seated in the socket on the fax accessory? Make
sure that the phone jack is well seated in the socket. The connector should be inserted into the
socket until it "clicks."

● Is the phone wall jack working properly? Verify that a dial tone exists by attaching a
phone to the wall jack. Can you hear a dial tone, and can you make a phone call?

What type of phone line are you using?

● Dedicated line: A standard fax/phone number assigned to receive or send faxes.

NOTE: The phone line should be for product fax use only and not shared with other types of
telephone devices. Examples include alarm systems that use the phone line for notifications to a
monitoring companies.

● PBX system: A business-environment phone system. Standard home phones and the fax
accessory use an analog phone signal. Some PBX systems are digital and might not be compatible
with the fax accessory. You need to have access to a standard analog phone line to be able to
send and receive faxes.

● Roll-over lines: A phone system feature where a new call "rolls over" to the next available line
when the first incoming line is busy. Try attaching the fax accessory to the first incoming phone
line. The fax accessory will answer the phone after it rings the number of times set in the rings-to-
answer setting.

NOTE: Roll-over lines can cause problems with the fax accessory's ability to receive faxes. Using roll-
over lines with this product is not recommended.

Are you using a surge-protection device?

A surge-protection device can be used between the wall jack and the fax accessory to protect the fax
accessory against electrical power passed through the phone lines. These devices can cause some fax
communication problems by degrading the quality of the phone signal. If you are having problems
sending or receiving faxes and are using one of these devices, connect the fax accessory directly to the
phone jack on the wall to determine whether the problem is with the surge-protection device.
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Are you using a phone company voice-messaging service or an answering
machine?

If the rings-to-answer setting for the messaging service is lower than the rings-to-answer setting for the
fax accessory, the messaging service answers the call, and the fax accessory is not able to receive
faxes. If the rings-to-answer setting for the fax accessory is lower than that of the messaging service, the
fax accessory answers all calls, and no calls are routed to the messaging service.

Does your phone line have a call-waiting feature?

If the fax telephone line has an activated call-waiting feature, a call-waiting notice can interrupt a fax
call in progress, which causes a communication error. Ensure that a call-waiting feature is not active on
the fax telephone line.

Check fax accessory status

If the analog-fax accessory does not appear to be functioning, print a Configuration page report to
check the status.

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Reports

● Configuration/Status Pages

● Configuration page

3. Touch the Print button to print the report, or touch the View button to view the report on the screen.
The report consists of several pages.

NOTE: The product IP address or host name is listed on the Jetdirect Page.

On the Fax Accessory Page of the Configuration Page, under the Hardware Information heading,
check the Modem Status. The following table identifies the status conditions and possible solutions.

Operational / Enabled1 The analog-fax accessory is installed and ready.

Operational / Disabled1 The fax accessory is installed and operational, however,
HP Digital Sending utility has either disabled the product fax
feature or has enabled LAN fax. When LAN fax is enabled,
the analog-fax feature is disabled. Only one fax feature, either
LAN fax or analog fax, can be enabled at a time.

Non-Operational / Enabled/Disabled1 A firmware failure has been identified. The firmware should
be updated.

Damaged / Enabled/Disabled1 Fax accessory has failed; reseat the fax accessory card and
check for bent pins. If the status is still DAMAGED, replace the
analog-fax accessory card.

1 ENABLED indicates that the analog fax accessory is enabled, turned on; DISABLED indicates that LAN fax is enabled (analog
fax is turned off).
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Fax feature is not operating

The fax accessory is installed but the icon does not appear on the product main screen.

Cause Solution

HP MFP Digital Sending Software Configuration utility has
disabled the analog-fax feature.

Use the HP MFP Digital Sending Software Configuration utility
to enable the analog-fax feature.

The accessory is not operating correctly. Check the fax accessory status. If the status is

NON-OPERATIONAL, new firmware might need to be
installed.

If the status is DAMAGED and you just installed the card, try
reseating the card and check for bent pins.

If the status is DAMAGED and the card is installed correctly,
the card might need to be replaced.

Faulty formatter board. Contact your HP service representative for service.

The product is not displaying the fax menus.

Cause Solution

LAN fax is enabled. This is normal operation. When the HP Digital Sending
Software enables LAN fax, the analog fax is disabled and the
fax menu, which is used for the analog fax only, does not
open.

General fax problems

Problem Cause Solution

Fax failed to send. JBIG is enabled and receiving fax does
not have JBIG capability.

Set JBIG off.

An "Out of Memory" status message
appears on the status message bar.

The product storage disk is full. Delete some files from the disk, see the
product user guide for information about
managing the disk.

Print quality of a photo is poor or prints
as a gray box.

Wrong Page Content mode setting. Try setting the Optimize Text/Picture
option to Photograph.

Pressed the Cancel button on the
product keyboard to cancel a fax
transmission and the fax was still sent.

Cancellation takes place after making a
selection in the cancellation menu
(displayed after pressing red Stop
button) and acknowledging with OK.

Cancel faxes using the fax menu.

No fax address book button appears. The fax address book feature has not
been enabled.

Use the HP MFP Digital Sending
Software Configuration utility to enable
the fax address book feature.
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Problem Cause Solution

Not able to locate the Fax settings in
HP Web Jetadmin.

Fax settings in HP Web Jetadmin are
located under the device's status page
drop-down menu.

Select Digital Sending and Fax from
the drop-down menu.

The header is being appended to the
top of the page when I have overlay
enabled.

The fax will append the overlay header
to the top of a page when overlay is set,
when the fax has been forwarded.

This is normal operation.

Have a mix of names and numbers in
the recipients box.

This is normal for both names and
numbers to appear, depending on
where they are from, the fax address
book lists names, and all other
databases list numbers.

Normal, no action required.

My one page fax prints as two pages. The fax header is being appended to
the top of the fax, pushing text to a
second page.

If you want your one page fax to print
on one page, set the overlay header to
overlay mode or adjust the Fit to page
setting.

Document stops feeding in the middle of
faxing.

There might be a jam in the ADF. If there is a jam, see the product user
guide for instructions on clearing jams.

The volume for sounds coming from the
fax accessory is too high or too low.

The volume setting needs to be adjusted.  

Problems with receiving faxes

Incoming fax calls are not being answered by the fax accessory (no fax detected).

Cause Solution

The rings-to-answer setting might not be set correctly. Check the rings-to-answer setting.

The phone cord might not be connected properly, or the
phone cord is not working.

Check the installation. Make sure you are using the phone
cord that came with the fax accessory.

The phone line might not be working. Disconnect the fax accessory from the phone jack, and
connect a phone. Try to make a phone call to ensure the
phone line is working.

A voice-messaging service might be interfering with the fax
accessory's ability to answer calls.

Do one of the following:

● Discontinue the messaging service.

● Get a phone line dedicated to fax calls.

● Decrease the rings-to-answer for the fax accessory to a
number less than the rings-to-answer for the voice mail.

Faxes are transmitting or being received very slowly.

Cause Solution

You might be sending or receiving a very complex fax, such
as one with many graphics.

Complex faxes take longer to be sent or received.
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Faxes are transmitting or being received very slowly.

Cause Solution

The receiving fax machine might have a slow modem speed. The fax accessory only sends the fax at the fastest modem
speed the receiving fax machine can use.

The resolution at which the fax was sent or is being received
is very high. A higher resolution typically results in better
quality, but also requires a longer transmission time.

If you are receiving the fax, call and ask the sender to
decrease the resolution and resend the fax. If you are
sending, decrease the resolution and change the Optimize
Text/Picture option.

If there is a poor phone-line connection, the fax accessory and
the receiving fax machine slow down the transmission to
adjust for errors.

Cancel and resend the fax. Have the phone company check
the phone line.

Faxes are not printing on the product.

Cause Solution

There is no media in the media input tray. Load media. Any faxes received while the input tray is empty
are stored and will print after the tray has been refilled.

Schedule Printing of Faxes is set. If Schedule Printing of Faxes is enabled, faxes will not print
until it is disabled.

The product is either low on toner or has run out of toner. The product stops printing as soon as it is low on toner or runs
out of toner. Any faxes received are stored in memory and
print after the toner has been replaced. For other product
printing problems, see the product user guide.

Incoming call may be a voice call. Incoming voice calls usually show up in the call report as a
Communication Error (17) As these are voice calls and
not a fax error, no action is needed to be taken. Ensure that
those calling you have a voice number that is different from
the fax number.

The incoming fax was interrupted. Verify that the fax telephone line does not have an activated
call-waiting feature. A call-waiting notice can interrupt a fax
call in progress, which causes a communication error.

The Fax Printing Schedule feature is set to Always store faxes. Change the Fax Printing Schedule setting to Always print
faxes.

Problems with sending faxes

Problem Cause Solution

Faxes quit during sending. The fax machine to which you are
sending might be malfunctioning.

Try sending to another fax machine.

 Your phone line might not be working. Disconnect the fax accessory from the
phone jack, and connect a phone. Try to
make a phone call to ensure the phone
line is working.
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Problem Cause Solution

 Your phone line might be noisy or poor
quality

Try using a lower baud rate to improve
the reliability of transmission. See
maximum baud rate setting.

 A call-waiting feature might be active Verify that the fax telephone line does
not have an activated call-waiting
feature. A call-waiting notice can
interrupt a fax call in progress, which
causes a communication error.

The fax accessory is receiving
faxes but is not sending them.

If the fax accessory is on a PBX system,
the PBX system might be generating a
dial tone the fax accessory cannot
detect.

Disable the detect dial tone setting.

 There might be a poor phone
connection.

Try again later.

 The fax machine to which you are
sending might be malfunctioning.

Try sending to another fax machine.

 Your phone line might not be working. Disconnect the fax accessory from the
phone jack, and connect a phone. Try to
make a phone call to ensure the phone
line is working.

Outgoing fax calls keep dialing. The fax accessory automatically redials
a fax number if the Redial on Busy
option is set to on or if the Redial On No
Answer is set on.

This is normal operation. If you do not
want the fax to retry, set Redial on Busy
to 0 and set Redial On No Answer to 0.

Faxes you send are not arriving
at the receiving fax machine.

The receiving fax machine might be
turned off or might have an error
condition, such as being out of paper.

Call the recipient to make sure the fax
machine is turned on and ready to
receive faxes.

 A fax might be in memory because it is
waiting to redial a busy number, or
there are other jobs ahead of it waiting
to be sent.

If a fax job is in memory for either of
these reasons, an entry for the job
appears in the fax log. Print the fax
activity log, and check the Result
column for jobs with a Pending
designation.

Error codes

If a fax problem occurs which prevents or interrupts sending or receiving of a fax, an error code is
generated that will help in determining the cause of the problem. Error codes show up in the fax activity
log, the fax call report, and the T.30 Protocol Trace. Print one of these three reports to obtain the error
code. A detailed description of the error codes and the appropriate action can be found at
www.hp.com by searching for HP LaserJet Analog Fax Accessory 500.

Fax error messages

When an analog fax is sent or received on an HP LaserJet product, any errors that occur during the fax
process will be displayed on the product control panel and entered into the fax reports. Fax errors can
occur for many reasons and often they are due to interruptions or noise on the telephone connection.
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Any error that takes place during the fax process regardless of where it originates will be displayed by
the product.

If the fax process is interrupted or an error occurs during a fax transmission or reception, a two part
status/error description is generated by the fax subsystem on the product. Normal or successful faxes
also generate messages indicating success. The message information consists of a text description and
a numeric code (a few messages don’t include numeric codes). Only the text part of the message will
be displayed on the product control panel; however, both the text message and numeric code will be
listed in the Fax Activity Report, Fax Call Report, and the Fax T.30 Trace (these fax reports can be
printed out individually from the product control panel – under the Administration > Reports > Fax
Reports and Administration > Troubleshooting > Fax > Fax T.30 Trace menus). The numeric code is
shown in parentheses after the text part of the message in the reports. For example, if a communication
error occurred, the control panel display would show Fax Failed: Communication Error. The same error
would be shown in the Result field in the Fax Activity Report as Communication Error (17). For this
example, the numeric code associated with this communication error is ‘17’.

The numeric code is generated by the fax modem. Usually a numeric code of (0) indicates a normal
modem response. Some messages will always display a numeric code of (0), whereas other messages
can have a range of numeric codes depending on the circumstances, and a few messages will have no
numeric code. Usually a numeric code of (0) indicates an error was not associated with the fax modem,
but occurred in another part of the fax subsystem or other product subsytem such as the printing
subsystem. Non-zero error codes give further detail into the particular action or process that the modem
is executing, and they don’t necessarily indicate that there is a problem with the modem.

In the tables that follow, the fax messages with the most common number codes are given with
recommended corrective action. Several messages that are normal or indicate a normal event are also
included in tables. For example, if a fax was not able to be sent to a busy number, a Fail Busy message
will be shown. Nothing is wrong with the fax subsystem; the message indicates the fax was not
completed due to a busy telephone number at the receiving end.

Persistent error messages with numeric codes different than those listed here require assistance of
customer support. A more detailed listing of the last fax call can be printed out before contacting
customer support to help identify the problem. The detailed fax listing is called a Fax T.30 Trace and
can be printed for the last fax, or it can be set to print whenever a fax error occurs. To print or
configure the Fax T.30 Trace, touch Administration, Troubleshooting, and then Fax T.30 Trace. You can
then print the report for the last fax or configure when to print the T.30 trace.
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Send-fax messages

Table 12-1  Send-fax messages

Message Error No. Description Action(s)

Cancelled 0 Fax was cancelled by user at
control panel of product.

None.

Success n/a Fax sent successfully. None.

Fail Busy 0 The receiving fax machine is
busy.

The fax will be retired
automatically (if configured),
otherwise try resending fax
later.

No Answer 0 The receiving fax machine is
not answering the call.

The receiving fax machine
may be disconnected or
turned off; contact the
receiver to check the
machine. Try resending.

Compression Error Any Fax may be corrupted or not
sent.

Try resending fax.

No Dial 0 No dial tone is detected
when sending the fax.

Verify the phone line is
active; set the sending fax to
"not" to detect a dial tone.

Modem Fail Any Unexpected or bad response
from the internal fax modem
to product.

Try resending fax; if the error
persists, contact service.

NOTE: This does not
necessarily indicate that the
modem hardware is bad.

Communication Error 17 or 36 Lost telephone connection
between sender and receiver.
May be due to voice calls.

Try resending the fax.

Communication Error Any besides 17 or 36 General communications
issue where the fax
transmission was interrupted
or did not proceed as
expected.

Try resending fax; if the error
persists, contact service.

Space Fail 0 Unable to read or write the
fax image file to disk; could
be corrupt product disk or no
space available on the
product's disk.

Try resending fax; if the error
persists, contact service.

Page Fail 0 Incompatible page width, or
page had too many bad
lines.

Try resending fax; if the error
persists, contact service.

Memory Error 0 Out of RAM memory on
product.

If error persists, may need to
add RAM to product.

Job Fail Any Fax failure; the fax job did
not complete.

Try resending fax; if the error
persists, contact service.
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Table 12-1  Send-fax messages (continued)

Message Error No. Description Action(s)

Power Failure 0 A power failure occurred
during the fax transmission on
the sending fax product.

Try resending the fax.

No Fax Detected 17 or 36 No fax machine was detected
at receiving end. May be due
to voice calls.

Verify fax number and have
receiver verify fax machine is
on and connected; then try
resending fax.
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Receive-fax messages

Table 12-2  Receive-fax messages

Message Error No. Description Action(s)

Success n/a Fax received ok. None.

Blocked n/a Fax reception was blocked by
receiving fax machine using
blocked number feature.

None.

Modem Fail Any Unexpected or bad response
from the internal modem to
the product - example is
trying to send a fax just as
another fax is arriving.

Have fax resent; if the error
persists, contact service.

Communication Error 17, 36 Lost telephone connection or
interruption between sender/
receiver.

Have the sender resend the
fax (if the sending machine
does not automatically retry).

Communication Error Any besides 17 or 36 General communications
issue where the fax
transmission was interrupted
or did not proceed as
expected.

Have fax resent; if the error
persists, contact service.

Space Fail 0 Unable to read or write
image file to disk; could be
corrupt product disk or no
space on disk.

Have fax resent; if the error
persists, contact service.

Page Fail 0 Incompatible page width or
page had too many bad
lines.

Have fax resent; if the error
persists, contact service.

Memory Error 0 Out of RAM memory on
product.

If error persists, may need to
add additional RAM memory
to product.

Compression Error 0 Corrupted fax - the received
image file cannot be
decoded.

Have fax resent; enable ECM
(Error Correction Mode) if not
already.

Print Fail 0 Corrupted fax - the received
image file cannot be
decoded.

Have fax resent; enable ECM
(Error Correction Mode) if not
already.

Poll Invalid 0 The fax polling feature
attempted to retrieve a fax
from another machine but no
fax was available.

Contact the administrator of
the fax machine being polled
and verify a fax is available,
and then retry.

Job Fail Any Fax failure; this includes all
non-specific failures.

Have fax resent; if the error
persists, contact service.

Power Failure 0 A power failure occurred
during the fax reception.

Have the sender resend the
fax.

No Fax Detected 17, 36 A voice call was made to the
fax.

None
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Fax reports

The following sections list the fax reports available on this product. These reports can be printed or
viewed on the product control panel.

The following fax reports are available on this product:

● Fax Activity Log

● Billing Codes Report

● Blocked Fax List

● Speed Dial List

● Fax Call Report

Use the following steps to print or view a fax report:

1. From the Home screen, scroll to and touch the Administration button.

2. Open the following menus:

● Reports

● Fax Reports

3. Touch the log or report to print or view.

4. Touch the Print or View button.

Fax activity log

The fax activity log includes the following information.

● The fax header information configured on the product.

● The job number of each fax job.

● Date and time of all faxes received, sent, or failed to send.

● The type of fax job; send or receive.

● Identification (phone number, if available)

● Duration (off-hook time)

● Number of pages

● Result (successfully sent, pending, or failed to send which includes error type and code)

The database stores the most recent 500 fax entries (older faxes are deleted from the log). The
database fax entries include any fax session as an entry. For example, a fax session could be a sent
fax, received fax, or firmware upgrades. Depending on the activity, there might be fewer than 500
entries in the report (unless you sent 500 faxes without receiving any faxes or other completing another
activity).
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If you want to use the log for record keeping purposes, you should print the log periodically (at least
every 500 faxes) and then clear it.

Billing code report

The billing code report is a list of the most recent 500 faxes that were successfully sent, listed by billing
code. The following information is provided in this report.

● Billing code number

● Date and time of all faxes that were successfully sent

● Identification number

● Duration (off hook time)

● Number of pages sent

● Result (success)

The database stores the most recent 500 faxes (older faxes are deleted from the database). If you want
to use the report for record keeping purposes, you should print the report periodically (at least every
500 faxes) and then clear it.

Blocked fax list report

The blocked fax list report contains the list of fax numbers that the product has been configured to not
receive faxes from.

Speed dial list report

A speed dial list report lists the fax numbers assigned to speed dial names.

Fax call report

The fax call report is a brief report that indicates the status of the last fax that was sent or received.

Clear the fax activity log

To clear the fax activity log, complete the following steps.

1. On the control panel, touch the Administration icon.

2. Open the following menus:

● Fax Settings

● Clear fax activity log

3. Touch the Clear button to clear the fax activity log.
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Service settings

These items in the control-panel menus can help with troubleshooting if the corrective action taken under
the Error Codes section is unsuccessful. They are intended to be used when an HP service
representative is assisting you.

Settings in the Troubleshooting menu

Open the Administration menu, and then select the Troubleshooting menu.

Troubleshooting menu settings T.30 Trace: The T.30 trace is a printed report which
produces a record of all the communications between the
sending and receiving fax machines for the last Fax
transmission or reception. The report has many technical
details which are usually beyond the scope of most users.
However the report contains detailed error codes and other
information that might be useful in troubleshooting a particular
problem related to sending or receiving a FAX. The report
contents might be requested by an HP service representative
when trying to determine the cause of a problem and will help
to determine the appropriate action.

 Transmit Signal LossTransmit Signal Loss: This selection
compensates for phone line signal loss. It is not recommended
to modify this setting unless requested to do so by an HP
service representative as it might render the fax inoperable.

 V34: This setting has two values (Normal and Off) that control
the modem's baud rate. The Normal setting allows the modem
to select (negotiate with the other modem) any of the
supported baud rates up to 33,600 bps. The Off setting sets
the baud rate to 14,400 bps. This setting remains set, until
changed.

 Speaker Mode: This service setting has two modes, Normal
and Diagnostic. In Normal mode, the modem speaker is
turned on during dialing through the initial connection and
then shuts off. For Diagnostic mode, the speaker is turned on
and remains on for all fax communications until the setting is
returned to Normal.

Settings in the Resets menu

Open the Administration menu, and then select the Resets menu.

Resets menu settings Restore Factory Telecom Settings or Restore Default Telecom
Settings: This selection resets several menu changes back to
their default settings. This includes the maximum baud rate,
ring-burst off time, V.34, speaker mode, and transmit signal
loss.
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Firmware upgrades

The firmware on the fax accessory can be updated. Fax firmware updates occur as part of an overall
product firmware update. See the product user guide for more information.
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13 Manage and maintain

● Print information pages

● Use the HP Embedded Web Server

● Use HP Web Jetadmin software

● Product security features

● Economy settings

● Install external I/O cards

● Clean the product

● Product updates
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Print information pages
Information pages provide details about the product and its current configuration. Use the following
procedure to print or view the information pages:

1. From the Home screen, scroll to and touch the Administration button.

2. Open the Reports menu.

3. Select the name of the report you want to review, and then touch the Print button to print it or
touch the View button to review the settings on the control-panel display.

NOTE: Some pages do not have the View option.

Table 13-1  Reports menu

First level Second level Description

Configuration/Status Pages Administration Menu Map  

 Configuration Page Shows the product settings and installed
accessories.

 Supplies Status Shows the approximate remaining life for the
supplies; reports statistics on total number of
pages and jobs processed, serial number,
page counts, and maintenance information.

HP provides approximations of the
remaining life for the supplies as a customer
convenience. The actual remaining supply
levels might be different than the
approximations provided.

 Usage Page Shows a count of all paper sizes that have
passed through the product; lists whether
they were simplex, duplex, monochrome, or
color; and reports the page count.

 File Directory Page Shows the file name and folder name for files
that are stored in the product memory.

 Color Usage Prints the color-use statistics for the product.

Fax Reports Fax Activity Log Contains a list of the faxes that have been
sent from or received by this product.

 Billing Codes Report A list of billing codes that have been used for
outgoing faxes. This report shows how many
sent faxes were billed to each code.

 Blocked Fax List A list of phone numbers that are blocked
from sending faxes to this product.

 Speed Dial List Shows the speed dials that have been set up
for this product.

 Last Fax Call Report A detailed report of the last fax operation,
either sent or received.
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Table 13-1  Reports menu (continued)

First level Second level Description

Other Pages Demo Page Prints a demonstration page that highlights
the printing capability of the product.

 Color Samples for RGB Prints color samples for different RGB values.
Use the samples as a guide for matching
printed colors.

 CMYK Values Prints color samples for different CMYK
values. Use the samples as a guide for
matching printed colors.

 PCL Font List Prints the available PCL fonts.
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Use the HP Embedded Web Server
Use the HP Embedded Web Server to view product status, configure product network settings, and to
manage printing functions from your computer instead of from the product control panel. The following
are examples of what you can do using the HP Embedded Web Server:

● View product status information.

● Determine the remaining life for all supplies and order new ones.

● View and change tray configurations.

● View and change the product control-panel menu configuration.

● View and print internal pages.

● Receive notification of product and supplies events.

● View and change network configuration.

To use the HP Embedded Web Server, you must have Microsoft Internet Explorer 5.01 or later or
Netscape 6.2 or later for Windows, Mac OS, and Linux (Netscape only). Netscape Navigator 4.7 is
required for HP-UX 10 and HP-UX 11. The HP Embedded Web Server works when the product is
connected to an IP-based network. The HP Embedded Web Server does not support IPX-based product
connections. You do not have to have Internet access to open and use the HP Embedded Web Server.

When the product is connected to the network, the HP Embedded Web Server is automatically
available.

Open the HP Embedded Web Server by using a network
connection

1. Identify the product IP address or host name. If the Network Address button is visible on the Home
screen on the product control panel, touch that button to display the address. Otherwise, follow
these steps to print or view the product configuration page:

a. From the Home screen on the product control panel touch the Administration button.

b. Open the following menus:

◦ Reports

◦ Configuration/Status Pages

◦ Configuration Page

c. Touch the Print or View button.

d. Find the IP address or host name on the Jetdirect page.

2. In a supported Web browser on your computer, type the product IP address or host name in the
address/URL field.
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HP Embedded Web Server features

Information tab

Table 13-2  HP Embedded Web Server Information tab

Menu Description

Device Status Shows the product status and shows the estimated life remaining of HP supplies. The
page also shows the type and size of paper set for each tray. To change the default
settings, click the Change Settings link.

Configuration Page Shows the information found on the configuration page.

Event Log Page Shows a list of all product events and errors. Use the HP Instant Support link (in
the Other Links area on all HP Embedded Web Server pages) to connect to a set
of dynamic Web pages that help you solve problems. These pages also show
additional services available for the product.

Usage Page Shows a summary of the number of pages the product has printed, grouped by
size, type, and paper print path.

Device Information Shows the product network name, address, and model information. To customize
these entries, click the Device Information menu on the General tab.

Print Browse to a file on your computer or network, and print it.

Printable Reports and Pages Lists the internal reports and pages for the product. Select one or more items to print
or view.

General tab

Table 13-3  HP Embedded Web Server General tab

Menu Description

Control Panel Administration
Menu

Shows the menu structure of the Administration menu on the control panel.

NOTE: You can configure settings on this screen, but the HP Embedded Web
Server provides more advanced configuration options than are available through
the Administration menu.

Alerts Set up e-mail alerts for various product and supplies events.

AutoSend Configure the product to send automated e-mails regarding product configuration
and supplies to specific e-mail addresses.

Control Panel Snapshot Shows an image of the current screen on the control-panel display.

Edit Other Links Add or customize a link to another Web site. This link appears in the Other Links
area on all HP Embedded Web Server pages.

Ordering Information Enter specific supplies ordering information to be displayed on the Supplies Status
Page. For example, this information could include the contact information or Web
URL for the company from which you purchase supplies.

Device Information Name the product and assign an asset number to it. Enter the name of the primary
contact who will receive information about the product.
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Table 13-3  HP Embedded Web Server General tab (continued)

Menu Description

Language Set the language in which to display the HP Embedded Web Server information.

Date and Time Set the date and time or synchronize with a network time server.

Sleep Schedule Set or edit a wake time, sleep time, and sleep delay for the product. You can set a
different schedule for each day of the week and for holidays.

Backup and Restore Create a backup file that contains product and user data. If necessary, you can use
this file to restore data to the product.

Solution Installer Install third-party software programs that can enhance the product functionality.

Quick Sets Setup Configure jobs that are available in the Quick Sets area of the Home screen on
product control panel.

Quota Server Setup Connecting to a quota server ensures that each person who uses the product stays
within a predetermined range of printed or scanned pages. When connected, the
product queries the server at the start of each job to ensure that the person has
pages available.

Copy/Print tab

Table 13-4  HP Embedded Web Server Copy/Print tab

Menu Description

Open from USB Setup Enable or disable the Open from USB menu on the control panel.

Manage Stored Jobs Enable or disable the ability to store jobs in the product memory, and configure job-
storage options.

Restrict Color Permit or restrict color printing and copying. You can specify permissions for
individual users or for jobs that are sent from specific software programs.

Scan/Digital Send tab

Table 13-5  HP Embedded Web Server Scan/Digital Send tab

Menu Description

Address Book Add e-mail addresses into the product one at a time, and edit e-mail addresses that
have already been saved in the product. You can also use the Import/Export tab
to load a large list of frequently-used e-mail addresses on to the product all at once,
rather than adding them one at a time.
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Table 13-5  HP Embedded Web Server Scan/Digital Send tab (continued)

Menu Description

E-mail Setup Configure the default e-mail settings for digital sending, including the following:

● Settings for the outgoing mail (SMTP) server

● Default settings for E-mail Quick Sets jobs

● Default message settings, such as the "From" address and the subject line.

● Settings for digital signatures and encryption

● Settings for e-mail notifications

● Settings for individual and group sign-in and permissions

● Default scan settings for e-mail jobs

● Default file settings for e-mail jobs

Save to Network Folder Setup Configure the network folder settings for digital sending, including the following:

● Default settings for Quick Sets jobs saved in a network folder

● Settings for notifications

● Default scan settings for jobs saved in a network folder

● Default file settings for for jobs saved in a network folder

Save to USB Setup Configure the USB settings for digital sending, including the following:

● Default settings for Quick Sets jobs saved on a USB flash drive

● Settings for notifications

● Default scan settings for jobs saved on a USB flash drive

● Default file settings for for jobs saved on a USB flash drive

OXPd: Workflow Use third-party workflow tools.

Digital Sending Software Setup Configure settings related to using optional Digital Sending software.

Fax tab

Table 13-6  HP Embedded Web Server Fax tab

Menu Description

Fax Send Setup Configure settings for sending faxes, including the following:

● Default settings for outgoing faxes

● Default setting for sending faxes with the internal fax modem

● Settings for using a LAN fax service

● Settings for using an Internet fax service
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Table 13-6  HP Embedded Web Server Fax tab (continued)

Menu Description

Speed Dials Manage fax speed dial numbers. You can also import .CSV files containing e-mail
addresses, fax numbers, or user records, so that they can be accessed on this
product. You can also export e-mail, fax, or user records from the product into a file
on your computer. You can then use this file as a data backup, or you can use it to
import the records onto another HP product.

Fax Receive Setup Configure default print options for incoming faxes, and set up a fax printing
schedule.

Fax Archive and Forwarding Enable or disable fax archiving and fax forwarding, and configure basic settings
for each.

● Fax archiving is a method to send a copy of all incoming and outgoing faxes
to an e-mail address.

● Fax forwarding is a method to forward incoming faxes to a different fax
device.

Fax Activity Log Contains a list of the faxes that have been sent from or received by this product.

Troubleshooting tab

Table 13-7  HP Embedded Web Server Troubleshooting tab

Menu Description

Reports and Tests Print a variety of reports to help you solve problems with the product.

Change the fax speed and fax speaker mode for diagnostic purposes.

Calibration/Cleaning Enable the automatic cleaning feature, set the page count at which the product
automatically prints the cleaning page, and set the page size to use for the cleaning
page.

Security tab

Table 13-8  HP Embedded Web Server Security tab

Menu Description

General Security Configure an administrator password so you can restrict access to certain features
on the product.

Enable or disable the Host USB port on the control panel or the USB connectivity
port on the formatter for printing directly from a computer.

Access Control Configure access to product functions for specific individuals or groups. Also select
the method by which individuals sign in to the product.
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Table 13-8  HP Embedded Web Server Security tab (continued)

Menu Description

Protect Stored Data Configure and manage the internal hard drive for the product. This product includes
an encrypted hard drive for maximum security.

Configure settings for jobs that are stored on the product hard drive.

Certificate Management Install and manage security certificates for access to the product and the network.

Networking tab

Use the Networking tab to change network settings for the product when it is connected to an IP-
based network. This tab does not appear if the product is connected to other types of networks.

Other Links list

NOTE: You can configure which items appear in the Other Links list by using the Edit Other
Links menu on the General tab. The following items are the default links.

Table 13-9  HP Embedded Web Server Other Links list

Menu Description

HP Instant Support Connects you to the HP Web site to help you find solutions to product problems.

Shop for Supplies Connects to the HP SureSupply Web site, where you can receive information on
options for purchasing original HP supplies, such as print cartridges and paper.

Product Support Connects to the support site for the product, from which you can search for help
regarding various topics.

Show Me How Connects to information that demonstrates specific tasks for the product, such as
clearing jams and printing on various types of paper.
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Use HP Web Jetadmin software
HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of
networked HP devices, including printers, multifunction products, and digital senders. This single
solution allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and
imaging environment — ultimately increasing business productivity by helping you save time, control
costs, and protect your investment.

HP Web Jetadmin updates are periodically made available to provide support for specific product
features. Visit www.hp.com/go/webjetadmin and click the Self Help and Documentation link to
learn more about updates.
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Product security features

Security statements

The product supports security standards and recommended protocols that help you keep the product
secure, protect critical information on your network, and simplify the way you monitor and maintain the
product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go/
secureprinting. The site provides links to white papers and FAQ documents about security features.

IP Security

IP Security (IPsec) is a set of protocols that control IP-based network traffic to and from the product.
IPsec provides host-to-host authentication, data integrity, and encryption of network communications.

For products that are connected to the network and have an HP Jetdirect print server, you can configure
IPsec by using the Networking tab in the HP Embedded Web Server.

Secure the HP Embedded Web Server

Assign an administrator password for access to the product and the HP Embedded Web Server so that
unauthorized users cannot change the product settings.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a
Web browser.

2. Click the Security tab.

3. Open the General Security menu.

4. In the Username field, type the name to associate with the password.

5. Type the password in the New Password box, and type it again in the Verify password
box.

NOTE: If you are changing an existing password, you must first type the existing password in
the Old Password field.

6. Click the Apply button. Make note of the password and store it in a safe place.

Encryption support: HP Encrypted High Performance Hard Disks

This product includes an encrypted hard disk. This hard disk provides hardware-based encryption so
you can securely store sensitive print, copy, and scan data without impacting product performance.
This hard disk uses the latest Advanced Encryption Standard (AES) and has versatile time-saving
features and robust functionality.

Use the Security menu in the HP Embedded Web Server to configure the disk.
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For more information about the encrypted hard disk, see the HP High-Performance Secure Hard Disk
Setup Guide.

1. Go to www.hp.com/support.

2. Type Secure Hard Disk into the search box and click the >> button.

3. Click the HP Secure High Performance Hard Disk Drive link.

4. Click the Manuals link.

Secure stored jobs

You can protect jobs that are stored on the product by assigning a PIN to them. Anyone who tries to
print these protected jobs must first enter the PIN at the product control panel.

Lock the control panel menus

You can lock various features on the control panel by using the HP Embedded Web Server.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a
Web browser.

2. Click the the Security tab.

3. Open the Access Control menu.

4. In the Sign In and Permission Policies area, select which types of users have permission for
each of the features.

5. Click the Apply button.

Lock the formatter

The formatter area, on the back of the product, has a slot that you can use to attach a security cable.
Locking the formatter prevents someone from removing valuable components from it.
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Economy settings

Optimize speed or energy use

By default the product stays warm between jobs to optimize speed. You can set the product to cool
between jobs, which conserves energy.

1. From the Home screen, touch the Administration button.

2. Open each of the following menus:

a. General Settings

b. Energy Settings

c. Optimum Speed/Energy Usage

3. Select the option that you want to use.

Powersave modes

Use the Sleep Schedule feature to reduce power consumption when the product is inactive. You can
schedule specific times of the day at which the product enters sleep mode or wakes from sleep mode.
You can customize this schedule for each day of the week or for holidays.

Use the Sleep Delay feature to cause the product to enter sleep mode automatically after a predefined
period of inactivity.

NOTE: These features do not affect product warm-up time.

Set sleep mode

1. From the Home screen, touch the Administration button.

2. Open each of the following menus:

a. Display Settings

b. Sleep Mode

3. Select one of the following options:

● Use sleep delay: Activates the Sleep Delay feature.

● Use sleep schedule: Activates the Sleep Schedule feature.

● Use both: Use the sleep delay and the sleep schedule.
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Set sleep delay

1. From the Home screen, touch the Administration button.

2. Open each of the following menus:

a. General Settings

b. Energy Settings

c. Sleep Delay

3. Select the appropriate time period, and then touch the OK button.

NOTE: The default value is 45 minutes.

Set the sleep schedule

NOTE: You must configure the date and time settings before you can use the Sleep Schedule feature.
If you have already configured the date and time settings, you can skip steps 2 and 3 in the following
procedure.

1. From the Home screen, touch the Administration button, and then open the General Settings menu.

2. Open the Date/Time Format menu. Configure the following settings:

● Date Format

● Time Format

3. Open the Date/Time menu and configure the following settings:

● Date

● Time

● Time Zone

If you are in an area that uses daylight savings time, select the Adjust for Daylight Savings box.

4. Open the Energy Settings menu, and then open the Sleep Schedule menu.

5. Touch the Add  button, and then select the type of event to schedule: Wake Up or Sleep.

6. Configure the following settings:

● Event Time

● Event Days

● Event Description

7. Open the Holidays menu to configure which days are holidays for your area.
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Install external I/O cards
This product is equipped with an external I/O (EIO) slot. You can install an additional HP Jetdirect print
server card or external EIO hard drive in the available EIO slot.

NOTE: This example shows installing an HP Jetdirect print server card.

1. Turn the product off.

2. Disconnect all power and interface cables.

NOTE: This illustration might not show all the cables.
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3. Loosen and remove the two retaining screws holding the cover for the EIO slot, and then remove
the cover. You will not need these screws and the cover again. They can be discarded.

4. Firmly insert the HP Jetdirect print server card into the EIO slot.

5. Insert and tighten the retaining screws that came with the print server card.
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6. Reconnect the power cable and remaining interface cables, and turn the product on.

7. Print a configuration page. An HP Jetdirect configuration page that contains network configuration
and status information should also print.

If it does not print, turn the product off, and then uninstall and reinstall the print server card to
ensure that it is completely seated in the slot.

8. Perform one of these steps:

● Choose the correct port. See the computer or operating system documentation for
instructions.

● Reinstall the software, choosing the network installation this time.

Clean the product
To clean the product exterior, use a soft, water-moistened cloth.

Clean the paper path

1. From the Home screen, touch the Device Maintenance button.

2. Open the following menus:

● Calibration/Cleaning

● Cleaning Page

3. Touch the Print button to print the page.

4. The cleaning process can take several minutes. When it is finished, discard the printed page.

Clean the scanner glass

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can
affect performance. Use the following procedure to clean the scanner glass and white plastic backing.
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1. Use the power switch to turn off the product,
and then unplug the power cord from the
electrical socket.

 

2. Open the scanner lid.  
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3. Clean the scanner glass and the white plastic
backing with a soft cloth or sponge that has
been moistened with nonabrasive glass
cleaner. Dry the glass and white plastic
backing with a chamois or a cellulose sponge
to prevent spotting.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

NOTE: Carefully clean the small glass strip
to the left of the scanner glass. Small marks on
this glass result in streaks on copies made from
the document feeder.

 

4. Plug in the product, and then use the power
switch to turn on the product.
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Product updates
HP regularly updates features that are available in the product firmware. To take advantage of the most
current features, update the product firmware. To download the most recent firmware upgrade, go to
www.hp.com/go/cljcm4540mfp_firmware.
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Self help
In addition to the information in this guide, other sources are available that provide helpful information.

Use the Control Panel poster This poster contains information on using the buttons and other features available
on the product control panel.

Quick Reference Topics Several Quick Reference Topics for this product are available at this Web site:
www.hp.com/support/cljcm4540mfp

You can print these topics and keep them near the product. They are a handy
reference for procedures that you perform frequently.

Quick Reference Guide This guide contains procedures for the most commonly used product functions. The
guide is available from this Web site: www.hp.com/support/cljcm4540mfp

You can print this guide and keep it near the product.

Control panel help The control panel has built-in help that guides you through several tasks, such as
replacing print cartridges and clearing jams. To open the Help system, touch the
Help button  in the upper-right corner of the screen.
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Solve problems checklist
Follow these steps when trying to solve a problem with the product.

1. Make sure the product Ready light is on. If no lights are on, complete these steps:

a. Check the power-cable connections.

b. Check that the power is turned on.

c. Make sure that the line voltage is correct for the product power configuration. (See the label
that is on the back of the product for voltage requirements.) If you are using a power strip
and its voltage is not within specifications, plug the product directly into the wall. If it is
already plugged into the wall, try a different outlet.

d. If none of these measures restores power, contact HP Customer Care.

2. Check the cabling.

a. Check the cable connection between the product and the computer or network port. Make
sure that the connection is secure.

b. Make sure that the cable itself is not faulty by using a different cable, if possible.

c. Check the network connection.

3. The control panel should indicate ready status. If an error message appears, resolve the error.

4. Ensure that the paper that you are using meets specifications.

5. Print a configuration page.

a. From the Home screen on the product control panel, open the following menus:

◦ Administration

◦ Reports

◦ Configuration/Status Pages

◦ Configuration Page

b. Touch the Print button.

If the pages do not print, check that at least one tray contains paper.

If the page jams in the product, follow the instructions on the control panel to clear the jam.

6. If the configuration page prints, check the following items:

a. If the page does not print correctly, the problem is with the product hardware. Contact
HP Customer Care.

b. If the page prints correctly, then the product hardware is working. The problem is with the
computer you are using, with the printer driver, or with the program.

7. Select one of the following options:
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Windows: Click Start, click Settings, and then click Printers or Printers and Faxes.
Double-click the name of the product.

-or-

Mac OS X: Open the Printer Setup Utility or the Print & Fax list, and double-click the line
for the product.

8. Verify that you have installed the printer driver for this product. Check the program to make sure
that you are using the printer driver for this product. The printer driver is on the CD that came with
the product. You can also download the printer driver from this Web site: www.hp.com/support/
cljcm4540mfp.

9. Print a short document from a different program that has worked in the past. If this solution works,
then the problem is with the program you are using. If this solution does not work (the document
does not print), complete these steps:

a. Try printing the job from another computer that has the product software installed.

b. If you connected the product to the network, connect the product directly to a computer with
a USB cable. Redirect the product to the correct port, or reinstall the software, selecting the
new connection type that you are using.

Factors that affect product performance

Several factors affect the time it takes to print a job:

● Maximum product speed, measured in pages per minute (ppm)

● The use of special paper (such as transparencies, heavy paper, and custom-size paper)

● Product processing and download time

● The complexity and size of graphics

● The speed of the computer you are using

● The USB connection

● The product I/O configuration

● The network operating system and configuration (if applicable)

● The printer driver that you are using
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Restore factory settings
1. From the Home screen, scroll to and touch the Administration menu.

2. Open the following menus:

● General Settings

● Restore Factory Settings

3. Select one or more categories of settings from the list, and then touch the Reset button.
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Interpret control-panel messages

Control-panel message types

Four types of control-panel messages can indicate the status of or problems with the product.

Message type Description

Status messages Status messages reflect the current state of the product. They inform you of normal product operation
and require no interaction to clear them. They change as the state of the product changes. Whenever
the product is ready, not busy, and has no pending warning messages, the Ready status message
appears if the product is online.

Warning messages Warning messages inform you of data and print errors. These messages typically alternate with the
Ready or status messages and remain until you touch the OK button. Some warning messages are
clearable. If the Clearable Warnings menu in the Display Settings menu is set to the Job option , the
next print job clears these messages.

Error messages Error messages communicate that some action must be performed, such as adding paper or clearing
a jam.

Some error messages are auto-continuable. If the Continuable Events menu in theDisplay Settings
menu is set to the Auto-Continue option, the product continues normal operation after an auto-
continuable error message appears for 10 seconds.

NOTE: Pressing any button during the 10-second auto-continuable error message overrides the
auto-continue feature, and the button function takes precedence. For example, pressing the Stop 
button pauses printing and offers the option to cancel the print job.

Critical-error messages Critical error messages inform you of a product failure. You can clear some of these messages by
turning the product off and then on. These messages are not affected by the Auto-Continue setting. If
a critical error persists, service is required.

Control-panel messages

The product provides robust control panel messaging. When a message appears on the control panel,
follow the on-screen instructions to resolve the issue. If the product displays an “Error” or “Attention”
message, and no steps are shown to resolve the issue, turn the product off then on. Contact HP support
if you continue to experience issues with the product.

To get additional information for warnings that appear in the status line, touch the Warning button .

For additional information on a variety of topics, touch the Help button  in the upper-right corner of
the home screen.
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Paper feeds incorrectly or becomes jammed
● The product does not pick up paper

● The product picks up multiple sheets of paper

● Prevent paper jams

● Clear jams

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

4. Check the product control panel to see if the product is waiting for you to acknowledge a prompt
to feed the paper manually. Load paper, and continue.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not
fan the paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

Prevent paper jams

To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

3. Use paper that has not previously been printed or copied on.
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4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

6. Make sure that the tray is fully inserted in the product.

7. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and
feed sheets one at a time.

Clear jams

Jam locations

Use this illustration to identify locations of jams. In addition, instructions appear on the control panel to
direct you to the location of jammed paper and how to clear it.

NOTE: Internal areas of the product that might need to be opened to clear jams have green handles
or green labels.

WARNING! To avoid electrical shock, remove any necklaces, bracelets, or other metal items before
reaching into the inside of the product.

Figure 14-1  Jam locations

1

3

4

6
7

8

5

2

1 Document feeder

2 Top cover

3 Right door

4 Tray 1 area
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6 Lower-right door
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7 Stapler

8 Output bins
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Clear jams in the document feeder

1. Open the document feeder cover.  

2. Lift the jam-access door, and remove any
jammed paper.

 

3. Close the document feeder cover.  
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Clear paper jams in the stapler

1. Lift the gray latch on the front of the stapler,
and open the stapler cover.

 

2. If jammed paper is visible underneath the
paper guide, pull it straight out.

 

ENWW Paper feeds incorrectly or becomes jammed 293



3. Lift the green jam-access door. If jammed
paper is visible under the jam-access door, pull
it straight out,

 

4. Close the stapler cover.  

Clear staple jams

1. Lift the gray latch on the front of the stapler,
and open the stapler cover.
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2. Lift the green tab on the staple cartridge up,
and then pull the staple cartridge straight out.

 

3. Lift up on the small lever at the back of the
staple cartridge.

 

4. Remove the jammed staples.  

5. Close the lever at the back of the staple
cartridge. Be sure that it snaps into place.
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6. Insert the staple cartridge into the stapler and
push down on the green handle until it snaps
into place.

 

7. Close the stapler cover.  
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Clear jams in the output bin area

1. If paper is visible from the output bin, grasp
the leading edge and remove it.

 

Clear jams from under the top cover

1. Pull the top-cover-release lever forward, and
then lift the top cover up.
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2. Remove any jammed sheets that are under the
top cover.

CAUTION: Do not touch the foam rollers
that are under the top cover. Contaminants
can affect print quality.

 

3. Close the top cover.  

298 Chapter 14   Solve problems ENWW



Clear jams in the right door

CAUTION: The fuser can be hot while the product is in use. Wait for the fuser to cool before
handling it.

1. Open the right door.  

2. Gently pull the paper out of the pickup area.  

3. If paper is visible entering the bottom of the
fuser, gently pull downward to remove it.

CAUTION: Do not touch the rollers on the
transfer roller. Contaminants can affect print
quality.
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4. If paper is jammed as it enters the output bin,
remove the fuser and gently pull the paper
downward to remove it.

 

5. Paper could be jammed inside the fuser where
it would not be visible. Grasp the fuser
handles, lift up slightly, and then pull straight
out to remove the fuser.

CAUTION: The fuser can be hot while the
product is in use. Wait for the fuser to cool
before handling it.

 

6. Open the jam-access door. If paper is jammed
inside the fuser, gently pull it straight up to
remove it. If the paper tears, remove all paper
fragments.

CAUTION: Even if the body of the fuser has
cooled, the rollers that are inside could still be
hot. Do not touch the fuser rollers until they
have cooled.
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7. Close the jam-access door, and push the fuser
completely into the product.

 

8. Close the right door.  
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Clear jams in Tray 1

1. If jammed paper is visible in Tray 1, clear the
jam by gently pulling the paper straight out.
Touch the OK button to clear the message.

 

2. If you cannot remove the paper, or if no
jammed paper is visible in Tray 1, close Tray
1 and open the right door.
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3. Gently pull the paper out of the pick up area.  

4. Close the right door.  
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Clear jams in Trays 2, 3, 4, or 5

CAUTION: Opening a tray when paper is jammed can cause the paper to tear and leave pieces of
paper in the tray, which might cause another jam. Be sure to clear jams before opening the tray.

1. Open the tray and make sure that the paper is
stacked correctly. Remove any jammed or
damaged sheets of paper. To access jammed
paper from the tray cavity, remove the tray
from the product.

 

2. Close the tray.  
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Clear jams in the lower-right door (Trays 3, 4, or 5)

1. Open the lower-right door.  

2. If paper is visible, gently pull the jammed
paper up or down to remove it.

 

3. Close the lower-right door.  
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Change jam recovery

This product provides a jam recovery feature that reprints jammed pages.

1. From the Home screen, scroll to and touch the
Administration button.

 

2. Open the General Settings menu, and then
open the Jam Recovery menu.

 

3. Select one of the following options:

● Auto — The product attempts to reprint
jammed pages when sufficient memory is
available. This is the default setting.

● Off — The product does not attempt to
reprint jammed pages. Because no
memory is used to store the most recent
pages, performance is optimal.

NOTE: When using this option, if the
product runs out of paper and the job is
being printed on both sides, some pages
can be lost.

● On — The product always reprints
jammed pages. Additional memory is
allocated to store the last few pages
printed. This might cause overall
performance to suffer.
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Improve print quality
You can prevent most print-quality problems by following these guidelines.

● Use the correct paper type setting in the printer driver.

● Use paper that meets HP specifications for this product.

● Clean the product as necessary.

● Replace print cartridges when they are reaching the end of their estimated life and print quality is
no longer acceptable.

● Use the printer driver that best meets your printing needs.

Select a paper type

1. Open the printer driver, click the Properties or Preferences button, and then click the Paper/
Quality tab.

2. Select a type from the Type is drop-down list.

3. Click the OK button.

Use paper that meets HP specifications

Use different paper if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Printed characters seem misformed.

● Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines
when selecting paper:

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust,
wrinkles, voids, staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that is designed for use in laser printers. Do not use paper that is designed only for use
in Inkjet printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.
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Print a cleaning page

Print a cleaning page to remove dust and excess toner from the paper path if you are having any of the
following problems:

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

Use the following procedure to print a cleaning page.

1. From the Home screen, touch the Device Maintenance button.

2. Open the following menus:

● Calibration/Cleaning

● Cleaning Page

3. Touch the Print button to print the page.

4. The cleaning process can take several minutes. When it is finished, discard the printed page.

Calibrate the product

Calibration is a product function that optimizes print quality. If you experience any image-quality
problems, calibrate the product.

1. From the Home screen, touch the Device Maintenance button.

2. Open the following menus:

● Calibration/Cleaning

● Full Calibration

3. Wait while the product calibrates, and then try printing again.

Set the image registration

If you are having problems with text aligning on the page, use the Set Registration menu to set the
image registration.

1. From the Home screen, touch the Administration button.

2. Open the following menus:

a. General Settings

b. Print Quality

c. Image Registration

d. Adjust Tray <X>
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3. Touch the Print Test Page setting, and then touch the OK button.

4. Follow the instructions on the test page to complete the adjustment.

Internal print-quality-test pages

Use the built-in print-quality-troubleshooting pages to help diagnose and solve print-quality problems.

1. From the Home screen, touch the Administration button.

2. Open the following menus:

● Troubleshooting

● Print Quality Pages

● PQ Troubleshooting Pages

3. Touch the Print button. Follow the instructions on the pages that print.

Check the print cartridge

Check each print cartridge, and replace it if necessary, if you are having any of the following
problems:

● The printing is too light or seems faded in areas.

● Printed pages have small unprinted areas.

● Printed pages have streaks or bands.

NOTE: If you are using a draft or EconoMode print setting, the printing might appear light.

If you determine that you need to replace a print cartridge, print the supplies status page to find the
part number for the correct genuine HP print cartridge.

Type of print cartridge Steps to resolve the problem

Refilled or remanufactured print
cartridge

Hewlett-Packard Company cannot recommend the use of non-HP supplies, either
new or remanufactured. Because they are not HP products, HP cannot influence
their design or control their quality. If you are using a refilled or remanufactured
print cartridge and are not satisfied with the print quality, replace the cartridge with
a genuine HP cartridge that has the words “HP” or “Hewlett-Packard” on it, or has
the HP logo on it.

Genuine HP print cartridge 1. The product control panel or the supplies status page indicates Very Low
status when the cartridge has reached the end of its designated life. Replace
the print cartridge if print quality is no longer acceptable.

2. Visually inspect the print cartridge for damage. See the instructions that follow.
Replace the print cartridge if necessary.

3. If printed pages have marks that repeat several times at the same distance
apart, print a cleaning page. If this does not solve the problem, use the
repeating defects information in this document to identify the cause of the
problem.
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Use the printer driver that best meets your printing needs

You might need to use a different printer driver if the printed page has unexpected lines in graphics,
missing text, missing graphics, incorrect formatting, or substituted fonts.

HP PCL 6 driver ● Provided as the default driver. This driver is automatically installed unless you
select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other
highly graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript
flash font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single
driver for use with multiple printer models

● Preferred when printing to multiple printer models from a mobile Windows
computer

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for
most users

● Developed to align with Windows Graphic Device Interface (GDI) for best
speed in Windows environments

● May not be fully compatible with third-party and custom solutions based on
PCL5

Download additional printer drivers from this Web site: www.hp.com/go/cljcm4540mfp_software.
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Improve print quality for copies

If you encounter print quality problems in copied documents, review the solutions for printed documents
listed previously in this document. However, some print-quality problems occur only in copied
documents.

● If streaks appear on copies made by using the document feeder, clean the small glass strip on the
left side of the scanner assembly.

● If dots or other defects appear on copies made by using the scanner glass, clean the scanner glass
and the white plastic backing.

1. Use the power switch to turn off the product, and then unplug the power cord from the electrical
socket.

2. Open the scanner lid.

3. Clean the scanner glass and the white plastic backing with a soft cloth or sponge that has been
moistened with nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these can damage the product. Do not place liquids
directly on the glass or platen. They might seep and damage the product.

4. Dry the glass and white plastic backing with a chamois or a cellulose sponge to prevent spotting.

5. Plug in the product, and then use the power switch to turn on the product.
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The product does not print or it prints slowly

The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.

◦ If the control panel does not indicate the product is ready, turn the product off and then on
again.

◦ If the control panel indicates the product is ready, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try sending the
job again.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check
the following items:

◦ Check the light next to the network connection on the product. If the network is active, the
light is green.

◦ Make sure that you are using a network cable and not a phone cord to connect to the
network.

◦ Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product. Using generic printer drivers can
cause delays clearing jobs from the print queue.

5. From the list of printers on your computer, right-click the name of this product, click Properties,
and open the Ports tab.

◦ If you are using a network cable to connect to the network, make sure the printer name listed
on the Ports tab matches the product name on the product configuration page.

◦ If you are using a USB cable and are connecting to a wireless network, make sure the box is
checked next to Virtual printer port for USB.

6. If you are using a personal firewall system on the computer, it might be blocking communication
with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

7. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.
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The product prints slowly

If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of
specifications, go to this Web site: www.hp.com/support/cljcm4540mfp.

2. When you configure the product to print on some paper types, such as heavy paper, the product
prints more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not
correct for the type of paper you are using, change the setting to the correct paper type.

3. If your computer is connected to a wireless network, low signal quality or interference might be
delaying print jobs.
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Solve walk-up USB printing problems
● The Open from USB menu does not open when you insert the USB accessory

● The file does not print from the USB storage accessory

● The file that you want to print is not listed in the Open from USB menu

The Open from USB menu does not open when you insert the USB
accessory

1. You might be using a USB storage accessory or a file system that this product does not support.
Save the files on a standard USB storage accessory that uses File Allocation Table (FAT) file
systems. The product supports FAT12, FAT16, and FAT32 USB storage accessories.

2. If another menu is already open, close that menu and then reinsert the USB storage accessory.

3. The USB storage accessory might have multiple partitions. (Some USB storage accessory
manufacturers install software on the accessory that creates partitions, similar to a CD.) Reformat
the USB storage accessory to remove the partitions, or use a different USB storage accessory.

4. The USB storage accessory might require more power than the product can provide.

a. Remove the USB storage accessory.

b. Turn the product off and then on.

c. Use a USB storage accessory that has its own power supply or that requires less power.

5. The USB storage accessory might not be functioning correctly.

a. Remove the USB storage accessory.

b. Turn the product off and then on.

c. Try printing from another USB storage accessory.

The file does not print from the USB storage accessory

1. Make sure paper is in the tray.

2. Check the control panel for messages. If paper is jammed in the product, clear the jam.
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The file that you want to print is not listed in the Open from USB
menu

1. You might be trying to print a file type that the USB printing feature does not support. The product
supports .pdf, .prn, .pcl, .ps, and .cht file types.

2. You might have too many files in a single folder on the USB storage accessory. Reduce the
number of files in the folder by moving them to subfolders.

3. You might be using a character set for the file name that the product does not support. In this case,
the product replaces the file names with characters from a different character set. Rename the files
using ASCII characters.
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Solve connectivity problems 

Solve direct-connect problems

If you have connected the product directly to a computer, check the cable.

● Verify that the cable is connected to the computer and to the product.

● Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.

● Verify that the cable is working correctly by connecting it to another product. Replace the cable if
necessary.

Solve network problems

Check the following items to verify that the product is communicating with the network. Before
beginning, print a configuration page from the product control panel and locate the product IP address
that is listed on this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

Poor physical connection

1. Verify that the product is attached to the correct network port using a cable of the correct length.

2. Verify that cable connections are secure.

3. Look at the network port connection on the back of the product, and verify that the amber activity
light and the green link-status light are lit.

4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product

1. Open the printer properties and click the Ports tab. Verify that the current IP address for the
product is selected. The product IP address is listed on the product configuration page.

2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always
print to this printer, even if its IP address changes.
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3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of
the IP address.

4. If the IP address is correct, delete the product and then add it again.

The computer is unable to communicate with the product

1. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the IP address for your product.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network
settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network

Hewlett-Packard recommends leaving this setting in automatic mode (the default setting). If you change
these settings, you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct printer
driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, printer drivers, and the network redirection.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.
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Solve product software problems with Windows

Problem Solution

A printer driver for the product is
not visible in the Printer folder

Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the system
tray, right-click the icon, and select Close or Disable.

 Try plugging the USB cable into a different USB port on the computer.

An error message was displayed
during the software installation

Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the task
bar, right-click the icon, and select Close or Disable.

 Check the amount of free space on the drive where you are installing the product software. If necessary,
free up as much space as you can, and reinstall the product software.

 If necessary, run the Disk Defragmenter, and reinstall the product software.

The product is in Ready mode,
but nothing prints

Print a Configuration page, and verify the product functionality.

 Verify that all of the cables are correctly seated and within specifications. This includes the USB and
power cables. Try a new cable.

 Verify the IP Address on the Embedded Jetdirect Page matches the IP address for the software port. Use
one of the following procedures:

 Windows XP, Windows Server
2003, Windows Server 2008,
and Windows Vista

1. Click Start.

2. Click Settings.

3. Click Printers and Faxes (using the default Start menu view)
or click Printers (using the Classic Start menu view).

4. Right-click the product driver icon, and then select Properties.

5. Click the Ports tab, and then click Configure Port.

6. Verify the IP address, and then click OK or Cancel.

7. If the IP Addresses are not the same, delete the driver, and
reinstall the driver using the correct IP address.

 Windows 7 1. Click Start.

2. Click Devices and Printers.

3. Right-click the product driver icon, and then select Printer
properties.

4. Click the Ports tab, and then click Configure Port.

5. Verify the IP address, and then click OK or Cancel.

6. If the IP Addresses are not the same, delete the driver, and
reinstall the driver using the correct IP address.
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Solve product software problems with Mac
● The printer driver is not listed in the Print & Fax list

● The product name does not appear in the product list in the Print & Fax list

● The printer driver does not automatically set up the selected product in the Print & Fax list

● A print job was not sent to the product that you wanted

● When connected with a USB cable, the product does not appear in the Print & Fax list after the
driver is selected.

● You are using a generic printer driver when using a USB connection

The printer driver is not listed in the Print & Fax list

1. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

2. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

The product name does not appear in the product list in the Print &
Fax list

1. Make sure that the cables are connected correctly and the product is on.

2. Print a configuration page to check the product name. Verify that the name on the configuration
page matches the product name in the Print & Fax list.

3. Replace the USB or network cable with a high-quality cable.

The printer driver does not automatically set up the selected
product in the Print & Fax list

1. Make sure that the cables are connected correctly and the product is on.

2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

3. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

4. Replace the USB or network cable with a high-quality cable.
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A print job was not sent to the product that you wanted

1. Open the print queue and restart the print job.

2. Another product with the same or similar name might have received your print job. Print a
configuration page to check the product name. Verify that the name on the configuration page
matches the product name in the Print & Fax list.

When connected with a USB cable, the product does not appear in
the Print & Fax list after the driver is selected.

Software troubleshooting

▲ Make sure that your Mac operating system is Mac OS X 10.5 or later.

Hardware troubleshooting

1. Make sure that the product is turned on.

2. Make sure that the USB cable is connected correctly.

3. Make sure that you are using the appropriate high-speed USB cable.

4. Make sure that you do not have too many USB devices drawing power from the chain. Disconnect
all of the devices from the chain, and connect the cable directly to the USB port on the computer

5. Check to see if more than two non-powered USB hubs are connected in a row on the chain.
Disconnect all of the devices from the chain, and then connect the cable directly to the USB port
on the computer.

NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic printer driver when using a USB
connection

If you connected the USB cable before you installed the software, you might be using a generic printer
driver instead of the driver for this product.

1. Delete the generic printer driver.

2. Reinstall the software from the product CD. Do not connect the USB cable until the software
installation program prompts you.

3. If multiple printers are installed, make sure that you have selected the correct printer in the
Format For drop-down menu in the Print dialog box.
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A Product supplies and accessories

● Order parts, accessories, and supplies

● Part numbers
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Order parts, accessories, and supplies

Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Order using HP software Use the HP Embedded Web Server on page 266
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Part numbers

Accessories

Item Description Product number

HP Color LaserJet  500-sheet Paper
Feeder and Cabinet

500-sheet paper tray with a storage
cabinet.

CC422A

HP Color LaserJet  3 x 500-sheet Paper
Feeder and Stand

1500-sheet paper tray. Contains three
500-sheet trays and a stand.

CC423A

HP LaserJet 900-sheet 3-bin Stapling
Mailbox

Stapler with a 3-bin output mailbox that
holds up to 900 sheets.

CC424A

HP Color LaserJet 500-sheet Paper
Feeder

500-sheet input tray (no storage cabinet
or stand)

CC425A

HP LaserJet MFP Analog Fax Accessory
500

Provides fax capability for the product.
This is included with the CM4540f MFP
and CM4540fskm MFP models.

CC487A

Cables and interfaces

Item Description Product number

Enhanced I/O (EIO) card HP Jetdirect 635n IPv6/IPsec Print
Server

J7961G

USB cable 2-meter standard USB-compatible device
connector

C6518A

Customer self-repair parts
The following Customer Self-Repair parts are available for your product.

● Parts listed as Mandatory self-replacement are to be installed by customers, unless you are
willing to pay HP service personnel to perform the repair. For these parts, on-site or return-to-depot
support is not provided under your HP product warranty.

● Parts listed as Optional self-replacement may be installed by HP service personnel at your
request for no additional charge during the product warranty period.

NOTE: For more information, go to www.hp.com/go/learnaboutsupplies.

Table A-1  Customer self-repair parts

Item Description Self-replacement
options

Product number Part number

HP Color LaserJet black
print cartridge

Standard black cartridge Mandatory CE260A CE260-67901
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Table A-1  Customer self-repair parts (continued)

Item Description Self-replacement
options

Product number Part number

HP Color LaserJet black
print cartridge

High-capacity black
cartridge

Mandatory CE264X CE264-67901

HP Color LaserJet cyan
print cartridge

Cyan cartridge Mandatory CF031A CF031-67901

HP Color LaserJet yellow
print cartridge

Yellow cartridge Mandatory CF032A CF032-67901

HP Color LaserJet
magenta print cartridge

Magenta cartridge Mandatory CF033A CF033-67901

HP Color LaserJet Toner
Collection Unit

Receptacle for toner that
has not fused to the
paper.

Mandatory CE265A CC493-67913

HP Staple cartridge Replacement staple
cartridge, which holds
5,000 staples

Mandatory C8091A

HP Color LaserJet fuser kit Replacement fuser Mandatory 110 Volt fuser: CE246A

200 Volt fuser: CE247A

110 Volt fuser:
CC493-67911

200 Volt fuser:
CC493-67912

Fuser cleaning kit Includes 50 sheets of HP
LaserJet Tough Paper and
instructions to clean the
fuser

Mandatory  CC419-67905

Document feeder
maintenance kit

Includes a replacement
roller assembly and
separation pad for the
document feeder

Mandatory CE248A CE248-67901

HP Color LaserJet image
transfer kit

Replacement transfer unit,
transfer roller, Tray 1
pickup roller, and eight
feed and separation
rollers for Trays 2-5.

Mandatory CE249A CC493-67910

Repair maintenance kit Replacement transfer unit
and transfer roller

Mandatory  CC493-67909

Control panel kit Replacement control
panel

Optional  CC419-67901

HP LaserJet 900-sheet 3-
bin Stapling Mailbox

Replacement stapler/
stacker

Mandatory CC424A CC424-67901

HP Color LaserJet 500-
sheet Paper Feeder

500-sheet input tray (no
storage cabinet or stand)

Mandatory CC425A CC425-67901

HP Color LaserJet  500-
sheet Paper Feeder and
Cabinet

500-sheet paper tray with
a storage cabinet

Mandatory CC422A CC493-67902
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Table A-1  Customer self-repair parts (continued)

Item Description Self-replacement
options

Product number Part number

HP Color LaserJet  3 x
500-sheet Paper Feeder
and Stand

1500-sheet paper tray.
Contains three 500-sheet
trays and a stand.

Mandatory CC423A CC493-67903

HP LaserJet MFP Analog
Fax Accessory 500

Provides fax capability for
the product. This is
included with the
CM4540f MFP and
CM4540fskm MFP
models.

Mandatory CC487A CC456-60002

Feed roller and
separation roller kit for
Trays 2–5

One feed roller and eight
separation rollers

Mandatory  CC493-67907

Tray 1 roller kit Pickup roller for Tray 1 Mandatory  CC493-67906

Formatter assembly kit Replacement formatter
(requires you to exchange
the previous formatter)

Mandatory  CE871-69001

Internal hard disk
assembly kit

Replacement
HP Encrypted High
Performance Hard Disk

Mandatory  CC419-67902

Output bin bezel Replacement bezel for
using the standard output
bin

Mandatory  CC419-67904

Document feeder bin
extension

Replacement long-paper
extension for the
document feeder output
bin

Mandatory  CC419-67903

Secondary transfer roller
kit

Replacement roller Mandatory  CC493-67908

Document feeder feed
roller

Replacement roller Mandatory  PF2309K131NI

Document feeder pickup
roller

Replacement roller Mandatory  PF2309K132NI

Document feeder
separation pad

Replacement separation
pad

Mandatory  PF2309K133NI

Document feeder
separation pad spring

Replacement spring Mandatory  PF2309P322NI

Tray 2, 3, 4, or 5 Replacement paper
cassette

Mandatory  RM1-5928-000CN

Pickup roller for Trays 2–
5

Replacement roller Mandatory  RL1-2099-000CN
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Hewlett-Packard limited warranty statement

HP PRODUCT DURATION OF LIMITED WARRANTY

HP Color LaserJet CM4540, CM4540f, CM4540fskm One-year on-site warranty

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects
in materials and workmanship after the date of purchase, for the period specified above. If HP receives
notice of such defects during the warranty period, HP will, at its option, either repair or replace
products which prove to be defective. Replacement products may be either new or equivalent in
performance to new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date
of purchase, for the period specified above, due to defects in material and workmanship when
properly installed and used. If HP receives notice of such defects during the warranty period, HP will
replace software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is
unable, within a reasonable time, to repair or replace any product to a condition as warranted, you
will be entitled to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been
subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or
calibration, (b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized
modification or misuse, (d) operation outside of the published environmental specifications for the
product, or (e) improper site preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED
AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE. Some
countries/regions, states or provinces do not allow limitations on the duration of an implied warranty,
so the above limitation or exclusion might not apply to you. This warranty gives you specific legal rights
and you might also have other rights that vary from country/region to country/region, state to state, or
province to province.

HP's limited warranty is valid in any country/region or locality where HP has a support presence for
this product and where HP has marketed this product. The level of warranty service you receive may
vary according to local standards. HP will not alter form, fit or function of the product to make it
operate in a country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT ARE
YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP OR
ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL,
CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED
IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or provinces do not allow the
exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may
not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE
MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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HP's Premium Protection Warranty: LaserJet print
cartridge limited warranty statement

This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or
tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the printer product or (c) exhibit
wear from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description of
the problem and print samples) or contact HP customer support. At HP's option, HP will either replace
products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED
AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE
FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR
OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE
MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Color LaserJet Fuser Kit, Transfer Kit, and Roller Kit
Limited Warranty Statement

This HP product is warranted to be free from defects in materials and workmanship until the printer
provides a low-life indicator on the control panel.

This warranty does not apply to products that (a) have been refurbished, remanufactured or tampered
with in any way, (b) experience problems resulting from misuse, improper storage, or operation outside
of the published environmental specifications for the printer product or (c) exhibit wear from ordinary
use.

To obtain warranty service, please return the product to place of purchase (with a written description of
the problem) or contact HP customer support. At HP’s option, HP will either replace products that prove
to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED
AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE
FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR
OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE
MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Data stored on the print cartridge
The HP print cartridges used with this product contain a memory chip that assists in the operation of the
product.

In addition, this memory chip collects a limited set of information about the usage of the product, which
might include the following: the date when the print cartridge was first installed, the date when the print
cartridge was last used, the number of pages printed using the print cartridge, the page coverage, the
printing modes used, any printing errors that might have occurred, and the product model. This
information helps HP design future products to meet our customers' printing needs.

The data collected from the print cartridge memory chip does not contain information that can be used
to identify a customer or user of the print cartridge or their product.

HP collects a sampling of the memory chips from print cartridges returned to HP's free return and
recycling program (HP Planet Partners: www.hp.com/recycle). The memory chips from this sampling
are read and studied in order to improve future HP products. HP partners who assist in recycling this
print cartridge might have access to this data, as well.

Any third party possessing the print cartridge might have access to the anonymous information on the
memory chip. If you prefer to not allow access to this information, you can render the chip inoperable.
However, after you render the memory chip inoperable, the memory chip cannot be used in an HP
product.
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End User License Agreement
PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User License
Agreement (“EULA”) is a contract between (a) you (either an individual or the entity you represent) and
(b) Hewlett-Packard Company (“HP”) that governs your use of the software product (“Software”). This
EULA does not apply if there is a separate license agreement between you and HP or its suppliers for
the Software, including a license agreement in online documentation. The term “Software” may include
(i) associated media, (ii) a user guide and other printed materials, and (iii) “online” or electronic
documentation (collectively “User Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO ALL
TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING, OR
OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU DO NOT
ACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE SOFTWARE. IF
YOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA, PLEASE RETURN THE
SOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN DAYS FOR A REFUND OF THE
PURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR MADE AVAILABLE WITH ANOTHER
HP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software (“HP
Software”), software under licenses from third parties (“Third Party Software” and “Third Party
License”). Any Third Party Software is licensed to you subject to the terms and conditions of the
corresponding Third Party License. Generally, the Third Party License is in a file such as
“license.txt” or a “readme” file. You should contact HP support if you cannot find a Third Party
License. If the Third Party Licenses include licenses that provide for the availability of source code
(such as the GNU General Public License) and the corresponding source code is not included with
the Software, then check the product support pages of HP's website (hp.com) to learn how to
obtain such source code.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and
conditions of this EULA:

a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing,
copying, storing, loading, executing, displaying, or otherwise using the HP Software. You
may not modify the HP Software or disable any licensing or control feature of the
HP Software. If this Software is provided by HP for Use with an imaging or printing product
(for example, if the Software is a printer driver, firmware, or add-on), the HP Software may
only be used with such product (“HP Product”). Additional restrictions on Use may appear in
the User Documentation. You may not separate component parts of the HP Software for Use.
You do not have the right to distribute the HP Software.

b. Copying. Your right to copy means you may make archival or back-up copies of the
HP Software, provided each copy contains all the original HP Software’s proprietary notices
and is used only for back-up purposes.

3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement
(collectively “Upgrade”), you must first be licensed for the original HP Software identified by HP as
eligible for the Upgrade. To the extent the Upgrade supersedes the original HP Software, you may
no longer use such HP Software. This EULA applies to each Upgrade unless HP provides other
terms with the Upgrade. In case of a conflict between this EULA and such other terms, the other
terms will prevail.
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4. TRANSFER.

a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer of
the HP Software to another end user. Any transfer will include all component parts, media,
User Documentation, this EULA, and if applicable, the Certificate of Authenticity. The transfer
may not be an indirect transfer, such as a consignment. Prior to the transfer, the end user
receiving the transferred Software will agree to this EULA. Upon transfer of the HP Software,
your license is automatically terminated.

b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for
commercial timesharing or bureau use. You may not sublicense, assign or otherwise transfer
the HP Software except as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User Documentation are
owned by HP or its suppliers and are protected by law, including applicable copyright, trade
secret, patent, and trademark laws. You will not remove any product identification, copyright
notice, or proprietary restriction from the Software.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or
disassemble the HP Software, except and only to the extent that the right to do so is allowed under
applicable law.

7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information you
provide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of support
services related to the Software or the HP Product. All such information will be subject to HP’s
privacy policy. HP will not use such information in a form that personally identifies you except to
the extent necessary to enhance your Use or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire liability
of HP and its suppliers under this EULA and your exclusive remedy under this EULA will be limited
to the greater of the amount actually paid by you for the Product or U.S. $5.00. TO THE
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS
BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES
(INCLUDING DAMAGES FOR LOST PROFITS, LOST DATA, BUSINESS INTERRUPTION,
PERSONAL INJURY, OR LOSS OF PRIVACY) RELATED IN ANY WAY TO THE USE OF OR
INABILITY TO USE THE SOFTWARE, EVEN IF HP OR ANY SUPPLIER HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES AND EVEN IF THE ABOVE REMEDY FAILS OF ITS ESSENTIAL
PURPOSE. Some states or other jurisdictions do not allow the exclusion or limitation of incidental
or consequential damages, so the above limitation or exclusion may not apply to you.

9. U.S. GOVERNMENT CUSTOMERS. Software was developed entirely at private expense. All
Software is commercial computer software within the meaning of the applicable acquisition
regulations. Accordingly, pursuant to US FAR 48 CFR 12.212 and DFAR 48 CFR 227.7202, use,
duplication and disclosure of the Software by or for the U.S. Government or a U.S. Government
subcontractor is subject solely to the terms and conditions set forth in this End User License
Agreement, except for provisions which are contrary to applicable mandatory federal laws.

10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i)
applicable to the export or import of the Software, or (ii) restricting the Use of the Software,
including any restrictions on nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to you in
this EULA.

© 2009 Hewlett-Packard Development Company, L.P.

Rev. 04/09
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OpenSSL
This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).
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Customer self-repair warranty service
HP products are designed with many Customer Self Repair (CSR) parts to minimize repair time and
allow for greater flexibility in performing defective parts replacement. If during the diagnosis period,
HP identifies that the repair can be accomplished by the use of a CSR part, HP will ship that part
directly to you for replacement. There are two categories of CSR parts: 1) Parts for which customer self
repair is mandatory. If you request HP to replace these parts, you will be charged for the travel and
labor costs of this service. 2) Parts for which customer self repair is optional. These parts are also
designed for Customer Self Repair. If, however, you require that HP replace them for you, this may be
done at no additional charge under the type of warranty service designated for your product.

Based on availability and where geography permits, CSR parts will be shipped for next business day
delivery. Same-day or four-hour delivery may be offered at an additional charge where geography
permits. If assistance is required, you can call the HP Technical Support Center and a technician will
help you over the phone. HP specifies in the materials shipped with a replacement CSR part whether a
defective part must be returned to HP. In cases where it is required to return the defective part to HP,
you must ship the defective part back to HP within a defined period of time, normally five (5) business
days. The defective part must be returned with the associated documentation in the provided shipping
material. Failure to return the defective part may result in HP billing you for the replacement. With a
customer self repair, HP will pay all shipping and part return costs and determine the courier/carrier to
be used.
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Customer support

Get telephone support for your country/region

Have the product name, serial number, date of purchase, and
problem description ready.

Country/region phone numbers are on the flyer that was in
the box with your product or at www.hp.com/support/.

Get 24-hour Internet support www.hp.com/support/cljcm4540mfp

Get support for products used with a Macintosh computer www.hp.com/go/macosx

Download software utilities, drivers, and electronic
information

www.hp.com/go/cljcm4540mfp_software

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Register your product www.register.hp.com
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C Product specifications

● Physical specifications

● Power consumption, electrical specifications, and acoustic emissions

● Environmental specifications
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Physical specifications
Table C-1  Product dimensions

Product Height Depth Width Weight

CM4540 MFP 575 mm (22.6 in) 617 mm (24.3 in) 827 mm (32.5 in) 54.8 kg (120.5 lb)

CM4540f MFP 1119 mm (44.1 in) 668 mm (26.3 in) 849 mm (33.4 in) 75.7 kg (166.5 lb)

CM4540fskm MFP 1119 mm (44.1 in) 668 mm (26.3 in) 1012 mm (39.8 in) 88.6 kg (195.0 lb)

Power consumption, electrical specifications, and
acoustic emissions

See www.hp.com/go/cljcm4540mfp_regulatory for current information.

CAUTION: Power requirements are based on the country/region where the product is sold. Do not
convert operating voltages. This will damage the product and void the product warranty.

Environmental specifications

Environmental condition Recommended Allowed

Temperature (product and print
cartridge)

17° to 27°C (62.6° to 80.6°F) 10° to 30°C (50° to 86°F)

Relative humidity 30% to 70% relative humidity (RH) 10% to 80% RH

Altitude N/A 0 m (0 ft) to 3000 m (9842 ft)
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D Regulatory information

● FCC regulations

● Environmental product stewardship program

● Declaration of Conformity

● Declaration of Conformity (fax models)

● Safety statements

● Additional statements for telecom (fax) products
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FCC regulations
This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy, and if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this equipment in a
residential area is likely to cause harmful interference in which case the user will be required to correct
the interference at his own expense.

NOTE: Any changes or modifications to the printer that are not expressly approved by HP could void
the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class A limits of Part 15 of FCC rules.
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Environmental product stewardship program

Protecting the environment
Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our
environment.

Ozone production
This product generates no appreciable ozone gas (O3).

Power consumption
Power usage drops significantly while in Ready and Sleep mode, which saves natural resources and
saves money without affecting the high performance of this product. To determine the ENERGY STAR®
qualification status for this product, see the Product Data Sheet or Specifications Sheet. Qualified
products are also listed at:

www.hp.com/go/energystar

Paper use
This product’s optional automatic duplex feature (two-sided printing) and N-up printing (multiple pages
printed on one page) capability can reduce paper usage and the resulting demands on natural
resources.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies
It’s easy to return and recycle your HP LaserJet print cartridges after use—free of charge—with
HP Planet Partners. Multilingual program information and instructions are included in every new
HP LaserJet print cartridge and supplies package. You help reduce the toll on the environment further
when you return multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled
properly, processing them to recover plastics and metals for new products and diverting millions of tons
of waste from landfills. Since this cartridge is being recycled and used in new materials, it will not be
returned to you. Thank you for being environmentally responsible!

NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use this
label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty
returns. For information about recycling your HP inkjet cartridges please go to http://www.hp.com/
recycle.

ENWW Environmental product stewardship program 341

http://www.hp.com/go/energystar
http://www.hp.com/recycle
http://www.hp.com/recycle


Return and recycling instructions

United States and Puerto Rico

The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more
HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Multiple returns (more than one cartridge)

1. Package each HP LaserJet print cartridge in its original box and bag.

2. Tape the boxes together using strapping or packaging tape. The package can weigh up to 31 kg
(70 lb).

3. Use a single pre-paid shipping label.

OR

1. Use your own suitable box, or request a free bulk collection box from www.hp.com/recycle or
1-800-340-2445 (holds up to 31 kg (70 lb) of HP LaserJet print cartridges).

2. Use a single pre-paid shipping label.

Single returns

1. Package the HP LaserJet print cartridge in its original bag and box.

2. Place the shipping label on the front of the box.

Shipping

For US and Puerto Rico HP LaserJet print cartridge recycling returns, use the pre-paid, pre-addressed
shipping label contained in the box. To use the UPS label, give the package to the UPS driver during
your next delivery or pick-up, or take it to an authorized UPS drop-off center. (Requested UPS Ground
pickup will be charged normal pick-up rates) For the location of your local UPS drop-off center, call
1-800-PICKUPS or visit www.ups.com.

If you are returning the package with the FedEx label, give the package to either the U.S. Postal Service
carrier or FedEx driver during your next pick-up or delivery. (Requested FedEx Ground pickup will be
charged normal pick-up rates). Or, you can drop off your packaged print cartridge(s) at any U.S. Post
Office or any FedEx shipping center or store. For the location of your nearest U.S. Post Office, please
call 1-800-ASK-USPS or visit www.usps.com. For the location of your nearest FedEx shipping center/
store, please call 1-800-GOFEDEX or visit www.fedex.com.

For more information, or to order additional labels or boxes for bulk returns, visit www.hp.com/recycle
or call 1-800-340-2445. Information subject to change without notice.

Residents of Alaska and Hawaii

Do not use the UPS label. Call 1-800-340-2445 for information and instructions. The U.S. Postal
Service provides no-cost cartridge return transportation services under an arrangement with HP for
Alaska and Hawaii.
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Non-U.S. returns

To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new product supply item) or visit
www.hp.com/recycle. Select your country/region for information on how to return your HP LaserJet
printing supplies.

Paper
This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.

Material restrictions
This HP product does not contain added mercury.

This HP product contains a battery that might require special handling at end-of-life. The batteries
contained in or supplied by Hewlett-Packard for this product include the following:

HP Color LaserJet Enterprise CM4540 MFP Series

Type Carbon monofluoride lithium

Weight 0.8 g

Location On formatter board

User-removable No

For recycling information, you can go to www.hp.com/recycle, or contact your local authorities or the
Electronics Industries Alliance: www.eiae.org.
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Disposal of waste equipment by users in private households in the
European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of with
your other household waste. Instead, it is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human health
and the environment. For more information about where you can drop off your waste equipment for
recycling, please contact your local city office, your household waste disposal service or the shop
where you purchased the product.

Chemical substances
HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006
of the European Parliament and the Council). A chemical information report for this product can be
found at: www.hp.com/go/reach.

Material Safety Data Sheet (MSDS)
Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner)
can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/
community/environment/productinfo/safety.

For more information
To obtain information about these environmental topics:

● Product environmental profile sheet for this and many related HP products

● HP’s commitment to the environment

● HP’s environmental management system

● HP’s end-of-life product return and recycling program

● Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.
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Declaration of Conformity

Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: Hewlett-Packard Company DoC#: BOISB-0806-01-rel.1.0

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP Color LaserJet Enterprise CM4540 MFP

Regulatory Model Number2) BOISB-0806-01

 Including:

CC422A – 500-sheet paper feeder and cabinet

CC423A – 3x500-sheet paper feeder and stand

CC424A – 900-sheet 3-bin Stapling Mailbox

CC425A – 1x500-sheet paper feeder

Product Options: ALL

Print Cartridges: CE260A, CE264X, CF031A, CF032A, CF033A

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2001 / EN60950-1: 2001 +A11

IEC 60825-1:1993 +A1 +A2 / EN 60825-1:1994 +A1 +A2 (Class 1 Laser/LED Product)

GB4943-2001

EMC: CISPR22:2005 +A1/ EN55022:2006 +A1 - Class A1) ,3)

EN 61000-3-2:2006

EN 61000-3-3:1995 +A1 +A2

EN 55024:1998 +A1 +A2

FCC Title 47 CFR, Part 15 Class A1) ,3) / ICES-003, Issue 4

GB9254-1998, GB17625.1-2003

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low Voltage Directive 2006/95/EC,

and carries the CE-Marking  accordingly.
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This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2. For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).

3. The product meets the requirements of EN55022 & CNS13438 Class A in which case the following applies: “Warning – This is a
class A product. In a domestic environment this product may cause radio interference in which case the user may be required to take
adequate measures.”

Boise, Idaho USA

August 17, 2010

For regulatory topics only:

European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-
TRE / Standards Europe, Herrenberger Strasse 140, D-71034, Böblingen (FAX: +49-7031-14-3143)
www.hp.com/go/certificates

USA Contact: Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho
83707-0015 (Phone: 208-396-6000)
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Declaration of Conformity (fax models)

Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: Hewlett-Packard Company DoC#: BOISB-0806-02-rel.1.0

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP Color LaserJet Enterprise CM4540f MFP

HP Color LaserJet Enterprise CM4540fskm MFP

Regulatory Model Number2) BOISB-0806-02

 Including:

CC422A – 500-sheet paper feeder and cabinet

CC423A – 3x500-sheet paper feeder and stand

CC424A – 900-sheet 3-bin Stapling Mailbox

CC425A – 1x500-sheet paper feeder

BOISB-0703-00 – Fax Module

Product Options: ALL

Print Cartridges: CE260A, CE264X, CF031A, CF032A, CF033A

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2001 / EN60950-1: 2001 +A11

IEC 60825-1:1993 +A1 +A2 / EN 60825-1:1994 +A1 +A2 (Class 1 Laser/LED Product)

GB4943-2001

EMC: CISPR22:2005 +A1/ EN55022:2006 +A1 - Class A1) ,3)

EN 61000-3-2:2006

EN 61000-3-3:1995 +A1 +A2

EN 55024:1998 +A1 +A2

FCC Title 47 CFR, Part 15 Class A1) ,3) / ICES-003, Issue 4

GB9254-1998, GB17625.1-2003

TELECOM: ES 203 021; FCC Title 47 CFR, Part 684)

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low Voltage Directive 2006/95/EC, the

R&TTE; Directive 1999/5/EC (Annex II), and carries the CE-Marking  accordingly.
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This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2. For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).

3. The product meets the requirements of EN55022 & CNS13438 Class A in which case the following applies: “Warning – This is a
class A product. In a domestic environment this product may cause radio interference in which case the user may be required to take
adequate measures.”

4. Telecom approvals and standards appropriate for the target countries/regions have been applied to this product, in addition to those
listed above.

5. This product uses an analog fax accessory module which Regulatory Model numbers are: BOISB-0903-00 (US-LIU) or BOISB-0903-01
(EURO LIU), as needed to meet technical regulatory requirements for the countries/regions this product will be sold.

6. 5. This product uses an analog fax accessory module which Regulatory Model number is: BOISB-0703-00 as needed to meet technical
regulatory requirements for the countries/regions this product will be sold.

Boise, Idaho USA

August 17, 2010

For regulatory topics only:

European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-
TRE / Standards Europe, Herrenberger Strasse 140, D-71034, Böblingen (FAX: +49-7031-14-3143)
www.hp.com/go/certificates

USA Contact: Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho
83707-0015 (Phone: 208-396-6000)
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Safety statements

Laser safety
The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has
implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser
product under the U.S. Department of Health and Human Services (DHHS) Radiation Performance
Standard according to the Radiation Control for Health and Safety Act of 1968. Since radiation
emitted inside the device is completely confined within protective housings and external covers, the
laser beam cannot escape during any phase of normal user operation.

WARNING! Using controls, making adjustments, or performing procedures other than those
specified in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations
Complies with Canadian EMC Class A requirements.

« Conforme à la classe A des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

VCCI statement (Japan)

Power cord instructions
Make sure your power source is adequate for the product voltage rating. The voltage rating is on the
product label. The product uses either 100-127 Vac or 220-240 Vac and 50/60 Hz.

Connect the power cord between the product and a grounded AC outlet.

CAUTION: To prevent damage to the product, use only the power cord that is provided with the
product.

Power cord statement (Japan)
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EMC statement (China)

EMC statement (Korea)

EMI statement (Taiwan)

Laser statement for Finland
Luokan 1 laserlaite

Klass 1 Laser Apparat

HP Color LaserJet CM4540, CM4540f, CM4540fskm, laserkirjoitin on käyttäjän kannalta turvallinen
luokan 1 laserlaite. Normaalissa käytössä kirjoittimen suojakotelointi estää lasersäteen pääsyn laitteen
ulkopuolelle. Laitteen turvallisuusluokka on määritetty standardin EN 60825-1 (2007) mukaisesti.

VAROITUS !

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän
turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.

VARNING !

Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för
osynlig laserstrålning, som överskrider gränsen för laserklass 1.

HUOLTO

HP Color LaserJet CM4540, CM4540f, CM4540fskm - kirjoittimen sisällä ei ole käyttäjän
huollettavissa olevia kohteita. Laitteen saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu
henkilö. Tällaiseksi huoltotoimenpiteeksi ei katsota väriainekasetin vaihtamista, paperiradan puhdistusta
tai muita käyttäjän käsikirjassa lueteltuja, käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan
suorittaa ilman erikoistyökaluja.
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VARO !

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömällelasersäteilylle laitteen ollessa
toiminnassa. Älä katso säteeseen.

VARNING !

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig
laserstrålning. Betrakta ej strålen.

Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista: Aallonpituus 775-795 nm Teho 5 m W
Luokan 3B laser.

Substances Table (China)

Restriction on Hazardous Substances statement (Turkey)
Türkiye Cumhuriyeti: EEE Yönetmeliğine Uygundur
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Additional statements for telecom (fax) products

EU Statement for Telecom Operation
This product is intended to be connected to the analog Public Switched Telecommunication Networks
(PSTN) of European Economic Area (EEA) countries/regions.

It meets requirements of EU R&TTE Directive 1999/5/EC (Annex II) and carries appropriate CE
conformity marking.

For more details see Declaration of Conformity issued by the manufacturer in another section of this
manual.

However due to differences between individual national PSTNs the product may not guarantee
unconditional assurance of successful operation on every PSTN termination point. Network
compatibility depends on the correct setting being selected by the customer in preparation of its
connection to the PSTN. Please follow the instructions provided in the user manual.

If you experience network compatibility issues, please contact your equipment supplier or Hewlett-
Packard help desk in the country/region of operation.

Connecting to a PSTN termination point may be the subject of additional requirements set out by the
local PSTN operator.

New Zealand Telecom Statements
The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has accepted
that the item complies with minimum conditions for connection to its network. It indicates no
endorsement of the product by Telecom, nor does it provide any sort of warranty. Above all, it provides
no assurance that any item will work correctly in all respects with another item of Telepermitted
equipment of a different make or model, nor does it imply that any product is compatible with all of
Telecom’s network services.

This equipment may not provide for the effective hand-over of a call to another device connected to the
same line.

This equipment shall not be set up to make automatic calls to the Telecom “111” Emergency Service.

This product has not been tested to ensure compatibility with the FaxAbility distinctive ring service for
New Zealand.

Additional FCC statement for telecom products (US)
This equipment complies with Part 68 of the FCC rules and the requirements adopted by the ACTA. On
the back of this equipment is a label that contains, among other information, a product identifier in the
format US:AAAEQ##TXXXX. If requested, this number must be provided to the telephone company.

The REN is used to determine the quantity of devices, which may be connected to the telephone line.
Excessive RENs on the telephone line may result in the devices not ringing in response to an incoming
call. In most, but not all, areas, the sum of the RENs should not exceed five (5.0). To be certain of the
number of devices that may be connected to the line, as determined by the total RENs, contact the
telephone company to determine the maximum REN for the calling area.

This equipment uses the following USOC jacks: RJ11C.
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An FCC-compliant telephone cord and modular plug is provided with this equipment. This equipment is
designed to be connected to the telephone network or premises wiring using a compatible modular
jack, which is Part 68 compliant. This equipment cannot be used on telephone company-provided coin
service. Connection to Party Line Service is subject to state tariffs.

If this equipment causes harm to the telephone network, the telephone company will notify you in
advance that temporary discontinuance of service may be required. If advance notice is not practical,
the telephone company will notify the customer as soon as possible. Also, you will be advised of your
right to file a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations, or procedures that
could affect the operation of the equipment. If this happens, the telephone company will provide
advance notice in order for you to make the necessary modifications in order to maintain uninterrupted
service.

If trouble is experienced with this equipment, please see the numbers in this manual for repair and (or)
warranty information. If the trouble is causing harm to the telephone network, the telephone company
may request you remove the equipment from the network until the problem is resolved.

The customer can do the following repairs: Replace any original equipment that came with the device.
This includes the print cartridge, the supports for trays and bins, the power cord, and the telephone
cord. It is recommended that the customer install an AC surge arrestor in the AC outlet to which this
device is connected. This is to avoid damage to the equipment caused by local lightning strikes and
other electrical surges.

Telephone Consumer Protection Act (US)
The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or
other electronic device, including fax machines, to send any message unless such message clearly
contains, in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business, other entity, or individual
sending the message and the telephone number of the sending machine or such business, or other
entity, or individual. (The telephone number provided cannot be a 900 number or any other number for
which charges exceed local or long distance transmission charges).

Industry Canada CS-03 requirements
Notice: The Industry Canada label identifies certified equipment. This certification means the
equipment meets certain telecommunications network protective, operational, and safety requirements
as prescribed in the appropriate Terminal Equipment Technical Requirement document(s). The
Department does not guarantee the equipment will operate to the user’s satisfaction. Before installing
this equipment, users should ensure that it is permissible for the equipment to be connected to the
facilities of the local telecommunications company. The equipment must also be installed using an
acceptable method of connection. The customer should be aware that compliance with the above
conditions may not prevent degradation of service in some situations. Repairs to certified equipment
should be coordinated by a representative designated by the supplier. Any repairs or alterations made
by the user to this equipment, or equipment malfunctions, may give the telecommunications company
cause to request the user to disconnect the equipment. Users should ensure for their own protection that
the electrical ground connections of the power utility, telephone lines, and internal metallic water pipe
system, if present, are connected together. This precaution can be particularly important in rural areas.

CAUTION: Users should not attempt to make such connections themselves, but should contact the
appropriate electric inspection authority, or electrician, as appropriate. The Ringer Equivalence
Number (REN) of this device is 0.0.
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Notice: The Ringer Equivalence Number (REN) assigned to each terminal device provides an indication
of the maximum number of terminals allowed to be connected to a telephone interface. The termination
on an interface may consist of any combination of devices subject only to the requirement that the sum
of the Ringer Equivalence Number of all the devices does not exceed five (5.0). The standard
connecting arrangement code (telephone jack type) for equipment with direct connections to the
telephone network is CA11A.

Japan Telecom Mark

A08-0138004
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A
accessories

ordering 322
acoustic specifications 338
activity log 259
address books, e-mail

LDAP support 199
recipient lists 203
recipient lists, creating 202

adjust copy images 181
Administration menu, control

panel 18
alerts, e-mail 64
anticounterfeit supplies 109
automatic paper sensing 102

B
Backup/Restore menu, control

panel 45
batteries included 343
billing code report

printing 260
billing codes 219
Billing Codes Report

description 264
bins, output

capacity 96
locating 5

black and white
copy jobs 178

Blocked Fax List
description 264

blocked fax list report
printing 260

booklets
creating (Windows) 152

books
copying 185

both sides, copying 189

both sides, printing on
turning on (Mac) 64

browser requirements
HP embedded Web Server

266
browser, Web

remote configuration 210
business graphics

printing 162
buttons, control panel

touchscreen 14

C
cable, USB

part number 323
Calibrate/Cleaning menu, control

panel 45
call report 260
Canadian DOC regulations 349
cancel

copy jobs 176
canceling

print job 66
canceling a fax 240
canceling a print request

(Windows) 128
cartridges

non-HP 109
recycling 109, 341
storage 109
warranty 329

cartridges, print
replacing 110

cautions iii
cleaning

paper path 279, 308
product 279
scanner glass 179, 279

clearing log/report data 260

CMYK Values
description 265

collate
copy jobs 178

color
adjusting 168
copy jobs 178
Edge Control 170
manage 167
match 172
Neutral Grays 170
Pantone® matching 173
print color samples 173
printed vs. monitor 172
printing in grayscale

(Windows) 143
sample book matching 172
using 167

color options
HP EasyColor (Windows) 171
setting (Windows) 141

Color Samples for RGB
description 265

Color tab settings 69
Color Usage

description 264
Color usage, Macintosh 64
configuration

remote 210
Configuration Page

description 264
configurations, models 2
configuring

IP address 59, 75
connection

USB with Mac 58
USB with Windows 73

connectivity
solving problems 316
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control panel
Administration menu 18
Backup/Restore menu 45
Calibrate/Cleaning menu 45
cleaning page, printing 279
Copy Settings menu 23
Display Settings menu 35
Fax Settings menu 29
General Settings menu 19
help 11
Home screen 12
locating 5
Manage Supplies menu 37
Manage Trays menu 38
menus, summary 16
messages, numerical list 120
messages, types of 288
Network Settings menu 39
Print Options menu 34
Print Settings menu 33
Reports menu 18
Scan/Digital Send Settings

menu 27
security 274
Service menu 46
settings 52, 63
Stapler/Stacker Settings menu

39
touchscreen buttons 14
Troubleshooting menu 42
USB Firmware Upgrade menu

46
conventions, document iii
copies

changing number of
(Windows) 130

copy
adjust lightness/darkness 181
books 185
cancel 176
collate 178
color 178
creating a stored job 187
enlarge 177
from document feeder 176
from glass 176
grayscale 178
improve quality 179
Job Build 190
Job Mode 190

mixed sizes 188
multiple originals 190
optimize for text or pictures

179
photos 186
reduce 177
restoring default settings 184
set options 183
special paper 183
two-sided documents 189

copy settings
HP Embedded Web Server

268
Copy Settings menu, control

panel 23
copying

quality, adjusting 311
counterfeit supplies 109
cover pages

printing (Mac) 67
printing on different paper

(Windows) 148
covers, locating 5
custom print settings (Windows)

131
custom-size paper settings

Macintosh 67
customer support

online 336

D
date/time setting 209
default gateway, setting 79
default settings, copy

restoring 184
defects, repeating 118
deleting

stored jobs 159
Demo Page

description 265
dial tone detection, setting 216
dialing mode

setting 213
dialing prefix

setting 216
digital send settings

HP Embedded Web Server
268

digital sending
about 198

address books 202, 203
configure e-mail 199
folders 195
job settings 194
LDAP support 199
product memory 196
recipient lists 203
sending documents 200
SMTP support 199
USB flash drive 197

digital sending utility, remote
configuration 211

Display Settings menu, control
panel 35

disposal, end-of-life 343
document conventions iii
document feeder

copying two-sided documents
189

jams 292
make copies from 176

double-sided copying 189
double-sided printing (duplexing)

loading paper 98
turning on (Mac) 64

drivers
changing paper types and

sizes 84
changing settings (Mac) 63
changing settings (Windows)

53
presets (Mac) 66
settings 52
settings (Mac) 66
settings (Windows) 129
supported (Windows) 49
universal 51

DSS. See digital sending utility
duplex alignment

setting 163
duplex printing (double-sided)

loading paper 98
settings (Windows) 136
turning on (Mac) 64

E
e-mail alerts 64
E-mail feature

enabling 192
economy settings 275
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Edge Control 170
electrical specifications 338
embedded Web server 210
Embedded Web Server (EWS)

assigning passwords 273
features 266

end-of-life disposal 343
energy use, optimizing 275
Enhanced I/O (EIO) card

installing 277
part number 323
partnumber 323

enlarge
copy jobs 177

envelopes
loading in Tray 1 90
loading orientation 98

environment, specifications 338
environmental features 3
Environmental Product Stewardship

Program 341
error

codes 254
error correction mode

settings 219
error messages

control panel 288
e-mail alerts 64
numerical list 120
types of 288

errors
software 318

European Union, waste disposal
344

EWS. See embedded Web server
Explorer, versions supported

HP Embedded Web Server
266

e-mail
about 198
address books 202, 203
configure 199
LDAP support 199
recipient lists 203
sending documents 200
SMTP support 199

F
fax

canceling 240

feeding problems 251
printing 247
receiving 241
required settings 207
sending 236
setup wizard 208, 211

Fax Activity Log
description 264

fax address book 239
fax notification 222
fax number confirmation 217
fax polling 229
Fax Reports

description 264
fax settings

HP Embedded Web Server
269

Fax Settings menu, control panel
29

FCC regulations 340
features 2
features, description 206
feeding problems 251
File Directory Page

description 264
File Upload, Macintosh 64
Finnish laser safety statement 350
firmware

Update Mac 64
firmware upgrades 262
firmware, downloading new 282
first page

printing on different paper
(Windows) 148

use different paper 67
fit-to-page 231
folders

sending to 195
fonts

Upload Macintosh 64
formatter

security 274
forms

printing (Windows) 143
fraud hotline 109
fuser

jams 299

G
gateway, setting default 79

gateways
configure 199

general configuration
HP Embedded Web Server

267
General Settings menu, control

panel 19
gloss level

selecting (Windows) 135
glossy paper, supported 162
graphics, business

printing 162
graphics, low quality 236
grayscale

copy jobs 178
printing (Windows) 143

group dial. See speed dial

H
hard disks

encrypted 273
help

printing options (Windows)
130

Help button, control panel
touchscreen 14

help, control panel 11
Home button, control panel

touchscreen 14
Home screen, control panel 12
HP Customer Care 336
HP Easy Color

disabling 171
using 171

HP Embedded Web Server
copy settings 268
digital send settings 268
fax settings 269
general configuration 267
information pages 267
network settings 271
other links list 271
print settings 268
scan settings 268
security settings 270
troubleshooting tools 270

HP Embedded Web Server (EWS)
features 266

HP fraud hotline 109
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HP Jetdirect print server
installing 277
models including 2

HP Printer Utility 64
HP tough paper 163
HP Universal Print Driver 51
HP Utility 64
HP Utility, Macintosh 64
HP Web Jetadmin 55, 272
HP-UX software 56
humidity requirements 338

I
information pages

HP Embedded Web Server
267

printing or viewing 264
installing

EIO card 277
EIO cards 277
print cartridges 110
product on wired networks,

Mac 59
product on wired networks,

Windows 75
software, USB connections 73
software, wired networks 77
toner collection unit 112

interface ports
locating 8, 9

Internet Explorer, versions
supported

HP Embedded Web Server
266

IP address
configuring 59, 75

IP Security 273
IPsec 273
IPv4 address 79
IPv6 address 80

J
jams

causes of 289
document feeder 292
fuser 299
lower-right door 305
output area 293
output bin 297
recovery 306

right door 299
stapler 293, 294
top cover 297
Tray 1 302
trays 304

Japanese VCCI statement 349
JBIG compression

setting 218
Jetadmin, HP Web 55, 272
Jetdirect print server

installing 277
models including 2

Job Build, copying 190
Job Mode, copying 190
job retention

setting options (Windows) 159
job storage

Macintosh settings 69
modes available 157
setting options (Windows) 159

jobs
Macintosh settings 64

jobs, print
storing permanent copies

(Windows) 160
storing permanent private

copies (Windows) 161
storing temporarily

(Windows) 160
storing temporary copies

(Windows) 160
jobs, stored

creating (Windows) 157
deleting 159
printing 158
receiving notification when

printed (Windows) 161
setting user names (Windows)

161
specifying names (Windows)

161

K
keys, control panel

touchscreen 14
Korean EMC statement 350

L
labels

printing (Windows) 145

LAN fax 206
landscape orientation

selecting, Windows 139
laser safety statements 349, 350
Last Fax Call Report

description 264
last page

printing on different paper
(Windows) 148

LDAP servers
connect to 199

letterhead
printing (Windows) 143

license, software 332
Linux software 56
loading

Tray 1 90
Tray 2 92, 93
Tray 3, 4, and 5 92, 93

loading paper 90
locked fax printing 247
log/report

activity log 259
activity log, clearing 260
billing code report 260
blocked fax list report 260
fax call report 260
speed dial list report 260

lower-right door
jams 305

M
Mac

changing paper types and
sizes 66

driver settings 63, 66
problems, troubleshooting 319
removing software 61
software 64
supported operating systems

58
Macintosh

HP Printer Utility 64
resize documents 67
support 336

Macintosh driver settings
custom-size paper 67
Job Storage 69
watermarks 67
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maintenance kits
part numbers 323

Manage Supplies menu, control
panel 37

Manage Trays menu, control
panel 38

managing network 78
maps, printing 163
marketing materials

printing 162
material restrictions 343
Material Safety Data Sheet

(MSDS) 344
media

custom-size, Macintosh
settings 67

first page 67
pages per sheet 68
supported sizes 85

memory
included 2, 64
supply errors 120

memory chip, print cartridge
description 331

memory DIMMs
security 274

memory lock
disabling 247
enabling 247

memory tag
locating 111

memory, saving and deleting
faxes 236

menus
summary 16

menus, control panel
Administration 18
Backup/Restore 45
Calibrate/Cleaning 45
Copy Settings 23
Display Settings 35
Fax Settings 29
General Settings 19
Manage Supplies 37
Manage Trays 38
Network Settings 39
Print Options 34
Print Settings 33
Reports 18
Scan/Digital Send Settings 27

Service 46
Stapler/Stacker Settings 39
Troubleshooting 42
USB Firmware Upgrade 46

mercury-free product 343
messages

e-mail alerts 64
numerical list 120
types of 288

mixed sizes
copying 188

models, features 2
modem speed 252
multifunction product 206
multiple pages per sheet

printing (Windows) 137

N
n-up printing

selecting (Windows) 137
names, job

specifying (Windows) 161
Netscape Navigator, versions

supported
HP embedded Web Server

266
network

password, changing 78
password, setting 78
settings, changing 78
settings, viewing 78

Network Folder, scan to 195
network settings

HP Embedded Web Server
271

Network Settings menu, control
panel 39

networks
configuring 73
default gateway 79
HP Web Jetadmin 272
installing EIO cards 277
IPv4 address 79
IPv6 address 80
print servers included 2
protocols supported 74
security 75
SMTP servers 199
subnet mask 79

networks, wired
installing product, Mac 59
installing product, Windows

75
Neutral Grays 170
non-HP supplies 109
not configured 207
notes iii
notification settings 222

O
on/off button, locating 5
online help, control panel 11
online support 336
opening printer drivers

(Windows) 129
operating environment

specifications 338
operating systems supported 48,

58
optimize copy images 179
ordering

supplies and accessories 322
orientation

paper, while loading 98
selecting, Windows 139

other links list
HP Embedded Web Server

271
output area

jams 293
output bin

jams 297
locating 5

output bins
configuring 103
selecting (Windows) 154

P
page sizes

scaling documents to fit
(Windows) 150

pages per sheet
selecting (Windows) 137

paper
covers, using different paper

148
custom-size, Macintosh

settings 67
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first and last pages, using
different paper 148

first page 67
jams 289
load 90
loading orientation 98
pages per sheet 68
printing on preprinted letterhead

or forms (Windows) 143
selecting 307

paper pickup problems
solving 289

paper size
changing 84

paper sizes
selecting 135
selecting custom 135
supported 85

paper tray selection 233
paper types

changing 84
selecting 135
supported 88

paper, ordering 322
paper, special

printing (Windows) 145
part numbers

maintenance kits 323
print cartridges 323
supplies 323

pause, when dialing 236
PBX systems troubleshooting 253
PCL drivers

universal 51
PCL Font List

description 265
personal jobs

storing temporarily
(Windows) 160

phone lines troubleshooting 253
photos

copying 186
photos, low quality 236
polling 229
portrait orientation

selecting, Windows 139
ports

locating 9

PostScript Printer Description (PPD)
files

included 64
power

consumption 338
power connection

locating 8
power switch, locating 5
PPDs

included 64
prefix

automatic dialing 216
preprinted paper

printing (Windows) 143
presets (Mac) 66
print cartridges

checking for damage 117
memory chips 331
non-HP 109
part numbers 323
recycling 109, 341
replacing 110
storage 109
warranty 329

print job
canceling 66

print jobs
storing permanent copies

(Windows) 160
storing permanent private

copies (Windows) 161
storing temporarily

(Windows) 160
storing temporary copies

(Windows) 160
print media

loading in Tray 1 90
Print Options menu, control panel

34
print quality

improving 307
improving (Windows) 135

print server card
installing 277

print settings
HP Embedded Web Server

268
Print Settings menu, control panel

33
print tasks 127

printer drivers
choosing 310

printer drivers (Mac)
changing settings 63
settings 66

printer drivers (Windows)
changing settings 53
settings 129
supported 49

printing
from USB storage accessories

164
settings (Mac) 66
settings (Windows) 129
stored jobs 158

printing locked faxes 247
printing on both sides

settings (Windows) 136
priority, settings 52, 63
private jobs

storing permanently
(Windows) 161

problem-solving
e-mail alerts 64
messages, types of 288
no response 312
slow response 313

product. See multifunction product
product info 1
product memory

sending to 196
product memory, scan to 196
proof and hold

selecting (Windows) 159
protocols, network 74
PS Emulation drivers 49
pulse dialing

setting 213

Q
quick copy jobs

storing (Windows) 160

R
receiving faxes 241
recipient lists 203
recycling

HP printing supplies returns and
environmental program 342

recycling supplies 109
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redial interval, setting 214
redial-on-busy

setting 215
redial-on-no-answer

setting 216
reduce

copy jobs 177
regulatory statements

environmental product
stewardship program 341

remote configuration
digital sending utility 211
Web browser 210
Web Jetadmin 210

removing Mac software 61
repeating defects,

troubleshooting 118
Reports menu, control panel 18
required settings

country/region 207
resize documents

Macintosh 67
Windows 150

resolution
setting 221

restore factory settings 287
restoring default settings

copy 184
retention, job

modes available 157
setting options (Windows) 159

right door
jams 299

rings-to-answer 226
ruler, repetitive defect 118

S
safety statements 349, 350
SAP software 56
save to device memory

enabling 192
save to network folder

enabling 192
Save to product memory 196
Save to USB 197
save to USB

enabling 192
scale documents

Macintosh 67
Windows 150

scan
job settings 194

scan settings
HP Embedded Web Server

268
Scan/Digital Send Settings menu,

control panel 27
scanner

glass cleaning 311
scanner glass

cleaning 179
scanning to e-mail

about 198
address books 202, 203
configure 199
job settings 194
LDAP support 199
recipient lists 203
sending documents 200
SMTP support 199

scanning to folder 195
scanning to product memory 196
scanning to USB 197
secuity settings

HP Embedded Web Server
270

security
encrypted hard disk 273

security features 75
security slot

locating 9
Send to E-mail

enabling 192
Send to Folder 195
sending a fax

delete multiple recipients 243
to multiple recipients 241
using fax address book

numbers 239
sending to e-mail

about 198, 199
address books 202, 203
job settings 194
LDAP support 199
recipient lists 203
sending documents 200
SMTP support 199

Service menu, control panel 46
service settings 261

settings
billing codes 219
dial tone detection 216
dialing mode 213
dialing prefix 216
driver presets (Mac) 66
drivers 53
drivers (Mac) 63
error correction mode 219
fax number confirmation 217
fit-to-page 231
JBIG compression 218
memory lock 247
paper tray selection 233
priority 52, 63
redial interval 214
redial-on-busy 215
redial-on-no-answer 216
required 207
resolution 221
restore factory 287
rings-to-answer 226
stamp received faxes 231

shortcuts (Windows)
creating 132
using 131

Sign in
control panel 194

signs, printing 163
sleep delay

disabling 276
enabling 276

sleep mode
disabling 275
enabling 275

Sleep Schedule
setting 276

slow fax reception 252
slow fax transmission 253
SMTP servers

connect to 199
software

embedded Web server 55
HP Printer Utility 64
HP Web Jetadmin 55
installing, USB connections 73
installing, wired networks 77
Mac 64
problems 318
settings 52, 63
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software license agreement
332

supported operating systems
48, 58

uninstalling for Windows 54
uninstalling Mac 61

Solaris software 56
solving

direct-connect problems 316
network problems 316
walk-up USB printing

problems 314
special media

guidelines 82
special paper

copying 183
guidelines 82
printing (Windows) 145

specifications
electrical and acoustic 338
operating environment 338

speed dial
creating 241
delete 243
list report 260

Speed Dial List
description 264

speed, optimizing 275
stamp received faxes 231
staple options

selecting (Windows) 155
stapler

jams 293, 294
Stapler/Stacker Settings menu,

control panel 39
staples

replacing 115
Start button, control panel

touchscreen 14
status

Home screen, control panel 12
HP Utility, Macintosh 64
messages, types of 288

status message bar 236
status, fax accessory page 250
Stop button, control panel

touchscreen 14
stopping a print request

(Windows) 128

storage, job
Macintosh settings 64, 69
modes available 157
setting options (Windows) 159

stored jobs
creating (Windows) 157
creating from a copy 187
deleting 159
printing 158
receiving notification when

printed (Windows) 161
security 274
setting user names (Windows)

161
specifying names (Windows)

161
storing

print cartridges 109
storing jobs

permanent copies (Windows)
160

permanent private copies
(Windows) 161

proof and hold (Windows)
159

setting options (Windows) 159
temporary copies (Windows)

160
temporary personal jobs

(Windows) 160
with Windows 157

subnet mask 79
supplies

counterfeit 109
memory errors 120
non-HP 109
ordering 322
part numbers 323
recycling 109, 341
status, viewing with HP Utility

64
supplies status page

description 264
printing 119

support
online 336

supported paper 85
system requirements

HP Embedded Web Server
266

T
T.30 Trace report 261
Taiwan EMI statement 350
TCP/IP

manually configuring IPv4
parameters 79

manually configuring IPv6
parameters 80

technical support
online 336

temperature requirements 338
tips iii
tone dialing

setting 213
toner cartridges. See print

cartridges
toner collection unit

replacing 112
top cover

jams 297
tough paper 163
transparencies

automatic sensing 102
printing (Windows) 145

trapping 170
Tray 1

automatic paper sensing 102
capacity 96
jams 302

Tray 2
capacity 96

trays
capacity 96
configure 101
included 2
jams 304
load 90
locating 5
Macintosh settings 64
paper orientation 98
selecting (Windows) 135

troubleshooting
control panel messages 288
direct-connect problems 316
error messages, numerical list

120
jams 289
Mac problems 319
network problems 316
paper feed problems 289
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PBX systems 253
repeating defects 118
slow fax reception 252
slow fax transmission 253
walk-up USB printing

problems 314
Troubleshooting menu, control

panel 42
troubleshooting tools

HP Embedded Web Server
270

two-sided copying 189
two-sided printing

settings (Windows) 136
turning on (Mac) 64

U
uninstalling Mac software 61
uninstalling Windows software 54
universal print driver 51
UNIX software 56
updates, downloading product

282
Usage Page

description 264
USB

sending to 197
USB configuration, Mac 58
USB configuration, Windows 73
USB Firmware Upgrade menu,

control panel 46
USB storage accessories

printing from 164
USB, scan to 197
user names

setting for stored jobs
(Windows) 161

V
voice calls and retries 246
VoIP 248

W
walk-up USB printing 164
Warning button, control panel

touchscreen 14
warnings iii
warranty

customer self repair 335
license 332

print cartridges 329
product 328

watermarks
adding (Windows) 152

Web browser requirements
HP Embedded Web Server

266
Web Jetadmin, remote

configuration 210
Web sites

customer support 336
fraud reports 109
HP Web Jetadmin,

downloading 272
Macintosh customer support

336
Material Safety Data Sheet

(MSDS) 344
universal print driver 51

Windows
driver settings 53
drivers supported 49
supported operating systems

48
universal print driver 51

wizard, fax setup 208, 211
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